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Before you start ...

Before you start ...
About This Documentation

This documentation applies to "Prinect PDF Toolbox" Version 2015. This manual contains all the infor-
mation you need for using Prinect PDF Toolbox.

�

� Note: Remember that the printed documentation may differ in its contents from the online 
documentation (PDF, Online Help) as it is not always possible for technical reasons to incor-
porate the latest modifications into the printed manuals. You can always find the latest 
information in the online documentation.

What you should already know

We assume that you are familiar with the Windows® and Mac OS X® operating systems that are sup-
ported by this application.

We also assume that you have a basic knowledge of handling PDF files in prepress. 

Further Documentation

You can find more information in the following documentation:

• in the enclosed "How to get started" leaflet 

• in the Heidelberg Prinect Licensing - Operating Manual

• in the "PDF Toolbox ReadMe" PDF for information about installation

System Requirements

You can install Prinect PDF Toolbox 2015 on the Macintosh and on the PC running Acrobat 9.0, 10.0 
and 11.0. 

Acrobat 8.0 is executable but issues that occur with this Acrobat version are no longer remedied.

Apart from that, the system requirements of each of the Acrobat versions are valid.

You will find more information in the chapter "Licensing / Installation".
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Before you start ...
Symbols and Styles

The following typographical conventions are used in this manual:

• References to other chapters and sections are blue (on the screen) and underlined.

Example: See section "Symbols and Styles", page 18.

• Quotes are used to indicate menus, folders, functions, hardware conditions, switch settings, sys-
tem messages, etc.

Example: Set the switch to "off".

• Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".

• A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is marked by symbols that are used as follows:

Warning: Contains information that must be taken into consideration to protect the user 
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to 
hardware or software.

�

� Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can 
be performed.
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What's New?

1 What's New?
What's New in Version 2015?

This chapter lists the new features implemented since the predecessor version 2013.

General Information about PDF Toolbox

• Acrobat versions 9, 10 and 11 are supported. 
You will find more details in Installation. 

• Macintosh PowerPC systems are no longer supported.

• Changing the line width for import of CFF2 cutting die outlines. You will find more details in 
CFF2 Presettings.

• For fast and easy identification of the currently selected PDF Toolbox version, the window cap-
tion displays the version number. 
The tooltip appearing in the toolbar also has a version number.

• New tool icons in the toolbar.

• New short help
You will find more details in Short Help.

• If several documents are selected to apply functions, the effect on the selected page range can 
be retained.

PDF Report (Preflight)

• PDF Report 

Restrict Preflight check to selected page ranges. See Restrict Preflight check to selected page 
ranges for details. The report indicates the selected range in "Number of pages".

"Settings > Modify"
For reasons of space, the new tab "Color names" was added to "Colors". Some checks were 
moved to the new "Color names" tab.
It is now possible to distinguish spot color types.
For this reason, the "Separations" tab has three new checks. See also Number of spot colors is, 
Colors are not uniform on all pages and Spot color is not in the color tables.

"Settings > Modify"
In "Content", you can now also print forms, stamps and markups. See Apply to page content for 
details.
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"Settings > Modify"
In "Fonts > Font type", specified fonts can be converted to "Graphics". See Font name contains 
for details. 

Prinect PDF/VT Control (PDF Assistant License) (New Tool)

• Navigation in existing PDF/VT files. A particular page of a data record can be accessed directly. 
You see for a current page which data record that page is part of. See PDF/VT Control for details.

• Creation or correction of PDF/VT meta data*. A normal PDF with unassigned variable data, for 
example, can be converted to a PDF/VT.
* Saved data allocated to a file is referred to as meta data.

PDF Geometry Control

• You can switch the coordinate origin with a button. For details, see 
 Sizes.

• The tabs "Scale" and "Rotate" were merged into the "Format" tab. See "Format" tab for details.

• New tab "Marks" for the creation of Cut and Register marks. See "Marks" Tab for details.

• The maximum number of elements for the "Split" function in the "Regroup" tab was increased 
from 5 to 10.

• Definition of the starting point for guides. More details can be found in Guides.

• New key shortcuts. See Mouse and Keyboard Shortcuts for details.

PDF Assistant Separation Control

• Separation of normal Composite pages with the option of preserving particular pages of a PDF 
in Composite.

Color Editor Color Management

• Indexed images con be converted. 

• New option Color Management for Device CMYK with Active Color Blending

• New option Color Management for CMYK Spot Colors Mapped to CMYK
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• New compression "JPEG2000" with quality setting, also for "JPEG". 
See Compression for details.

Spot Colors

• Changes to images and gradients. See Apply (Object).

Multicolor Spot Colors

• Special processing with spectral data for contone colors. See Special Handling for Contone 
Colors.

• Optional sorting of columns by ascending or descending Delta-E value.

Coating Editor

Coating Editor

• Button for fast switching between 100% and 0% area coverage.

Barcode Editor

Barcode Editor

• Implementation of free text marks.

• New tab "Position" for size and alignment. See Position for details.

• Triangular marks for production binary codes. These triangles are used for registration control at 
the folder-gluer.

• The binary codes "Sick", "Bobst", "Kurandt" and "Pharma 0-1-2" can hold more figures (greater 
range of values).

Object Editor

Object Editor

• Aligning several objects to the box confining all objects.

• Editing of objects in the wireframe mode (3D wireframe model) is possible.
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What's New?
• Display of identical X or Y position in the path editor if several points are selected.

• Numerical input of X or Y position for selected points in the path editor.

• For more new features, refer to Brief Overview of the Overall Functionality.

Assemble Pages

• Selection of assembled pages in a stack using navigators (UP/DOWN arrows). 

• For the "CFF2 Import", you can make and import presettings regarding the line weight in the 
"Plug-Ins" menu.

Prinect VDP Editor (New Tool)

• Creation of variable text or barcode marks for printing variable data (e.g. if Linotype-L is con-
nected). See VDP Editor for details.

• Variable and text elements are identified as "Prinect VDP Marks" layer.

What's New in Version 2013?

This chapter lists the new features implemented since the predecessor version 2012.

General Information about PDF Toolbox

• Acrobat versions 9, 10 and 11 are supported. Version 8 is no longer supported. See Installation 
for details. 

• The settings for page range are kept when you go from one tool to another.

• You can show or hide the Toolbox tools in the main window of the PDF Toolbox if desired. More 
details can be found on page 35.

• The main window of the PDF Toolbox is minimized automatically together with Acrobat. 
The PDF Toolbox is also minimized when you close the last active document in Acrobat (Win-
dows: in the task bar).

• You can trigger an active button (blue border) by hitting the "Return" key in windows where this 
kind of operation is set. As a result, you no longer need to confirm with the mouse. Can be used, 
for example, in "Geometry Control > Apply". 
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• New quick tool called "Wireframe View On/Off". This requires that you have a license for the 
"Object Editor" option. More details can be found on page 193.

PDF Report

• PDF Report 

"Settings > Modify"
There is a new check in "Colors" in the "Separations" tab. See Spot color name contains non-
ASCII characters for details.

"Settings > Modify"
There is a new selection option in "Colors" in the "General" tab. You can convert marks color 
"All" within the trim box to CMYK, to K or you can remove it fully. See Marks color "All" is used 
inside the trim box for details.

"Settings > Modify"
The "Font is not embedded" function in "Fonts" in the "General" tab was enhanced. You cannot 
embed fonts, for example, that were not licensed properly. You will see a suitable message in 
this case. See Font is not embedded or embedding is illegal for details.

"Settings > Modify"
There is a new check in the "Document" tab. See "PDF/VT administration data do not match 
document" for details.

In the "General" tab, you can restrict the number of data sets for PDF/VT documents (PDF for 
variable data printing). See Maximum number of documents to preflight in a PDF/VT for details.

The trim check has changed in the "Content" tab. You can add a missing trim using scaled pixels 
as set in Tolerance. This requires that there is a suitably set bleed box. Definition is: Bleed box 
not equal trim box and not equal media box. See Trim missing - Tolerance (mm) for details.

PDF Geometry Control

• Geometry Control

Deletion of pages using the context-sensitive menu. See Context-sensitive menu functionality for 
details.

Proof Color 

· Guides can be repeated separately for x/y. 

· You can remove all of the values entered for the guides with the "Reset" function. 

· See Guides for a description.
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The "Split" tab was renamed to "Regroup". The reason for renaming is the new functionality 
"Combine" with its variants "Vertical Spacing" and "Horizontal Spacing". 
You can file tiling parameters that will be used frequently as a parameter set with the "+" button.
In addition, you can split into set formats (Tile). 
See "Regroup" tab for details. 

Color Editor Color Management

• The PDF/X Output Intent profile can be used automatically as the CMYK input profile. See Use 
PDF/X Output Intent, if available, as CMYK Input Profile for a description.

Color Editor Spot Colors

• New "Multicolor" tab for evaluating the quality when converting spot colors to any CMYK or 
NChannel process color spaces (using the "Lab recipe"). See "Multicolor" Tab for details.

• Parameters for the Multicolor enhancement were added to the "Default" tab. See "Default" Tab 
for details.

• The color spaces in the table are listed in the "Color Tables" tab. See "Color Tables" Tab for 
details.

Trap Editor

• In the Trap Editor, you can now disable "Convert Bitmaps to Graphics, if possible" in the 
"Images" group in "Automatic > Modify > Rules" for trapping. 
See Images for a description.

• You can now make the page contents more transparent using the "Soften Content" option in 
"Highlight" in the "Preferences" tab. In addition, you can also increase the trap width when high-
lighting if you wish. See Highlight for a description.

Object Editor 

• New tab, "Text", for easier text editing. 
Display and modification of text attributes like font type, font size, embedding state, character 
spacing and word spacing.
Conversion of selected texts on a page to graphics.
Selection of text by font name or font size.
See Object Editor - General Information for a description.
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• "Geometry" tab
Object position for object and page reference point from 3x3 matrix.
Scaling of width/height, as an option also proportionally.

• "Color/Overprint" tab
Modify colors through the import of color tables.
Modify colors by browsing an ICC profile. A device-independent ICC color space is then created, 
for example, "CMYK - ISO Coated".
Direct conversion of a device-independent color space for images and smooth shading to the 
appropriate device-dependent color space through removal of the assigned ICC profile.
Display and selection of the various device-independent color spaces. To date, only "CMYK", for 
example, displayed and you could only switch to DeviceCMYK. Now, "CMYK - ISO Coated" also 
displays (if used on the PDF page) and you can also switch to it.

• "General"
Button bar along the bottom in all the tabs for most of the functions accessed otherwise only in 
the context-sensitive menu.
Color selection with the pipette and use of this color. You can copy this target color for a fill and/
or a border in the list box above "Color selection or with a mouse click on the color box beside 
the pipette. 
Export of selected objects to a new PDF. Using Assemble Pages, you can position any part of your 
initial document on other PDF files.
"Wireframe View On/Off" (viewer only, no editing in this mode).

Versioning Assistant

• You can combine base and version elements. See Combine for a description. 

Assemble Pages

• You can display guides when you enable the "Guides" option.

• Calculation can be made in the text boxes.

Barcode Editor

• New codes: QR and Data Matrix 
See Barcode Selection for details.

• Preliminary selection of the barcode types to be shown using selection buttons. See Barcode 
Selection for details.
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Register Control

• In addition to the "Front" and "Back" views, there is now also the "Front & Back" view.

• An "Unchanged" mode was added to "Turn" and "Tumble" to view differences between front and 
back. The pages are stacked one on top of the other as they are.
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2 Licensing / Installation
General

The Prinect PDF Toolbox is a tool for editing and customizing PDF documents for a wide range of out-
puts. The Prinect PDF Toolbox is available for the Macintosh and for the PC.

You can access the Prinect PDF Toolbox plug-in directly from Adobe Acrobat. 

To license the product, open the "Prinect PDF Toolbox Licenses" window in Adobe Acrobat using 
"Plug-Ins > Prinect 2015 > Licenses". The “Prinect PDF Toolbox 2015 Licenses” window opens. The 
following licenses are possible: 
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Installation

There are two installers available for the Prinect PDF Toolbox:

• Prinect PDF Toolbox 2015 for the Macintosh 

• Prinect PDF Toolbox 2015 for the PC running with Acrobat 9.0, 10.0 or 11.0. Versions 10.0 and 
11.0 are recommended.

The products of the PDF Toolbox run as Acrobat plug-ins and, for that reason, have the same system 
requirements as the Acrobat version you use. 

The existing Acrobat application must be closed during installation.

You need a minimum of 128 MB memory and an available USB port.

Furthermore, you need approx. 170 MB additional space on your hard disk for the plug-ins and 300 
MB temporary disk space during installation. 

Proceed as follows to install the entire Prinect PDF Toolbox or only single features of it:

1. Insert the installation CD into the appropriate drive. 

2. Start "PDFToolboxSetup.exe".

3. Click "Next" and follow the instructions.

4. Installation of the Prinect PDF Toolbox is complete when you click "Finish" and you can now 
license it.

�

� Note: There is no separate license for Batch Processing in this version.

Single-user License

A single-user license enables the tools by means of a dongle. The tools specified in your license are 
now available whenever you open a PDF file. 

Prerequisite: The license plug-in is located in the "...\Acrobat\plug_ins\Heidelberg" folder 
(part of the standard installation of the Toolbox) and Acrobat® is running. The dongle must 
also be plugged in for a single-user license.

To enter the license key, invoke "Plug-Ins > Prinect 2015  Licenses...". 

1. The ID number of the dongle appears in the "License ID" box (needed to request the license key). 
The status panel shows whether the dongle was detected.

2. Enter your license key in the enabled box and click "Verify". All the product options that you pur-
chased a license for are automatically enabled. 

3. The tools specified in your license are now available whenever you open a PDF file. 
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Notes on Single-user License

Enabling with "Service"

If you installed a new single-user license plus new dongle but still haven't a license key, you can 
enable the full scope of the plug-ins by clicking the "Service" button. This is valid for 10 days and is 
possible once per dongle. Afterwards, you must enable the plug-ins through the license key.

Dongle problems in Windows®

If you see a message saying that the dongle is missing, although it is plugged in correctly to the USB 
port of your workstation, please check in "Control Panel > Software" whether the "Sentinel Protection 
Installer 7.6.6" is installed. If an older version of the Sentinel driver was already installed, the driver 
may not have been updated during installation. In this case, uninstall the old Sentinel driver and then 
repeat installation.
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Central License Server Management
Central license management enables the tools through a server. The tools specified in your license 
are now available whenever you open a PDF file. 

Prerequisite: The license plug-in is located in the "...\Acrobat\plug_ins\Heidelberg" folder 
(part of the standard installation of the Toolbox) and Acrobat® is running. There is a network 
connection to the server on which the licenses are managed (this can also be the current 
computer).

To open the licenses window, invoke "Plug-Ins > Prinect 2015 > Licenses...". 

1. Enter the name of the server in "License Server". All product options related to your license are 
now automatically enabled if you have a fixed license, i.e. one linked to your workstation.

2. Select one or more of the installed product options and click "Request" if you have a floating 
license, i.e. one that is not linked to your workstation.

3. The tools specified in your license are now available whenever you open a PDF file.

To release licensed products again, select the products and click "Release".

The licensing procedure through the server differs slightly depending on the type of license you have 
purchased:

• In the case of a fixed license, i.e. one that is linked to a certain workstation, you will receive the 
license assigned to your workstation on the server. Such a license is linked physically to the 
workstation concerned. Changes can be made only through the license server, and you don't 
have to define any further settings at the workstation.

• In the case of a floating license, you request the number of licenses you want for each of the 
products by clicking the "Request" button. The components are enabled on your workstation if 
licenses are still available on the server.

�

� Note: A message will display in the lower part of the dialog if the number of licenses you 
want is not available. 
You can use floating licenses on each workstation connected to the central license server. 
The only restriction is the number of licenses that can be used at the same time. A license 
is made available again if it is not used for some time or when the software is exited.
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Demo Mode
All the product options can be enabled for 15 days in the Demo mode. Select the option you want and 
click "Demo". With Prinect Color Editor and Prinect Trap Editor, your edited PDF document will be 
marked so that you will not be able to use it in your production process (the PDF pages will be mir-
rored or rotated by different angles or they will have a black cross on top of them). The full function-
ality of Prinect PDF Assistant and Prinect Screening Selector is available for 15 days without any 
restriction.

Application Information / Online Help

You can display information about the application, e.g. the version number, on the PC with the "Help 
> Info about 3rd Party Plug-Ins" menu. You will find the Online Help for Prinect PDF Toolbox in "Help 
> Plug-In Help". You will find this information in the "Apple" menu on the Macintosh.
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3 PDF Toolbox in General
General Information about PDF Toolbox

Prerequisite: Prinect PDF Toolbox has been installed and the standard PDF Toolbox sets 
are available, depending on your operating system version, e.g. in C:\Documents and Set-
tings\All Users\Application Data\Heidelberg\PDFToolbox.

As of Windows 7.0 you can find them in C:\ProgramData\Heidelberg\PDFToolbox.

To access this folder, you can enter the following in Windows Explorer:
"%ALLUSERSPROFILE%\Heidelberg\PDFToolbox". You can also use this string for scripting pur-
poses.

Import or Export Settings

All PDF Toolbox parameter sets, including custom ones, can be imported or exported. See "Parameter 
Sets/Folders", page 263 for a description.

Invoke the Prinect PDF Toolbox

You have two ways of invoking the Prinect PDF Toolbox:

• Click the icon shown in the menu bar. 

• Select "Plug-Ins > Prinect 2015 > PDF Toolbox" in the menu bar and then a tool.

The Prinect PDF Toolbox window of the tool you selected opens:
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There are also different way to invoke each of the tools:

• Select the icon of the tool you wish to work with in the Prinect PDF Toolbox:

PDF Report

Geometry Control

Separation Control

Color Management

Spot Colors

Coating Editor

Trap Editor

Screening Selector

Object Editor

• Or you use the items in the menu bar; select "Plug-Ins > Prinect 2015 > PDF Toolbox > ...".
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• You can hide a tool on the left in the Prinect Toolbox if desired by right-clicking it and deselecting 
this tool.

In addition to the tools named so far, there are other tools that you can invoke in two different ways:
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• You will find the icons listed below in the command bar. 
If this is not the case, you can (in Acrobat) right-click the command bar and open the context-
sensitive menu where you can add the icons with "Quick Tools...".

1 2 3 4 5 6 7 8 9 10 11 

1 PDF Toolbox

2 Assemble Pages

3 Register Control 

4 Imposition Editor 

5 VDP Editor

6 Barcode Editor 

7 Fast View - Alternate Images ON/OFF 

8 Wireframe View On/Off (part of the Object Editor)

9 Show Layout Pages

10 Versioning Assistant

11 PDF/VT Control

�

� Note: If you installed several versions of Prinect PDF Toolbox, you must customize the quick 
tools to the version you want.

• Or go to the menu bar and select, for example, "Plug-Ins > Prinect 2015 > Assemble Pages". In 
addition to the icons, you can also select "Import/Export..." and "Licenses...". 
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Tooltip

Many of the buttons and icons have brief explanations known as tooltips. Allow the mouse pointer to 
hover over an object for a moment. A tooltip will then appear (if there is one) and disappear again 
after a short period.

You must click if a question mark displays to the right of the mouse pointer. A detailed description 
then appears that remains on the screen. The description disappears when you click the text again.
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Help

Display the current Help with "Help > Plug-In Help > Prinect PDF Toolbox 2015". A PDF displays that 
contains a supplement to the other Helps named and a reference description of the single tools.

Short Help

Contains short help texts (e.g. possible shortcuts) for some active tools. The button turns 
active and can be clicked if short help is available:
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Mouse and Keyboard Shortcuts

The "Apple key" is used on the Macintosh instead of the "ALT" key.

General

Keyboard / 
Mouse

Function

Load button You can invoke the respective function with the Return key in windows where a 
button has a blue background. There is no need to click "Apply" for example.

Geometry Control window

"Page Sizes"

Keyboard / 
Mouse

Function

Arrow Keys

SHIFT + 
Arrow Keys

Click the rubberband and move it pixel by pixel with the arrow keys.

10 pixels per click.

"Ctrl" + "+" Rotate page clockwise by 90 degrees.
or
Invoke the context menu (right click in the window) and choose "Rotation +90°".

"Ctrl" + "-" Rotate page counterclockwise by 90 degrees.
or
Invoke the context menu (right click in the window) and choose "Rotation -90°".

Context-sensitive 
menu

Other context menu functions:
"180° Rotation"
"Empty Page Before"
"Empty Page After"
"Delete Pages" (only active if a blank page was inserted beforehand).

"Ctrl" + "-" Rotate page clockwise by 90 degrees.
or
Invoke the context menu (right click) and choose "Rotation -90°".

.
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Editing the path with the Path Editor

Applies to the Object Editor and the Coating Editor

To invoke the Path Editor: 

Context-sensitive menu (right-click) on open PDF > "Create Path". "Edit Path is active..." displays in 
the message pane.

After you create the path, apply the function (e.g. coating): 

Context-sensitive menu (right-click) > "Apply".

Keyboard / 
Mouse

Function

Single click If point or path hit...•

If neither point nor path are hit...•

Double click

Path closed:
right-click +

Apply

If you hit the starting or end point of an open path, then this path closes.•

Runs the function (e.g. coating).•

SHIFT + click If a point was hit, its selection state is inverted.•

If a path was hit, all points of the path are included in the selection.•

ALT + Click
ALT + SHIFT + 

click

If you hit a point, this point is selected and its type changes to a corner point 
(ALT) or a curved point (ALT + SHIFT).

•

If a path was hit, a corner (ALT) (ALT + SHIFT) is inserted.•

If no path was hit, this will define the starting point of a new path.•

Click + drag hold-
ing down 

mouse button

If the click starts on a selected point, all points selected so far will be moved.•

If the click starts on an unselected point, all points will be deselected and only 
this point is selected and moved.

•

If the click does not start on a point, all points inside the rubberbanded box will 
be selected. All points selected so far will be deselected.

•

SHIFT + click + 
drag holding 

down 
mouse button

All points inside the rubberbanded box will be selected additionally. All points 
selected so far will remain selected.

•

If you hit a point, this point is selected. If you did not hit a point but clicked the 
outline of a path, then all points on this path are selected. All points selected 
so far will be deselected.

If there are no paths or points so far ("Create Path" mode), this sets the starting 
point for a new path.

If you have a selected open path, then this point is added to the end and 
selected. It does not matter how many or which points on the open path are 
selected.



PDF Toolbox in General
Selection of items in Object-Editor / Screening Selector

Keyboard / 
Mouse

Selection

Click Only the hit object is selected

SHIFT + click The hit object is selected in addition

ALT + click The hit object is deselected.

ALT + SHIFT + 
click

The object below the topmost selected object is selected

Rubberband All objects fully inside the box are selected

SHIFT + rubber-
band

All objects fully inside the box are added to the selection.

ALT + rubberband All objects fully inside the box are deselected.

Coating Editor

Keyboard / 
Mouse

Selection

Click

Draw
rubberband

The hit object is varnished. 

All objects within the bounding box you draw are varnished.

ALT + click Remove varnished area.

ALT + rubberband Only the area within the rubberband is varnished. All other hit objects are 
ignored.
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4  PDF Assistant PDF Report
PDF Report

Use this tool to create a report for PDF files, providing a clearly structured summary of the major file 
properties, also pointing out any compliance errors with regard to the PDF/X format.

This will give you a fast and convenient overview of print-relevant data, for example of an unknown 
PDF, and you can more readily assess whether the document can be printed or whether any correc-
tions are necessary.

�

� Note: The present chapter describes the parameters for the PDF Report. Self-explanatory 
settings will not be described.

Creating a PDF Report

To launch the tool, select "Plug-Ins > Prinect 2015 > PDF Toolbox > PDF Assistant PDF 
Report...". The following window displays:
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Report Tab

Folder for Reports

Type the path where the report is to be saved in the "Folder for Reports" text box. 

�

� Note: Once created, the report is automatically saved in the folder specified in this box. The 
report file name is made up of the file name of the analyzed PDF file and _rep. A number is 
appended to the file name if several reports are created for the same file.

Template for Report

The default template for the report, "Report.pdf", is set by default in this box. You can select other 
folders and templates to suit your needs.

Attach report to document

Enable the "Attach report to document" option if you wish to include the report as a PDF attachment 
to the analyzed PDF.

The PDF document then shows a suitable note.

Show full document path

Enable "Show full document path" if you wish to have the path to the current PDF document listed 
in the report.

Create Report with Preview

In addition, a preview of the first page can be generated automatically and added to the report. This 
functionality makes it easier for you to see which reports belong to which analyzed PDFs.

Open Report

The report can open automatically based on the following conditions:

"Always", "Never", "If Warning", "If Error"
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Description

This is where you can view descriptions of the default preflight profiles or make some additional 
explanatory notes about them.

Settings

This is where you can select default or custom parameter sets that are used for checking a PDF.

Apply Corrections

Global option which, if disabled, allows you to not apply corrections. The function is disabled if the 
parameter set you selected does not include any corrections. 

Restrict Preflight check to selected page ranges

The following page ranges are available:

• "From:", "To:"
Specify the desired range.

Use the adjacent list box:

• "All"
Presetting, no restriction.

• "Even" 
All even page numbers.

• "Odd" page numbers
All odd page numbers.

• "Current"
The currently selected page.

Delete

You can delete the selected parameter set. By default, an alert message displays, asking whether you 
really want to delete.

Modify

You can make changes to the existing parameter sets. See "To modify "Settings"", page 46 for a 
description.

Export

You can export the selected parameter set (preflight profile) with all its settings as a template for Pri-
nect. The correct Prinect path is usually set by default.

Report

Click "Report". The opened PDF will be checked against the selected parameter set and the settings 
you made, and the report created of it displays as a PDF document.
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The report is now also filed in the folder that you specified in "Folder for Reports". The report is really 
added to the PDF document only when the PDF document is saved.

The report contains general information about the document such as file name, location, author, cre-
ation and modification date, screen system data, lossy compression, etc.

If a PDF report or even a report from the Prinect Prepress Manager is open, you can jump directly to 
the problem in the PDF file by positioning the mouse pointer on an individual message in the report 
(the hand then turns into a pointing finger). 

If a PDF file and the Navigator window are open, clicking an X in the PDF selects the error message 
in the window's list. In the same manner, you can select a message in the Navigator window to jump 
to the problem in the PDF file. 

To modify "Settings"

The "Settings" dialog opens when you click "Modify".

You can edit the selected parameter set (profile) with its default parameters in this window. You can 
edit each of these check parameters separately.

You can save all the data that you set in the various tabs.

• Save As...

To save the set: Click "Save As...". A dialog box appears where you can change the name of the 
set. Finally click "Save". 

• Save & Close 

With this function, you can save the selected set using the same name and quit "Settings" at the 
same time. Click "Save & Close".

• Cancel 

Closes the "Settings" window without applying any changes.

To view a description of the various check parameters, move the mouse pointer to a check parame-
ter. When a question mark appears, you can then display a tooltip with a click. The check parameters 
will be described briefly below.

The following window displays where you can edit the parameters:
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"Description" tab

"Description" displays information about preflight profiles like in the previous window. You can mod-
ify this information by making changes to the text.

"Document" tab

These are validation rules applying to the page-independent properties of the entire PDF file. Corre-
sponding error messages do not refer to pages or page objects.

To provide a fast overview a colored symbol marks off the information:

Settings that do not affect the print output and can be ignored.

Settings that could affect the print output and therefore require a message to be issued.

Yellow symbols mark off settings that should be verified.

Red symbols mark off settings that are likely to cause problems, such as images with very 
low resolutions or fonts that are not embedded.

• "PDF version is below" / "PDF version is above"

You can choose from PDF 1.2 up to PDF 1.7. 

• "Modification of document is not allowed" / "Saving document is not allowed" / "Printing docu-
ment is not allowed" 

The default is "Error" in each case. 

• "PDF/VT administration data do not match document"

In the case of PDF/VT data, an overall page total results from a number of documents, each with 
a page total. Generally, the overall page total should match that in the PDF.

• "File size is above (MB)" 
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This shows information if a set file size is exceeded. 

• "Creator" or "Application is unknown" 

Example: "Creator" = "Acrobat Distiller" and "Application" = "QuarkXPress". Missing entries are 
mainly from outdated applications or exotic PDF creators. 

• Neither "Creator" nor "Application" is one of (comma separated) 

This checks whether the user entered the name. For example: "Acrobat Distiller" means all Dis-
tiller versions, "Acrobat Distiller x.x" means only version x.x.

• "Creator" or "Application" is one of (comma separated)

This checks whether the name is included. In other words, "Acrobat Distiller" means all Acrobat 
Distiller versions. "Acrobat Distiller X" means only version X.

"PDF/X" tab

The format is defined from ISO standard 15930 (PDF/X-3) for the exchange of digital data and files in 
the graphic arts industry. The standard is based on the Adobe® Portable Document Format (PDF Ver-
sion 1.4). 

The PDF/X format is available basically in versions PDF/X-3:2003 and PDF/X-1a:2003. You can find 
a description of the versions and more details in the Internet at the address named below.

For further information on PDF/X, see http://www.pdfx3.org/.

The "PDF/X" section comprises details required for compliance with the PDF/X standard.

• PDF does not comply with the requirements of

Checks the document for compliance with the selected PDF/X standard. Even if this check is not 
enabled here, the appropriate entry is set automatically in the PDF if all PDF/X requirements are 
met.

• Trapped status is unknown

PDF/X requires a "Yes" or "No" for the trap status.

• Document title is missing

PDF/X requires a PDF-internal document title.

• Creation or modification date is missing

PDF/X requires a creation and modification date.

• Filter is not PDF/X-compliant

Filters such as LZW or JPEG 2000 are not allowed in PDF/X.

• PDF/X Output Intent is missing

Checks whether the intent for which the PDF was prepared is set in the document.
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• PDF/X Output Intent is not (comma-separated)

If there is an intent, this checks whether its description contains one of the names.

"Pages" Tab

The following tabs are found:

"Trim Box" tab

These are validation rules applying to the object-independent parts of a single PDF page. These are 
basically checks regarding the format, the orientation or specific content properties. Respective error 
messages do not refer to page objects.

• Trim Box is not set

Checks whether the Trim Box is directly set. A Trim Box being identical to the Media Box is also 
rated as not being set.

· Set
Creates a trim box with constant offset to the media box. 

· Left
Distance of the trim box from the left edge of the media box 

· Bottom
Distance of the trim box from the bottom edge of the media box

· Right
Distance of the trim box from the right edge of the media box

· Top
Distance of the trim box from the top edge of the media box 

• Trim Box size is not … DIN A4

Checks whether the trim box has a given format. Note: The orientation is ignored in this case, 
i.e. DIN A4 fits A4 landscape and portrait format.

· Set
Creates a trim box in the required size

· Center
If this parameter is enabled, the trim box created is centered to the media box. When it 
is disabled, the Trim Box is created with a constant distance to the left bottom edge of 
the Media Box.

· Width
Width of the required trim box

· Height
Height of the required trim box
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Manually specifying the format in "Width/Height" will automatically select "Custom".

· Left
Distance of the trim box from the left edge of the media box

· Bottom
Distance of the trim box from the bottom edge of the media box

• Pages with different Trim Box are present

This checks whether the pages in a document have different sizes.

• Precision

The settings you make here apply to all parameter in this tab, for example to the accuracy used 
for checking the Trim Box format.

"Miscellaneous" Tab

• Rotation operators are present 

A PDF rotate key rotates one page in Acrobat for display purposes. This rotated view often 
causes problems during imposition or when interpreting page formats. 

· Remove: The rotate key is removed without changing the page content. The page view in 
Acrobat is no longer rotated. 

· Apply: The rotate key is applied to the page content data and then removed. The page 
appears unchanged but without rotate key in Acrobat. 

• Orientation is not: The pages of a multi-page document are checked for a specific or uniform ori-
entation. 

The first page is decisive in the case of "Uniform".

All landscape pages are rotated to portrait if "Portrait" is set.

All portrait pages are rotated to landscape if "Landscape" is set.

• Media Box and Crop Box are different 

Different media and crop boxes often cause confusion regarding the paper format; you can set 
them to equal values without any problems. 

• Page boxes are not PDF/X-compliant 

PDF/X requires that certain page boxes be defined (trim box or art box must be present). Existing 
page boxes are subject to certain restrictions. During corrections, the art box is deleted since the 
PDF/X format stipulates that only one box be present, e.g. the trim box. 

• Number of pages is: 

not equal n: All documents that do not have the set number of pages are handled according to 
what is set (Warning, Info, Error, etc.). 
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• Page contents are empty

The contents are empty when no contents are defined in the PDF or none of the page objects is 
inside the Trim Box. The bounding box of an object is used for comparison since the actual struc-
ture of the object makes it impossible to detect all blank pages.

• Page is separated

A separated composite page consists of several gray pages describing the single color separations. 
Separated pages are not allowed in PDF/X and cannot be processed by functions like color manage-
ment or trapping. A Heidelberg pseudo composite page is also reported as separated (see also PDF 
Assistant > Separation Control).

"Images" tab

These are rules referring to the images or bitmaps (1-bit images or image mask operators) contained 
in the page contents. Respective error messages always refer to page objects.

"Resolution" tab

This is where you set check criteria that check the properties of images or bitmaps that are found in 
the page contents of the PDF documents.

• Resolution of color images is below... and below...

The check criterion is met if there are color images whose resolution is less than the set value.

The "... and below" setting is enabled if "Continue with warning" is set as the preflight action.

You can set a second check with this setting. When you enter a second, lower resolution and set 
the preflight action to "Cancel with error", processing aborts and an error message is issued if 
there are images whose resolution is less than this second value.

• Resolution of color images is above

The check criterion is met if there are color images whose resolution is more than the set value.

• Resolution of grayscale images is below/... and below/Resolution of grayscale images is above

The settings for grayscale images are equivalent to the settings for color images (see the "Reso-
lution of color images is below" parameter).

• Resolution of bitmap images is below/... and below/Resolution of bitmap images is above

The settings for bitmap images are equivalent to the settings for color images (see the "Resolu-
tion of color images is below" parameter).

"Miscellaneous" Tab

• Images using lossy JPEG compression are present

Compression of JPEG images always involves a loss of data. JPEG 2000 supports both lossless 
and lossy compression. The check criterion is met when there are images in the lossy JPEG com-
pression.
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• 1-, 2- or 4-bit images are present

PDF allows images with 1, 2, 4, 8 or 16 bit per pixel and color channel. 8-bit images are usual.

• 16-bit images are present

16-bit images are supported as of PDF version 1.5.

The PDF/X standard does not permit 16-bit images.

• OPI comments are present

In OPI image data replacement ("Open Prepress Interface"), the documents have placeholders 
and references to high-resolution image files instead of the high-resolution images. These refer-
ences are found as "OPI comments" in the code of the input documents. OPI image data 
replacement is illegal in a PDF/X workflow.

· Remove

It is safe to remove OPI comments if you do not wish to use OPI image data replacement 
and you are sure that all the images are embedded in the PDF documents in the required 
resolution.

• Images with alternate image are present

The system checks whether alternate images that speed up the view are already in the docu-
ments.

· Remove

It is a good idea to enable automatic creation of alternate images in the Preflighter, and 
for that reason you should also enable "Remove". If you don't, alternate images are cre-
ated only for those images that do not yet have any alternate images.

The PDF/X standard allows alternate images.

• Alternate image is default for printing

You can define an alternate image as the default for printing in a PDF document that has one or 
more alternate images. In this case, this alternate image is printed. Generally, this alternate 
image is different to the one you see in the document on the screen.

· Change

You should enable "Change" to avoid any issues that may occur in this context.

Alternate images that are defined as the default for printing are illegal in the PDF/X stan-
dard.
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• Not enough image data 

An image that is defined among other things by height, width and color space always has an 
exact number of bytes. Missing image data normally is due to an error in the generation of the 
PDF.

�

� Note: This check is time-consuming because each image must be fully read in.

"Fonts" tab

These are validation rules relating to the fonts used by the page contents. Respective error messages 
always refer to page objects. 

Forms/comment fields are not checked.

"General" tab

• Font is not embedded or embedding is illegal

A font that is not embedded or a font that does not allow embedding cannot be printed reliably 
(TrueType). 
This is remedied automatically when "Embed font" is enabled:

· Embed font

Embedding is with Adobe Acrobat and uses the installed system fonts.

• Font "Courier" is used inside the trim box

Courier is often used as substitution font for missing fonts. Usage of the Courier font inside the 
Trim Box could indicate that an undesired font replacement has taken place.

• Font encoding is other than recommended for PDF

The PDF specification contains strict rules with regard to encoding (e.g. WinAnsi or MacRoman) 
– in particular for TrueType fonts. Failure to comply with these recommendations can result in 
faulty font output.

• Different fonts have the same unique identifier

Correct Type1 fonts have a UniqueID valid worldwide. Fonts can be printed incorrectly if a doc-
ument contains different fonts with the same UniqueID.

You can enable "Correct".

• Font size is below (pt)

Fonts that are too small are sometimes not legible when printed.

• Font uses more separations than 

In particular smaller fonts with more than one color channel are problematic in printing because 
fringes or flashes can occur.
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• Black font is knockout and below (pt)

In particular smaller black fonts are normally set to overprint when created (i.e. CMY channels 
lying below them are preserved) so that no fringes or flashes will occur.

• Width of a character is not defined

A font character with an undefined width is an indication for a font with faulty encoding and usu-
ally results in defective texts. This check should always be enabled.

• Character is not defined in the embedded data/Character is defined several times in the embed-
ded data/Character is defined incorrectly in the embedded data

Missing characters or those that are defined several times or incorrectly cannot be printed reli-
ably or cannot be printed at all.

• Character without glyph is not encoded as space

This occurs mainly in incorrectly embedded or incorrectly encoded fonts.

"Font type" tab

• Multiple master font is used

Multiple master (MMType1) fonts create characters by calculating certain font parameters from 
templates. You should not use such fonts for printing.

• OpenType font is used

OpenType fonts are an extension of the TrueType format and were introduced as late as PDF 1.6. 
OpenType fonts may not be understood by older output systems and are prohibited in PDF/X-
1a:2003 and PDF/X-3:2003.

• Type3 (user-defined) font is used

User-defined fonts are quite common and normally do not cause any print problems. You can 
enable this for information purposes.

• TrueType font is used

TrueType fonts can cause print problems, in particular when their encoding does not comply 
with the PDF specification. The quality of these fonts is normally lower than that of Type1 fonts.

• TrueType CID font is used

Checks whether the TrueType CID variant (Type0/CIDFontType2) is used. Acrobat Distiller often 
embeds European TrueType fonts as CID variant since these can be encoded better.

• Type1 font is used

Fonts in standard Adobe Type1 format are quite common and normally do not cause any print 
problems. You can enable this for information purposes.
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• Type1 CID font is used

Fonts in standard Adobe Type1 CID format (Type0/CIDFontType0) are quite common and nor-
mally do not cause any print problems. You can enable this for information purposes.

• Font name contains

Here you can specify the names of fonts that, for example, tend to cause problems during out-
put. You can also enable the option "Convert to graphics" to automatically convert the fonts.

"Colors" tab

These are test rules referring to the colors and color spaces used by the page contents. Respective 
error messages always refer to page objects.

"General" tab

• Contains Device RGB colors

Device RGB colors belong to the group of device-dependent color spaces and are not allowed in 
PDF/X (exception: the output intent color space is of the RGB type). For printing, you must con-
vert RGB colors to the process color space using color management and a suitable RGB ICC pro-
file.

• Contains CIE L*a*b colors or calibrated RGB

The device-independent colors that are checked here are CIELab, calibrated RGB and ICCBa-
sed(RGB). Device-independent colors are forbidden in PDF/X-1a, but allowed in PDF/X-3. For 
printing, you must convert device-independent colors into the process color space using color 
management.

• Contains CMYK colors with ICC profile

CMYK with ICC profile (ICCBased (CMYK)) belong to the device-independent colors; they are for-
bidden in PDF/X-1a but allowed in PDF/X-3. For printing, these colors are normally also con-
verted to the print color space using color management. This often leads to undesired results, 
for example because chromatic black is created. With the help of Heidelberg products (Prinect 
Integration Manager or Prinect Color Editor), you can optionally convert ICCBased (CMYK) to 
device CMYK directly – without Color Management – so that the color values are not changed.

• Contains ICC profile identical to PDF/X Output Intent

You may get unwanted results after Color Management if identical profiles are used for the 
images of a page and for PDF/X Output Intent.

• Contains calibrated gray

Calibrated gray and gray with ICC profile (ICCBased (Gray)) belong to the device-independent 
colors; they are forbidden in PDF/X-1a but allowed in PDF/X-3. For printing, these colors are nor-
mally also converted to the print color space using color management. This often leads to unde-
sired results, for example because chromatic black is created. 
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Using the Prinect Integration Manager, you can convert these colors directly to DeviceGray - 
without Color Management -  so that the color values are not changed.

• Contains DeviceN colors with ICC profile (NChannel)

This parameter checks whether a document has objects in the "NChannel" color space. NChan-
nel is an extension of the device-dependent, multi-channel color space (DeviceN). This exten-
sion was introduced with PDF 1.6.

A DeviceNcolor space is a combination of up to eight separation colors such as Hexachrome 
made up of C, M, Y, K, Green and Orange. You can combine spot colors with any process colors 
in a DeviceN color space. Theoretically, this means that Device RGB can be combined with a 
PANTONE® color.

It is possible that NChannel is not interpreted correctly by older output systems; it is not permit-
ted in PDF/X.

• Marks color "All" is used inside the trim box

With the "All" marks color, an area coverage of 100% is used in each separation to be printed. 
The use of "All" is mainly not wanted within the trim box because too much ink will be applied.
This can be corrected automatically by selecting the appropriate option in the list box beside the 
feature.
Select option:
"Remove", "Convert to K", "Convert to CMYK"

• Contains chromatic gray (R=G=B or C=M=Y, K=0):

Gray RGB or CMYK can be converted to CMYK black with Heidelberg products (Prinect Integra-
tion Manager or Prinect Color Editor). This enhances the quality of your printing considerably.

• Contains repeat pattern (color space pattern)

This parameter checks whether there is a repeat pattern (e.g. wall paper with repetitive ele-
ments).

�

� Note: Pattern color spaces cannot be trapped. You can use a Pattern color space as a 
design element.

• Maximum area coverage in elements is above (%)

This parameter checks whether the maximum area coverage for single graphic elements and 
optionally also for images exceeds a set value. The value for area coverage is obtained from the 
sum of the area coverage values of the single color separations. This means that the theoretical 
maximum value for area coverage in the CMYK color space is 400%. An area coverage that is 
created by overprinting single elements cannot be determined correctly for this check.

· Check images

Images are also checked to see that they do not exceed the maximum area coverage if 
this option is enabled. Images must have a minimum number of pixels, not necessarily 
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contiguous, in order for this check to be worthwhile. You set this value in "Image area 
comprises at least (dots)".

"Separations" tab

Some elements of this tab were moved to the new "Color Names" tab due to reasons of space. For 
more details, see "Color Names".

This is where you find check criteria affecting color separations and spot colors:

• Contains C, M, Y, K

This lets you check CMYK colors specifically. 

• Number of spot colors is

This parameter checks whether the number of spot colors in a document deviates from a default 
or matches a default (depending on the condition set). In this check, only the spot colors, and 
not the CMYK process colors, are counted. 

A distinction between several spot colors is also possible:
"Normal and Opaque", "Transparent" and "DieLine"

• Colors are not uniform on all pages

Checks all pages for uniform color assignment. 

A distinction between several spot colors is also possible:
"Normal and Opaque", "Transparent" and "DieLine"

• Spot color is defined several times

Unfortunately, the PDF specification permits the definition of differing alternative color spaces 
for the same spot color. This can cause undesired results, in particular when this color is to be 
printed with the alternative color.

• Spot color is not in the color tables

Checks if spot colors are present in the current color tables.

• Spot color "None" is used

Elements in spot color "None" cannot be seen and can produce unwanted results in the output.

The impact of spot color "None" can be seen after the PDF was edited, for example, with Color 
Management.

Tab "Color names"

New tab; some options it contains were moved here from the "Separations" tab.

• Contains spot colors with conflicting names

This checks whether a document has spot colors of the same name but in different notations 
(e.g. Green, GREEN, green).
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Different notations can cause problems in production. In the Prinect Integration Manager, the 
exact spelling of the color names is important, whereas in Prinect MetaDimension it is not.

Conflicts with color names can occur, for example, if the color names differ by uppercase/low-
ercase letters only (Green, GREEN, green) or if PANTONE® colors with the same number but a 
differing extension (e.g. 125 C and 125 CV) are defined. Without any intervention, such spot col-
ors are treated as different colors. This means that each has its own printing plate, something 
which is normally unwanted.

• Spot color name contains non-ASCII characters

The name of the spot color contains characters that are not in the ASCII character set. 
The characters are replaced automatically by their hexadecimal ASCII code when the "Rename" 
option beside the function is enabled.

• Old-style Pantone color name is used

Current Pantone color names end with C, M, U or EC, PC, HC. The old-style color names ended 
with CV, CVC or CVU. 

There is no check whether or not the color is found in the current PANTONE ® color tables.

• Illegal Pantone color name is used

This parameter checks whether illegal PANTONE® color names are used in a document. For 
example, PANTONE® color names without an extension are illegal (e.g. "PANTONE 125" instead 
of "PANTONE 125 C").

The color names must also start with an uppercase letter. There is no check whether or not the 
colors are found in the current PANTONE® color tables.

• Illegal HKS color name is used

This parameter checks whether illegal HKS® color names are used in a document. For example, 
HKS® color names without an extension are illegal (e.g. "HKS 12" instead of "HKS 12 K"). The 
color names must also start with an uppercase letter. There is no check whether or not the col-
ors are found in the current HKS® color tables.

• Spot color is not

You can check for custom names.

"Overprint" tab

• CMYK White is overprinting - Check images

This parameter checks whether a color is defined as "overprinting CMYK white" in a document.

Overprinting CMYK white is a color without effect in the page content. This is undesired in most 
cases and can cause faulty prints. Note: overprinting 0% spot colors are also detected here. 
Heidelberg products (Prinect Integration Manager or Prinect Color Editor) can convert overprint-
ing white to knockout white.
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• 0% spot color is overprinting - Check images

Normally overprinting 0% spot colors are not visible. However, they can be problematic in prin-
ting if they are printed using an alternate process color (converted to CMYK).

• Gray is overprinting

According to the PDF specification, overprinting gray cannot overprint any CMY colors under-
neath although most users would assume that this is possible. This is the desired behavior in 
most cases. Heidelberg products (Prinect Prepress Integration or Prinect Color Editor) can con-
vert overprinting device gray to overprinting black process color.

• Spot color is overprinting

This parameter checks whether spot colors with an "overprinting" property are defined in a doc-
ument.

Overprinting spot colors are problematic in printing because they are not printed as a separate 
separation but using their alternative process color. In such cases, the overprint property nor-
mally cannot be reproduced properly.

• CMYK element with ICC profile is overprinting

This checks whether a CMYK element with an embedded profile was found that is overprinting 
at the same time. A CMYK element (graphic or text) with an ICC profile does not have a unique 
overprinting behavior during output if the overprint mode (OPM=1) is enabled at the same time.

This is illegal in PDF/X-4.

• Any other color is overprinting

This parameter checks whether colors with an "overprinting" property are defined in a docu-
ment.

"Content" tab

These are validation rules for fatal errors relating to certain page contents. Respective error messages 
always refer to page objects. Exception: optional contents (several layers) are reported across pages. 
The Layer function in Acrobat lets you easily view details on optional contents.

• Transparency present

The transparencies introduced with PDF 1.4 can cause considerable print problems. There are 
many reasons for the problems that produce faulty or unattractive results again and again. 
Transparency is prohibited in PDF/X.

• Layers (optional contents) are present

Layers were introduced in PDF 1.5 and allow optional contents to be defined. This means, the 
currently visible content of a page depends on Acrobat user settings or the screen resolution. 
Layers are illegal in the PDF/X format.
In contrast, layers are allowed in the PDF/X-4 and 5 formats.
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• Transfer functions are present

Transfer functions are for artistic effects and to correct the properties of a particular output 
device. In this way, a PostScript file that is planned for output on a particular imagesetter, for 
example, can have transfer functions that compensate the dot gain generated by this device. Dot 
gain can be caused, for example, by scattering or focusing inaccuracies of the laser beam when 
a plate is being imaged. In this context, dot gain is the difference between the screen value 
defined in the digital copy (area coverage) and the screen value measured on the imaged plate.

Transfer functions make it possible to change the colors of single page elements from the out-
side, as it were. A normal gray image can, for example, be set fully to 0%. If you measure such 
an image with Prinect Color Editor, the actual image data are shown, but not the values resulting 
from the additional transfer function. Transfer functions are normally found only in preseparated 
data and are prohibited in PDF/X.

· Unchanged

The transfer functions are kept as part of the generated PDF file and used during output. 
This setting makes sense if the transfer curve was used as a design element.

· Remove

All transfer functions in the PostScript code are removed. Generally, it is advisable to use 
this setting, except when the PostScript documents have device-specific transfer func-
tions for exactly the device (imagesetter) that is used for output (e.g. to compensate dot 
gain).

· Apply

The transfer functions are not kept as part of the generated PDF documents but are used 
during further processing of the documents. This can cause the reproduced colors to 
change. You can use this option, for example, to create color effects in your output.

Applied transfer functions are already taken into account when PDF page objects are 
created as the objects already have modified tonal values. The transfer functions origi-
nally in the PostScript code are no longer required afterwards. As a result of the "Apply" 
setting, there are no conflicts about the used transfer functions during further process-
ing. However, one disadvantage is that you cannot remove these transfer functions later 
if you discover that they were applied incorrectly. PDF/X files must not have any transfer 
functions for the reasons mentioned above.

• PostScript is present

PostScript commands can be embedded in a PDF page as page content. Acrobat does not show 
these PostScript elements. Usually, only the marks elements of a layout PDF contain PostScript 
commands today. PostScript commands are illegal in the PDF/X format.

· Remove
The PostScript commands are removed from the single page elements.
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• Line art flatness is beyond (Dots)

Flatness is measured in pixels and specifies the precision with which Bezier curves will be 
approximated on an output device. Too high a value produces curves with visible corners. Too 
low a value results in longer output times during imaging. Note: The default of the output device 
is used if a value of 0 is set.

· Correct
Change flatness to the nearest admissible value Values below this value are set to the 
lower value. Values above this value are set to the upper value. Example: [0.5-1.0] cor-
rects the flatness to values between 0.5 and 1 pixel. 

• Smoothness of blends is beyond (%)

The definition of a Smooth Shading results in a precise color value at a specific point. Smooth-
ness defines the amount of allowable deviation from this specific value. The smaller this value, 
the better the quality and the longer the output times.

· Correct 

Change smoothness to the nearest admissible value Values below this value are set to 
the lower value. Values above this value are set to the upper value. Example: [1.0-2.0] 
corrects the smoothness to values between 1% and 2%. Note: the default PDF value is 
2%.

• Line weight is below (mm)

This parameter checks whether there are hairlines in the documents whose line weight is less 
than the set value.

"Hairlines" are lines without a defined thickness. They are not invisible but are output in the low-
est thickness possible with the device resolution. For that reason, they can be seen easily in a 
proof (300 dpi), are practically invisible on a plate (2400 dpi) and are practically no longer pres-
ent in offset printing. Strokes, thin rectangles and "MoveTo", "LineTo" or "Fill" graphic com-
mands are detected as hairlines.

�

� Note: A line with a weight of 0.0 is always reproduced accurate to "1 device pixel" and is 
not invisible, as is often presumed.

· Correct

Lines below this value are increased to this set value. Attention: Under certain boundary 
conditions that affect objects, such as asymmetric scalings, not all types of hairlines can 
be corrected.
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• Trim missing - Tolerance (mm)

This checks element by element whether there is enough trim. There is not enough space for the 
trim if the element size (page content) ends exactly on the trim box.

The following message appears: "Not enough trim".

You can add to the trim in "Tolerance (mm)". 

Please note that missing trim cannot be found or added in all cases. As added trim can cause 
visible changes in the margin area, the tolerance chosen should not be too great.

• Action, JavaScript, or comment is present in printable area

PDF permits the use of different kinds of comments or other visible elements that are not part 
of the actual page description. Normally, these are ignored in printing, are prohibited in PDF/X 
and should be removed if they are in the page area. 

· Remove

All comments, JavaScript instructions and other action-related elements that do not 
come from Heidelberg Prinect applications are removed from the documents.

· Apply to page content

Forms, stamps and mark-ups can be printed.
Note:
Usually, you will not want this.

• Non-PDF/X-compliant screen information is present

This parameter checks whether a document has screen system information (known as "halftone 
objects") that does not comply with the PDF/X standard. These halftone objects are areas within 
a page where different screen parameters (dot shape, resolution, etc.) to the rest of the page are 
defined.

· Remove

You can remove data that does not comply with the standard.

• PDF/X-compliant screen information is present

The check of screen system information (halftone objects) breaks them down into whether they 
are permitted or prohibited in PDF/X or were generated by the Heidelberg Prinect Screening 
Selector.

· Remove

Removes the screen system information from the page elements. 
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• Heidelberg screen information is present

The check of screen system information (halftone objects) breaks the items down into: whether 
they are "permitted or prohibited in PDF/X" or whether they were generated by the Heidelberg 
Prinect Screening Selector.

· Remove

Removes Heidelberg screen system information from the page elements.

• PostScript Level 3 is required

This parameter checks whether the examined PDF documents have elements like multi-channel 
spot color space (DeviceN) or shades (Smooth Shading) that need an output device that is com-
patible with PostScript Level 3. 

Normally, these elements cannot be output correctly on older output devices that do not support 
PostScript Level 3.
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Navigator Tab

The PDF Report Navigator is a tool that you can use to view errors, warnings or information that the 
preflight report detected.

The tool launches displaying the Navigator if the PDF was already checked. You can view the results 
in the lower part of the window. 

Prerequisite: A PDF report on a PDF file was already created. This can also be a report that 
was created with Prinect Integration Manager. A PDF file or a report must be open before 
PDF Report Navigator can be started. 

Use the "PDF Report Navigator" to 

• navigate between the pages

• set filters and categories to show certain warnings/errors only

• create comments about the warnings/errors on the PDF pages and remove them again

You can use the Navigator buttons to click through the issued error messages. They are indicated by 
an X in the PDF file. 
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Buttons from left to right:

• Go to the beginning of the list 

• Go back one error message 

• Go back one error message or - if a problem occurs several times - go back one step within the 
error message 

• Go forward one error message or - if a problem occurs several times - go forward one step within 
the error message 

• Go forward one error message 

• Go to the end of the list

Autozoom

If you activated "Autozoom", the problem in the PDF file is enlarged when you continue to click in the 
list or using the buttons. 

Comments

Comments can be removed or created. Their icon is a little piece of paper. If you remove comments, 
they disappear only after the display of the PDF page is updated. The content of the comments can 
be read if you roll over them with the cursor or if you open the comment by double-clicking it. You 
can use the filter settings to determine yourself which comments are to be generated. 

Colors of the X's and the contents 

The colors correspond to the error messages in the report: red - error; yellow - warning; green - rem-
edied; blue - information 
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"History" Tab

The tab shows an overview of all checked PDF files of one Acrobat session with the relevant number 
of messages. In addition, it is also possible to open the reports or the PDF file. 

This functionality facilitates access to current reports and files.

"General" Tab

The settings in this tab apply to all parameter sets, i.e. they are not saved along with the separate 
Preflight profiles. Exception: the profile description.

Limits for messages

• Maximum number of objects per check

Defines the maximum number of objects that the Navigator can show details about the same 
problem on one page.

• Maximum number of comments per page

Defines the maximum number of comments per page that the Preflighter inserts if there are 
errors or warnings (0 -> no comments).
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• Maximum number of documents to preflight in a PDF/VT

Defines the maximum number of documents (data sets) to check during the preflight. Because 
PDF/VT files can contain thousands of variable documents, you have the option of restricting 
this number to save time. Default value: 10

Units & Format

Use the list boxes in the "Units & Format" group to define the units for "Length", "Resolution", and 
"Paper" to be used in the report.

Navigator filter

The Navigator filter function confines the result list based on various criteria, giving you better orien-
tation there. This lets you customize the results to suit your needs.

The criteria are divided into:

Type

Type describes the kind of messages that will display:

Error, warning, remedied, info

Category

In "Category" you can select for which category the type of message (error, warning) will display: 

Pages, images, fonts, colors, content

Use of Preflight Profiles in the Prinect Environment

You can also use the preflight profiles created with the PDF Report plug-in in a Prinect Integration 
Manager workflow. You will find the profiles in...

• for the Mac:

All Users/Shared/Heidelberg/PreflightSets (Mac) 

• up to Windows XP:

C:\Documents and Settings\All Users\Application Data\Heidelberg\PDFToolbox\PreflightSets 
(Win) 

• for Windows Vista and Windows 7:

C:\ProgramData\Heidelberg\PDFToolbox\PreflightSets
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You must then copy these Heidelberg preflight profiles (extension .hpp) to the following folder 
of the Prinect server:
\SysConfig\Resources \PreflightProfiles 

You can then import these profiles with "Administration > Resources > Preflight Profiles > Import". 

Open the PDF Report

There are several ways to open the report:

You can open the report in the folder you specified in "Folder for Reports".

If the PDF file was saved after the report was created, you can open the report in the vertical pane to 
the left by clicking the "Attachments" icon.

If a PDF report or even a report from Prinect Integration Manager is open, you can jump directly to 
the problem in the PDF file by positioning the mouse pointer on a single message in the report (the 
hand then turns into a pointing finger).

Structure

The structure of the PDF Report is as follows (from beginning to end):

• A document overview with general information.

• Summary showing the number of problems found and the number of affected objects.
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• Problems regarding separate objects are listed below.
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5 PDF Assistant Geometry Control
Geometry Control

Geometry Control makes it possible for you to influence a number of parameters relating to page size 
and positioning in a PDF document.

To launch Geometry Control, select "Plug-Ins > Prinect 2015 > PDF Toolbox > PDF Assistant Geometry 
Control...".

Click the icon shown opposite.

The following dialog appears when Geometry Control is open:

The settings in the dialog are applied to the active PDF document when you click "Apply" but they are 
not yet saved.

"Undo" restores the state that existed before "Apply".
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Working with Geometry Control

"Page Sizes" tab (box definition)

5 boxes are important for printing PDF documents: Media Box, Trim Box, Bleed Box, Crop Box and Art 
Box. They can be set or corrected for a PDF document.

It often happens that PDF files lack boxes (e.g. no margin with trim marks), feature incorrectly set 
boxes (e.g. media boxes too big) or inconsistent boxes in one document. Geometry Control allows 
these boxes to be set or corrected for a PDF document.

Media Box

The media box comprises all objects of a page, including text and images that appear on the page or 
extend beyond the page.

From a technical point of view, the media box defines the limits of the physical medium on which the 
page is to be printed. Apart from the complete page, it can comprise space for trim marks, color con-
trol bars and other elements. 

Contents outside the media box can be deleted without changing the essential PDF file contents 
because Adobe® Acrobat® ignores objects outside the media box when creating PDF files.

Crop Box

The crop box defines the area the page content is cropped to for display or output. In contrast to the 
other box types this box does not convey any meaning in relation to the physical page geometry or 
the intended use. It merely defines how the page contents are cropped. The crop box defines the way 
the page contents are positioned on the output medium if no other information is available (e.g. 
imposition instructions defined in a JDF or PJTF job). 

Bleed Box

The bleed box represents an extended area around the trim box causing the entire page contents to 
be trimmed when a bleed area is defined. A document requiring a bleed also requires a bleed box. 
The bleed box is always larger than the trim box and smaller than the media box. The bleed area of 
a printed page can have print, folding and cut marks, slug lines, etc.

Trim Box

The trim box shows the final document size after printing and cutting. A document configured to be 
printed in a print shop requires a trim box. The trim box must be smaller than the bleed box or media 
box.

Art Box

The art box represents a page area (e.g. a graphic file) that will be positioned when the PDF content 
is to be placed in an application such as a DTP program. The art box must be smaller than the bleed 
box.

�

� Note: The very least you should define is the trim box as imposition is usually based on the 
trim box. No box must be larger than the Media Box.
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Sizes

Media Box

The following is set by default when you open the dialog:

• First list box (box to be edited)

Width and height of the Trim Box and offset (X, Y offset) to the Media Box are displayed.

• Button "Coordinate origin" 

The default is the bottom left corner of the Media Box (indicated with a red dot). Clicking this 
button will switch the coordinate origin to "top left" (the red dot indicates this accordingly).
This can prevent errors when extending multi-page PDFs. 

• Second list box (dimensions to apply)

Width and height of the document and offset (X, Y offset) to the Media Box are displayed.

�

� Note: Any undefined box is displayed with the media box values.

Operation is basically as follows:
Select the box type to be edited in the first list box and use the second list box to assign the box in 
question a setting.

The selected box (first list box) is identified with a green line in the PDF, the values in the dialog have 
a red frame (actual value). If you select a presetting to be applied (second list box), it turns to a green 
line (setpoint). The actual value still present is retained as a red line.

When you click "Apply", the setpoints turn into actual values (setpoint = actual value). The PDF shows 
the result as a green line.

1. To edit the parameters for a box, select the box to edit in the "MediaBox" combo box.

The application comes with the following boxes: Media Box, Crop Box, Bleed Box, Trim Box and 
Art Box. You cannot overwrite these presettings. You will find a description of each of the boxes 
on the preceding pages.

2. In the second list box, select a box size you want from the presettings. A red line in the PDF indi-
cates the result of this change.

The application comes with the following boxes: Document: Target box = Actual box, User, Con-
tent, Automatic, DIN A3, DIN A4, DIN A5, US Legal, US Letter. You cannot overwrite these pre-
settings. You can, however, define and save your own parameter sets (see the section Define/
delete a custom parameter set).

(3). As an alternative, you can type the X/Y offsets or the width and height in the text boxes or drag 
the green lines in the PDF.
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Automatic

�

� Note: Select "Automatic" if you have a PDF without a trim box. The trim box is set automat-
ically at the cut marks if you set this option. 

Content

�

� Note: "Content" selected: This lets you align boxes to the content. For example, if you have 
an object on a PDF page, you can select any frame that then envelopes the object precisely.

�

� Note: You can move the box lines with the arrow keys while keeping the Shift key pressed, 
or with the mouse. 

• Pressing the Shift key while moving with the mouse lets you change the X or Y value only, 
depending on the direction you start moving the line. 

• Grabbing the box at one of its corners while pressing the Shift key at the same time allows you 
to proportionally scale the width and height of the box while you move the mouse.

To move the trim box (e.g. in packaging printing):

You can move the trim box (lines) to another position.

Hold down the Alt key. The cursor changes shape. Click the dieline. The trim box moves to the hull 
you clicked. 

The list box automatically displays the "User" item.

Automatic Adjustment

Depending on the option you have chosen, the bleed box is based on your trim box settings, or the 
media box is based on the definition for the bleed box. The values you type in the text boxes define 
the scaling factor by which the box to be adjusted is to be enlarged in relation to the reference box.

• To do so, enable one or both options in the "Automatic Adjustment" section and type values for 
scaling the respective box in the text boxes. 

Automatic box calculation works in both directions, i.e. using the values above, the values of the 
media box also result in appropriate changes of bleed and trim boxes.

In this way, you can, for example, add an appropriate margin area to a document that comes without 
cut marks and trim. You can then set the cut marks automatically in the "Marks" tab.

�

� Note: The status box at the bottom of the dialog indicates whether the current presettings 
can be applied or whether a box would be too large (i.e. larger than the media box).
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4. Specify the page range of the document to which to apply the new parameters.

5. Click “Apply” to conclude. The new box definition is applied to the selected pages. 

�

� Note: After you have clicked the "Apply" button it will be disabled until you choose another 
box or edit any of the values.

Define/delete a custom parameter set

1. To define or delete a custom set, click the "+" (define) or "-" (delete) sign beside the sizes in the 
"Page Sizes" tab. The following window opens for this purpose:

�

� Note: The “Save & Close” button is disabled because predefined parameter sets are only 
available before you create your own parameter set for the first time. To edit one of your 
own parameter sets later, you must select this parameter set in the list box before you click 
the button with the "+".

You can now define the selected box by either specifying a fixed size (width/height) and/or fixed 
offsets. 

2. To do so, enable the “Fixed Size” option and type values for the width and the height. The values 
of the set selected in the list box are set by default in the text boxes.

3. Enable the "Fixed Margin" option and type values for the X and Y offsets (the origin is the bottom 
left media box corner). 

The selected box with the specified size is centered in the media box if you specified only the 
"Fixed Size" option.

Enabling the "Fixed Margin" option only will center the selected box in the media box using the 
specified X and Y offsets while its size is adapted to the surrounding media box. 

4. Click “Save As” to conclude. The "Save As" dialog appears. 

5. Enter a descriptive name for the parameter set and then click “OK”. 

6. Also close the previous window. 
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The new parameter set now appears in the parameter set list box. 

Context-sensitive menu functionality

Insert blank page

You can insert blank pages before and after the current page using the functions in the context-sen-
sitive menu (see above).

Delete Pages

You can delete pages by invoking the context-sensitive menu beside "Automatic Adjustment". You 
cannot delete all the pages. The function is disabled if "All" is selected in the list box. 

"Proof Color" tab

In the "Proof Color" tab, you can add the current values for the trim, bleed and/or media box to the 
page content as lines and text. As a result, the size and name of the boxes are shown in the PDF doc-
ument and can be seen on the paper, e.g. of a proof. The contents are created as overprinting spot 
color elements. You can assign a name (default "ProofColor") and alternate color of your choice.

�

� Note: In current Heidelberg workflow products, page contents where "ProofColor" is 
defined as the color are automatically output only in the proof while they are suppressed 
automatically for a high-res output. This prevents that a film or plate of the "ProofColor" 
separation is imaged inadvertently.

Color

This is where you can set the color of the boxes. The selected color is valid for the box type selected.
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Box/Dimensioning/Lines

This is where you can select whether broken lines will be used to display the boxes and what is the 
line weight. You can also select whether or not the trim box, bleed box and/or media box will also be 
shown as text labels.

�

� Note: The selected font (Helvetica, Courier, Times Roman) will be embedded in the PDF 
when the Resource/Font folder of Adobe Acrobat contains a PostScript Type1 font with the 
same file name (e.g. "Helvetica").

You can set the unit for the line weight and the page range at the bottom of the dialog.

The boxes are shown in the PDF document when you click "Apply".

All the elements in the selected Proof Color are removed when you click "Remove".

To remove all the elements in a document: Shift + click "Remove".

Information about inserting the boxes is shown below in the status panel.

Guides

Here, you can create guides and save them as parameter record. You can customize the guides 
accordingly to a reference value (box). 
This functionality can make it easier for you to visually check positions and spacing.

Click the "+" sign to open the window for setting the data:

• In the list box, define the desired order (starting point) of the guides in horizontal (x) or vertical 
(y) direction, then specify the desired value (depending on the selected unit, e.g. mm) in the first 
field in X-direction. The guide in the example would be positioned "3 mm from the left". 
You can also duplicate the line by enabling the option "Repeat Lines". 

• If applicable, save the parameter set and click "Apply". 

• You can remove all the values you entered with "Reset".

"Format" tab

In the previous version, the following functions were located in the "Format" and "Scale" tabs. 

Click the function to change:

• "Page Reorientation"

The list box after "Page Reorientation" provides you with many ways of rotating the pages in the 
PDF document.
The "Force Portrait,..." and "Force Landscape,..." options let you give all the pages in the PDF 
document a uniform orientation. For example, if you want to impose a PDF document that has 
landscape and portrait pages only with portrait pages, select "Force Portrait..." and "Page Range 
> All".

There are three options for "Scaling":
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• "Scale content"

The content of a box is scaled (the boxes remain unchanged). Scaling occurs by percent. For this 
purpose, you can specify/change the percentages manually in Width/Height.

• "Scale page"

Page format and page content are scaled. Scaling occurs by percent. For this purpose, you can 
specify/change the percentages manually in Width/Height.

• "Target size"

Page format and page content are scaled. The selected box is matched to the selected size. For 
example, a defined art box can be fit to an A4 page. 

This also affects the sizes of the other boxes, for example, the media box also becomes bigger if 
you scale up the trim box.

The settings you define are shown in the PDF document when you click "Apply".

Information about the performed steps is shown in the status box.

"Regroup" tab

Split

This tab lets you split the pages of a PDF document into as many as ten parts, for example, if a mul-
tiple-paged document in letterfold is to be split into single pages.

The size of the trim box is shown, and you can select whether you want to split in horizontal or ver-
tical direction. The boxes you need are enabled, depending on what you select.

Green lines are used to display the trim box and the dividing line in the PDF document. You can shift 
the dividing line in the PDF document with the mouse pointer or by typing values into the boxes and 
hitting the "Tab" key.

The settings you define are shown in the PDF document when you click "Apply".

You can save set parameters for a split action by clicking the "+" button. This works around entering 
the parameters again when splits recur.

�

� Note: You can apply your changes to several PDFs if you hold down the Shift key and click 
"Apply" at the same time. A dialog displays where you can select the other PDFs.

Join

The "Combine" function lets you combine single pages to double pages again.

Tile

The "Tile" function splits pages into set sizes. You can select the set sizes in a list box.
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Sorting

You can resort the PDF if you spilt it into two parts and horizontally. These double pages be sorted 
consecutively or have a fully new combination. The texts are matched.

You can set the unit for the values shown and the page range at the bottom of the dialog. Information 
about splitting is shown in the status panel.

Proof Color

The settings you defined are shown in the PDF document when you click "Proof Color". You do not 
have to split the pages but can just view where the split will have to be. For example, this lets you 
mark the places where folding will be.

"Content" tab

A bounding box encompasses the contents of a page when you select the "Content" tab. You can cen-
ter this box around the content of the selected box with "Apply". You can shift the content as required 
by clicking it and dragging it holding down the mouse button.

Center Content in

The width/height of the selected box and the content as well as the X and Y offset from the bottom 
left corner of the selected box are shown during this.

You can set the unit for the values shown and the page range at the bottom of the dialog. Information 
about the content is shown in the status box.

Clip Objects to

The objects of a page are clipped to the box you selected.

The part cut off is fully removed from the PDF document. You can reduce the size of the PDF file by 
doing this.

You can select the page range at the bottom of the dialog. Information about clipping is shown in the 
status box.

Remove Objects Outside

The objects outside the selected box are deleted.

"Marks" Tab

A new "Marks" tab has been added. Cut and register marks can be generated and positioned auto-
matically:

There must be sufficient space for the marks.
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1. Select the Geometry Control tool.

2. Go to the "Marks" tab.

3. Enable the marks you want. 
You can restrict cut marks to existing separations or set them to "All" (default). You can select 
the position of register marks or choose "All round" (default).

4. Choose the desired application range (pages) and click "Apply".

Options

Apply offset from bleed box, if available

With a Bleed Box present, the distance to the Trim Box as taken as the offset.

Extend media box if marks are outside

Extends the media box automatically if the marks are outside of it.

Functions available to all tabs

Click "Apply" to apply and accordingly display the settings you made in the selected page range of 
the PDF document. 

You can change the scope and the display of the unit of measure.

Select any number of documents in a folder with the key shortcut: 
"Shift + click" "Apply".
Following the selection, the settings you made can be applied to all files.
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6 PDF Assistant Separation Control
Using Separation Control

With Separation Control you can view and, if necessary, edit the separation information of PDF files 
containing separated pages. 

The separation information shows you the separated pages assigned to a composite page. Unfortu-
nately, separation information in a PDF file is often incorrect or is missing entirely. One of the most 
frequent separation information errors is the definition of individual color separations as  a composite 
page. 

Separation Control lets you group separation pages belonging together, edit existing groups, or create 
a pseudo composite. To do so, the program places several pages on top of each other, thus creating 
the resemblance of a composite page. You can use this simulation to verify the correct assignment of 
individual separated pages. However, you can also save the pseudo composite file and integrate it in 
a composite workflow. 

Separation Control lets you group separation pages belonging together, edit existing groups, or create 
a pseudo composite. To do so, the program places several pages on top of each other, thus creating 
the resemblance of a composite page. You can use this simulation to verify the correct assignment of 
individual separated pages. However, you can also save the pseudo composite file and integrate it in 
a composite workflow. 

�

� Note: Color Management or trapping is not possible for pseudo composite files.

You can use Separation Control to create separation information not available in an already sepa-
rated PDF file.

Grouping separations

Launch Separation Control by clicking the icon shown to the left or selecting “Plug-Ins > Pri-
nect 2015 > PDF Toolbox > PDF Assistant Separation Control...". 

The Separation Control window displays the separation information contained in the PDF file.
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Correct separation information contains at least 4 process color separations and, if applicable, sep-
arations for spot colors for each page.

Separation control shows separation data for composite PDFs as well.

You can correct faulty information by grouping separations belonging together to pages.

To group separations properly, mark all the separations that are to belong to one page.

Click "Regroup". 

You now have the page made up of the correct separations and you can now convert it to a compos-
ite. Click "Composite" to do this.

Use the same procedure to correct faulty groups. 

Go To Page

For a better overview of the interdependencies between the pages you can view each page of the PDF 
file. 

Highlight the page or separation and click “Go To Page”. 
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Automatic

A PDF document can have incorrectly separated pages. You can use "Automatic" to work around this 
error. 

"Automatic" is enabled if each page is reported as a single composite PDF. Through the automatic 
function, the colors of a page up to the first repetitive color are then regrouped to a new page.

Let's say you have an incorrectly separated PDF. Separation Control shows you the following result:

Click "Automatic". The following result displays:
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Edit color data of separations

The color reproduction of a separation or alternate color is only relevant for printing if no separations 
are to be generated but the PDF is to be included in a composite workflow, e.g. in Prinect Integration 
Manager.

Unknown colors, i.e. colors without an alternate color saved in the PDF are initially assigned a default 
green as the alternate color. As preparation for a composite workflow or in order to improve the color 
display, you can edit the “alternate color” CMYK components.

You can edit both the color name and the color information.

�

� Note: These changes apply to all colors with the same name following in the list but not for 
colors preceding in the list. To apply such a change to all colors of the same name you must 
highlight the first occurrence of the color in the list.

1. Double-click the color to be edited. 

The "Edit Color" window appears.

2. Edit the color name in the relevant text box if applicable.

3. To correct the color definition, edit the percentage values for Cyan, Magenta, Yellow or Black in 
the respective text boxes. 

4. Click "OK". The edited color is saved in the separation information.

Tip: You can also use the Prinect Color Editor (in “Settings > Spot Colors”) to assign suitable colors 
from color tables and thus apply the correct CMYK alternate colors to an entire document if the doc-
ument contains spot colors without an alternate color, the names of which, however, are correctly 
specified e.g. Pantone® or HKS® colors.
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Create missing separation information

You can create separation information if it is not available or only partially available in an already sep-
arated PDF file.

This requires an equal number of separations per document page because the separations are con-
secutively grouped according to pages and assigned appropriate separation information. 

You can generate separation information when (in rare cases) not all pages come with a complete set 
of separations; in this case, however, you must subsequently edit the grouping.

1. Launch Separation Control as described before.

2. Click "Create". The “Create Separation Information” window opens. 

The process color options are enabled in the “Process Colors” area. 

You need not make any changes here unless not all CMYK colors were used. 

3. In this case you must disable the option in question.

4. Enable an option for each spot color in the “Spot Colors” area if your PDF file contains spot color 
separations. 

5. Type the spot color name and the color definition in each of the text boxes. 

6. Finally, click "OK". 

�

� Note: At least one of the separations also contains color if the message “The document 
uses other colors than DeviceGray” displays. As separations normally should use gray only, 
this may cause output issues.

The separation information is generated and appears in the Separation Control window.

�

� Note: This function overwrites any existing separation information.
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Create pseudo composites

You can create a pseudo composite once the separation information is correct and complete. During 
this process the grouped separations are placed on top of each other in overprinting mode.

You can use this pseudo composite to verify whether or not separations belonging together have been 
grouped. You can, however, also save the file in this format – it still contains all the separation infor-
mation but can be used for a composite workflow as well.

1. First save the PDF file with the corrected separation information.

2. Click “Composite”. A PDF file with a pseudo composite is created. 

3. Check the pseudo composite. 

4. Save the file if you wish to use it in a composite workflow.

�

� Note: Color Management or trapping is not possible for pseudo composite files.

You can change this pseudo composite PDF file back into a separated file. 

5. Click "Separate". 
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7 Color Editor Color Management
"Color Management" in the Prinect PDF Toolbox

The "Color Management" tool lets you analyze colors in PDF files and, if necessary, it converts them 
for printing. 
Conversion of all the data is done with the tried-and-tested Heidelberg Color Management.

The "Color Management" tool eliminates inconsistencies in PDF files that could cause problems 
during printing. For example, if different color spaces are used in a PDF file, you can correct them for 
printing.

Color Management analyzes PDF files according to their color spaces and embedded ICC profiles.

The actual data you have, as shown by the analysis, and the suggested conversion are presented in 
a clear, easy-to-follow manner. 

You should run a color analysis with the "Color Management" tool before you use the "Trap Editor". 
Any color issues in PDF files are detected and eliminated before the "Trap Editor" starts to spread and 
choke adjacent color areas.

Example of usage:

A multi-page PDF document contains a single page with a color space that is optimized for screen 
display in Acrobat®. This page would not be suited for printing! You can select a suitable color space 
for this page that makes printing of the page totally easy. The color matching is simulated accordingly 
on the screen.

Different Color Spaces

Generally, there are three different color space groups in the PDF format:

• Device-dependent color spaces
There are the following device-dependent color spaces: 
"DeviceGray", "DeviceRGB" and "DeviceCMYK"

• Device-independent color spaces
There are the following device-independent color spaces: 
"CalGray", "CalRGB", "CIEL*a*b" and "ICCBased"

• Special color spaces
There are the following special color spaces: 
"Spot color" (separation), "Multicolor" (DeviceN) and "Pattern"

Some of the special color spaces are not real color spaces but only derived subsets of other 
color spaces. The "Spot color" and "Multicolor" color spaces are used mainly for the definition 
of spot colors.
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Working with Color Management
We have drawn up a workflow for you below to give you an idea of how efficient your work is with 
Color Management:

1. Open the PDF file.

2. Start Color Management.

3. Analysis of the color spaces, data, etc. detected by Color Management. 

4. Define your output process.

5. Click "Modify" and change the parameters to match your output process.

6. Save the new set you have just generated with "Save As...". Use a plausible name for it (e.g. out-
put xy-proofer).

7. Check in the view panel if you are satisfied with the suggested conversions from the current doc-
ument (left) to the converted document (right). More details can be found in Color Space.
The suggestions are based on the parameter set selected to the right of "Settings".

8. Click "Apply (Pages)" if you are happy with the conversion suggestions.

9. The PDF file is converted accordingly.

10. Once again, check the conversion log in the display box.

11. Save your PDF file in Acrobat.
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"Pages" Tab

The entire "color content" of the PDF displays in the view panel.

• The open PDF document shown in the graphic has 36 pages. 

• The page range comprises all the pages of the document. 

All the color spaces, special colors, ICC profiles and separations found in the PDF file are dis-
played.

The numbers in parentheses refer to the various definitions of a color space in the file (e.g. a dif-
ferent white level or various, embedded profiles).
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Color Space

The colors below the "After Apply" column indicate what type of conversion is needed:

Black No conversion necessary (e.g. "CMYK" to "CMYK").

Green Conversion with Heidelberg CMM (e.g. "CIE L*a*b" to "CMYK").

Blue Conversion without Heidelberg CMM (e.g. "CalRGB" to "DeviceRGB").

Red Requires your attention (e.g. missing target profile in RGB image).

The analysis shows you at once what color data are in the PDF file.

"Current" (column on the left) shows the color spaces, ICC profiles, special colors and separations 
present in the current pages. "After Apply" (column on the right) shows the types of conversion sug-
gested for the current pages.

Separations

Left: Shows you all the color names of the data in the PDF file.
Right: Shows you the names of all printable colors that were set in the spot colors.

Settings

This is where you select parameter sets for conversion. 

"Setting" is the "core" of Color Management. All conversions are based on the sets defined here. You 
can edit each of the parameters separately after you click "Modify...". See ""Pages" Tab > "Modify..."", 
page 96 for details. 

Delete...

All selected "settings" will be deleted.

Modify...

You will find a more detailed description on ""Pages" Tab > "Modify..."", page 96.

From ... To .../ Apply (Pages)

The page range lets you restrict the pages of a PDF file to those you wish to analyze and convert. 

�

� Note: When you open a PDF file, the page range always defaults to the last setting made 
when the application was exited.

You start the conversion with "Apply (Pages)". The settings are applied to all the objects in the page 
range.
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�

� Note: "Shift + click" --> You can select several documents for this process.

"Object" Tab

Shows the current measured data below "Current" (left column) and data after conversion below 
"After Apply" (right column). These data display after they are measured in the file.

This is where you can edit the color space for single images. For example, indexed images can be con-
verted.

You can measure colors. 

Click a color in the PDF file with the mouse pointer. Details of the object then display in the window 
(e.g. text, graphic, shading). See also the section "Status Panel", page 92. 

�

� Note: The color of the object indicated by the mouse pointer is shown when you are mea-
suring. Not all the object colors lying below the topmost color are shown even if "Overprint" 
is set for the object. 
Holding down the "Alt" (PC) or "command key" (Macintosh), you can pass through the 
object to select and measure the layers further down.

Changing the Cursor Shape

You can change the shape of the cursor for measuring colors.

To do this, select the appropriate command in the context-sensitive menu.
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Image/Format

The analysis shows you at once what data are in the image. The format, resolution, filter, compres-
sion and color space display when you click an image.

Color Space 

The color spaces currently present in the pages. The numbers in parentheses refer to the various defi-
nitions of a color space in the file (e.g. a different white level or various, embedded profiles).

Delete...

This will remove the ICC profile of the image, and the color space will be converted to a suitable 
device-dependent color space.

Modify

You can assign a new ICC profile to the image. A new window displays where you can select an ICC 
profile and then assign it.

Current/After Apply

• The following icons indicate the status of the colors:

"Overprint"

"No Overprint"

Left: Calibrated RGB 

Right: The CMYK values reflect the values without any Color Management.

Apply (Object)

You start conversion, depending on the parameter set that you selected in "Settings".

You can apply a parameter set to separate images or to Smooth Shadings. You can thus convert spe-
cific images from RGB to CMYK only. You cannot apply this function to graphics or text elements.

Status Panel

The status panel displays the conversion results and important information or error messages. For 
example, when you are measuring colors, information about the selected object displays, or an error 
message indicating an invalid, embedded ICC profile appears. The area covered by the selected ele-
ment also displays in this panel.
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"ICC Profiles" Tab

PDF/X Output Intent

Shows the ICC profile or output process description if the file is PDF/X or if Output Intent is defined.

PDF/X is a data exchange format (composite/non-separated) for object-oriented data (screened data 
and vector data (graphics, text)) that contains all the elements required for printing data. "Output 
Intent" refers to the output process defined in a PDF file. "Output Intent" must be regarded inde-
pendently of the actual PDF/X format.

A PDF file is not necessarily a PDF/X file if an output process is defined in this PDF file.

The "PDF/X Output Intent" section shows the tag of any embedded ICC profile for an existing "Output 
Intent" and a description of the output process if an ICC profile is not embedded. PDF/X supports 
cross-media, color management-oriented workflows and conventional CMYK-oriented workflows. The 
format is defined from ISO standard 15930 (PDF/X-3) and is intended for the exchange of digital data 
and files in the graphic arts industry. The standard is based on the Adobe® Portable Document For-
mat (PDF Version 1.3). 

The PDF/X format is available basically in versions PDF/X-3:2002 and PDF/X-1a:2001. Color Manage-
ment supports both these versions. You can find a description of the versions and more details in the 
Internet at the address named below.

You can find more details about PDF/X Output Intent at http://www.pdfx3.org/.
Prinect PDF Toolbox  –  User’s Guide / Online 93

http://www.pdfx3.org/


Color Editor Color Management
Delete.../Modify.../Save...

Saves or deletes the embedded (active) ICC profile or modifies a new one that you want to embed.

The "Save..." and "Delete" buttons are enabled if a PDF/X file or a PDF file with an "Output Intent" 
and an embedded ICC profile is opened. You can now save the embedded ICC profile for any further 
work or remove it from the PDF file. You can also add a new ICC profile.

ICC Profiles Used in Document

Displays embedded ICC profiles, with the option of editing them.

Delete.../Modify.../Save...

"Delete...": Use this to remove the marked ICC profiles in the selected page range from the document. 
All the objects of this color space then have the related device-dependent color space as a result.

"Modify...": Use this to replace the marked ICC profiles in the selected page range from the docu-
ment. All the objects of this color space then have the new device-dependent color space as a result.

"Save...": Use this to save the ICC profile in the file system.

"Preferences" Tab

You can define some preferences for Color Management.
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Protocol

In the "Protocol" group, you can define whether a log file will be written or not.

All PDF files edited on a certain day are listed in the log file. This log file records, for example, the 
time the program starts and ends, set parameters, color conversions run including the name of the 
profile used and the number of objects for color matching.

1. Check the "Write PDF Log File" option.

In the "Keep for ... days" box, type in after how many days the log file will be deleted automati-
cally.

2. Select a paper size for the log file in the "Paper" list box (DIN A4 or US Letter).

3. In the "Folder" box, define the folder where the log file will be saved. Browse to the folder you 
want with the button with the three dots.

The log file is named automatically. The name comprises "PrinectColorEditor" and the date (month, 
day and year). The log file is saved as a PDF.

Use comment to insert information about applied parameters

This lets you define whether a comment about the work done will be added to this PDF. You can view 
these details using the added Note and by clicking the Adobe® Acrobat® "Comments" function.

Folder for ICC Profiles

This lets you browse to a central folder for ICC profiles.

General

Show maximum area coverage of the images

You can check the "Show maximum area coverage of the images" option. This option lets you calcu-
late the total dot area of an image when you click it, and this information is also shown in the status 
box with the other data.

Color Range

In the "Color Range" group, you can define which unit  (0...255; 0 %...100 %; 0.0 %...100.0 %) will 
be used to display the color data.
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"Pages" Tab > "Modify..." 

All the parameters that can be set by the user for a custom conversion between the color spaces can 
be found in "Settings > Modify...". Select one of Heidelberg's standard sets that comes nearest to 
what you need, then modify it and give it a new name when you save. 

�

� Note: We recommend that you "write-protect" existing sets in the file system so as not to 
inadvertently overwrite them. The files of the sets are located in the following folder:

• for Windows XP: "C:\Documents and Settings\All Users\Application Data\Heidelberg\PDFTool-
box\ColorSets". To find the files on a Macintosh go to "... Users\Heidelberg".

• for Windows Vista and Windows 7: "C:\ProgramData\Heidelberg\PDFToolbox\..."

"Color Management" tab

You can define your settings for color matching in this section.

Device Independent Colors

"Device Independent Colors" means that ICC profiles are assigned to the colors of images or graph-
ics. These profiles enable the images or graphics in the original color space (e.g. of a scanner) to be 
converted without any difficulty to the device-independent Lab color space. The "Lab", "Calibrated-
RGB" and "CalibratedGray" color spaces are regarded as device-independent as they are clearly iden-
tified.
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The options have the following functions:

• Treat ICCBased CMYK as Device CMYK

All embedded ICC profiles that are part of the "DeviceCMYK" color space are removed. This set-
ting prevents unwanted "CMYK" to "CMYK" conversions.

• Treat ICCBased RGB and Calibrated RGB as Device RGB

Colors from the "Calibrated RGB and ICCBased RGB" color space are converted to the "Device 
RGB" color recipe without Color Management. Then the data are converted to the target color 
space with Color Management and using the set ICC profiles in RGB > "+" All or RGB > "+" Gra-
phic.

• Treat ICCBased Gray and Calibrated Gray as Device Gray

Colors from the "Calibrated Gray and ICCBased Gray" color space are converted to the "Device 
Gray" color recipe without Color Management. The color is used in the K separation. This setting 
prevents a "chromatic" (CMY) gray.

Rendering Intent

This is where you can define color matching for each of the listed color spaces.

In addition to selecting ICC profiles, you can set the rendering intent for the individual graphics/image 
types. Rendering intent determines how color matching is done: Since losses always occur during a 
color space transformation, it can be helpful, for example, to retain the photographic perception of 
an original and to accept a limit on the number of color values. The following parameters are avail-
able for rendering intent: "From Document", "Absolute Colorimetric", "Relative Colorimetric", "Satu-
ration" and "Perceptual".

Rendering intent can be treated differently in the following sections:

• CMYK/Gray

• RGB/L*a*b

• Spot Colors

This color matching is often referred to as gamut mapping and is controlled by the Color Rendering 
Intent.

Color Rendering Intent is defined in the ICC standard. The following four color matching options are 
used by the Color Management module and the ICC profiles:

• Absolute Colorimetric
"Absolute Colorimetric" is used for the exact and verifiable reproduction of colors. This Rende-
ring Intent is used for the simulation (proof or proof print) of an output process to another output 
device or for the output of defined color data in print.
The colors of the original in the color space of the output process are reproduced correctly. All 
colors that lie outside the color space are mapped to the nearest reproducible color. As a result, 
very light, very dark or very colorful details in the originals can be lost when they are reproduced. 
The printing material is simulated during an output process simulation if the lightness and hue 
of the material lie in the color space of the output process.
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• Relative colorimetric
"Relative Colorimetric" is used for the exact and media-dependent reproduction of colors. This 
Rendering Intent is used for an output process simulation to another output device, where the 
simulation in part takes into account media white.
The colors of the original are reproduced relative to the white of the media used. The white point 
of the original is matched to the white point of the reproduction. All colors that lie outside the 
color space are mapped to the nearest reproducible color. As a result, very dark or very colorful 
details in the originals can be lost when they are reproduced. The printing material is not simu-
lated during an output process simulation. 

• Perceptual
"Perceptual" Rendering Intent is used for the harmonic reproduction of colors in print, taking 
into account the different color gamuts of the original and print. It is mainly used in the color 
separation of photographic images.
With this color matching option, the hue in all the natural colors of the original is reproduced for 
the most part correctly but with restrictions in the contrast. The type of color matching is man-
ufacturer-specific, with the user being able to set some of the aspects such as contrast and 
chroma change during profile generation.

• Saturation
This Rendering Intent is used whenever the reproduction of chroma in the colors is important in 
the printed result, while keeping the saturation of the original's color data. It is mainly used in 
the color separation of graphics and diagrams (business graphics). 
With this color matching option, the chroma in all the colors of the original is reproduced as cor-
rectly as possible but with restrictions in lightness and hue. The type of color matching is man-
ufacturer-specific, with the user being able to define some settings during profile generation.

• From Document
The Color Rendering Intents that were defined for images and graphics in the PDF file are used. 

Black point compensation

In gamut mapping, all L shadows that are darker than black ink are matched to black ink and, as a 
result, shadow definition is lost. This applies especially to "Relative Colorimetric" color matching. 

When you check the "Black Point Compensation" option, black point compensation is enabled and 
matches shadows, consequently preventing a loss of detail. 

The "Black Point Compensation" option can be enabled for "Relative Colorimetric" "Perceptual" and 
"Saturation" color matching. 

Output

Press Profile

This is where you select the output profile that describes the properties of the output device you 
want.

The output profiles can come from different color spaces depending on your output:

• The profile is normally "DeviceCMYK" for printing presses. 
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• It can be a "DeviceGray" profile for a black-and-white output. 

• It can be a "DeviceRGB" profile for a monitor output (e.g. an Internet page).

Use PDF/X Output Intent, if available, as Press Profile

An open PDF/X file with a defined Output Intent and embedded ICC profile is always used as the 
Press Profile. The set press profile is ignored in this case.

Use PDF/X Output Intent, if available, as CMYK Input Profile

An open PDF/X file with a defined Output Intent and embedded ICC profile is used as the source pro-
file for CMYK-to-CMYK conversion. The CMYK profile set in the "Device Colors / DeviceLink" tab is 
ignored.

Embed Applied Press Profile as PDF/X Output Intent

The selected press profile is embedded in the PDF file as the PDF/X Output Intent. This can be very 
useful for comprehensive workflows with the PDF/X format.
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"Device Colors / DeviceLink" Tab

You define the settings for device-dependent colors in this tab.

ICC/DeviceLink Profile

Color space conversions are performed with the help of ICC profiles. In this group, you select the 
source profiles that you will use for conversion to the device-independent Lab color space. Conver-
sion to the target color space is based on the set Press Profile ("Color Management" tab > "Output"). 

ICC press profiles are created during installation:

• for Windows XP in: "C:\Documents and Settings\All Users\Application Data\Heidel-
berg\PDFToolbox\ICCProfiles". 

To find the files on a Macintosh go to "... Users\Heidelberg".

• for Windows Vista and Windows 7 in: "C:\ProgramData\Heidelberg\PDFToolbox\ICCProfiles..." 

To find this folder on a Macintosh go to "... Users\Heidelberg".

This directory contains the ICC profiles included in the shipment.

By default, after installation, these ICC profiles are used for automatic color matching.

�

� Note: You can supplement these supplied ICC profiles with your own profiles by copying the 
relevant files to the above-named directory.
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Click the button with the three dots to display a list box (the appropriate profile folder opens 
automatically) where you can select the ICC profile you want.

If you are working in a Prinect Prepress Manager environment, you can access its resources there. 
Path: "\\Prepress Manager Server\PTConfig\SysConfig\Resources\ICC Profiles"

�

� Note: You cannot perform a conversion to the target color space if no profiles are selected. 

During the import of an ICC profile, the system checks whether it matches the selected color space. 
An error message is issued if it does not.

RGB > "+" All

Select an ICC profile for the conversion of images and graphics.

RGB > "+" Image

To convert the RGB images in the PDF file select an ICC profile that is defined by the "DeviceRGB" 
color space. 

RGB > "+" Graphic

To convert the RGB graphics (also text and shade) in the PDF file, select an ICC profile that is defined 
by the "DeviceRGB" color space. 

�

� Note: For RGB graphics from Office documents, it may be advantageous to use Heidelberg's 
"RGB2CMYK.icc" "link profile". This profile allows a simple conversion from "RGB" to 
"CMYK" with a PostScript standard that makes it possible to keep existing corner colors as 
they are.

CMYK > "+" All

Select an ICC profile for conversion.

CMYK > "+" Image

To convert the CMYK images in the PDF file select an ICC profile that is defined by the "DeviceCMYK" 
color space. 

CMYK > "+" Graphic

To convert the CMYK graphics (also text and shade) in the PDF file select an ICC profile that is defined 
by the "DeviceCMYK" color space. 

Gray > "+" All

Select an ICC profile for conversion.

Gray > "+" Image

To convert the gray images in the PDF file select an ICC profile that is defined by the "DeviceGray" 
color space. When you enabled the "CMYK Image" option, you can also apply the CMYK profile 
selected there.
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Gray > "+" Graphic

To convert the gray graphics (also text and shade) in the PDF file select an ICC profile that is defined 
by the "DeviceGray" color space. When you enabled the "CMYK Graphic" option, you can also apply 
the CMYK profile selected there.

Multicolor > "+" All

Select an ICC profile for conversion.

Multicolor > "+" Image

To convert the multicolor images in the PDF file select an ICC profile that is defined for a certain Devi-
ceN color space, e.g. Hexachrome. In rare cases, a document can have several different multicolor 
color spaces. In such cases, you can only convert the images of one of these color spaces. The profile 
you select determines which type of multicolor image will be converted.

Multicolor > "+" Graphic

To convert the multicolor graphics (including text and shading) in the PDF file, select an ICC profile 
that is defined for a certain DeviceN color space, e.g. Hexachrome. 

�

� Note: "Rendering Intent" is dimmed if a Device Link profile is selected. Selection of a ren-
dering intent is superfluous here because it is already described in the Device Link profile.

Rendering Intent

See Rendering Intent for a description.

BPC

See Black point compensation for a description.

Preserve in CMYK

During a CMYK-to-CMYK or Gray-to-CMYK image or graphic conversion, black is preserved depending 
on what you set:

• Special (default)
C, M and Y are converted to CMY, K is converted using special methods. Extensive tests have 
shown these to be the best. The "Special" parameter eliminates most of the problems in com-
plex files. This parameter is only available in the Heidelberg CMM.

• Basic
C, M and Y are converted to CMY, K is converted to the target density with the help of a grada-
tion curve. 

• K=K 
Only C, M and Y are converted to CMY, K is not converted. 

Black remains identical. 
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• In addition to keeping black, you can set that the primary and secondary colors (e.g. 100% 
magenta or 100% cyan + 100% yellow) will also be kept. There are two different modes in this 
case:

· exact, i.e. only 100% values are preserved

· smooth conversion

Color Management for Overprinting Device CMYK Graphics

Only active if "CMYK" is enabled-

You can also use Color Management for overprinting Device CMYK graphics. 

Color Management for Subsets of Device CMYK

Only active if "CMYK" is enabled-

You can also use Color Management if single channels are missing.

Color Management for Device CMYK with Active Color Blending

Only active if "CMYK" is enabled-

Color Management can be disabled with active Color Blending because it can cause visible color 
changes in rare cases. 

Color Management for CMYK Spot Colors Mapped to CMYK

Only active if "CMYK" is enabled.

Color Management is disabled for spot colors mapped to CMYK.
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"Overprint" Tab

In the "Overprint" tab, you can set parameters that automatically detect and eliminate unsuitable 
"Overprint" settings in a PDF file. 

Overprint

K Set Colors (without Gray and Black) to Knockout

All overprinting colored elements (image, graphic and text) are set to Knockout.

This function is useful for correcting a wrong application of the Overprint status. 

This function should not be used if the page content must be set to overprint, for example, 
if an overprinting spot color is to produce a color mix.

k The status of the colors does not change.

K Set Gray and Black to Knockout

All overprinting gray and black elements (image, graphic and text) are set to Knockout. The 
option "Set Black to Overprint if Above or Equal (%)" lets you specify a percentage starting 
from which graphic or text elements will be set to Overprint again.
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k The status of gray and black remains unchanged.

K Set CMYK White to Knockout

An overprinting CMYK white (C=M=Y=K=0%) is set to knockout. 

There are no printable colors with this combination.

The CMYK combination with a value of 0% mainly occurs unintentionally when generating 
PDF data. 

k An overprinting CMYK white (C=M=Y=K=0%) remains unchanged.

K Set Black to Overprint if Above or Equal (%) X

The value set for this parameter defines the threshold above which black will overprint. 

You have the option of deselecting certain objects. Selection: "Text", "Lines", "Graphic" and 
"Bitmap"

How this works:
The smaller the value, the greater the use of overprinting. The default value is 100%. The 
values range between 0% and 100%.

50% All gray colors with 50% and above in the K separation are set to "Over-
print".

100% Only gray colors with 100% in the K separation are set to "Overprint".

Suitable color spaces for such a black are "DeviceCMYK" with C=M=Y=0%, "DeviceGray" 
or "/Separation/Black".

�

� Note: If you enter 1% in this box, images and shades with the DeviceGray color space are 
also set to Overprint (e.g. if K from CMYK is to be extracted for versioning).

k Any existing black remains unchanged.

K Turn Overprinting Device Gray into K

All overprinting colors in the "DeviceGray" color space are converted to black. This produces 
the "Separation/Black" color space. 

In keeping with the PDF specification, "DeviceGray" colors overprint all spot colors lying 
lower down. However, contrary to expectations, CMY separations are knocked out. 

This conversion causes CMY separations to be overprinted and also affects shades and 
images. This problem doesn't occur if this parameter is checked.

Overprinting "DeviceGray" images and shades are generally used for transparent shadows. 
You would not get satisfactory results without this conversion type.

k All overprinting colors of the "DeviceGray" color space remain unchanged.
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CMYK Overprint Mode

Prerequisites: An overprint option is enabled.

The CMYK overprint mode influences the overprint behavior of DeviceCMYK colors. This applies only 
to graphic and text elements but not to images and blends.

Retain unchanged

The overprint mode defined in the PDF document is used as it is.

Enable (OPM=1), unless otherwise specified

If no OPM (overprint mode) is defined in the PDF document, it is set to '1' when this option is selected.

Always enable (OPM=1)

The OPM is set to '1' in all cases.

Always enable (OPM=0)

The OPM is set to '0' in all cases.

An example of how OPM reacts in overprint now follows:

C M Y K Spot 
color

Existing ink set 10% 0% 30% 0% 50%

Overprinting ink set 0% 20% 80% 0%

Overprint status off, no 
matter whether OPM=0 or 
OPM=1

0% 20% 80% 0% 0%

Overprint status on, 
OPM=0

0% 20% 80% 0% 50%

Overprint status on, OPM=1 10% 20% 80% 0% 50%
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General Tab

Spot Colors

K Map All Spot Colors to Process

This parameter lets you replace all the spot colors in the PDF document by CMYK, i.e. you 
can also print them on the four plates.

k All the spot colors are kept in the PDF document.

Gray Colors

K Turn R=G=B Graphics into Gray

All "DeviceRGB" graphics and texts with the same values for R, G and B are converted to 
"DeviceGray" (Gray = R). 
Shades and images are not converted.

k The RGB values are converted to the target color space by means of the set RGB > "+" Gra-
phic profile. This produces a "mixed" CMY gray.

K Turn C=M=Y, K=0 Graphics into Gray

All "DeviceCMYK" graphics and texts with the same values for C, M and Y are converted to 
"DeviceGray". Consequently, K has the value of CMY.
Shades and images are not converted.
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k The CMYK values are converted to the target color space by means of the set CMYK > "+" 
Graphic profile. This produces a "mixed" CMY gray.

Tolerance Limit (%)

The "Tolerance Limit" box is enabled when you check the two options just named.

This tolerance limit allows you to convert RGB or CMY values to gray also in cases where the equation 
R=G=B or C=M=Y is not met exactly.

Enter a percentage in this box by which the R, G and B or the C, M and Y values may deviate in order 
to be still converted to gray.

Marks Color

You can set parameters that affect the spot color "All" in the "Marks Color" group. Spot color "All" is 
used for marks that will be output in all the separations, e.g. trim and register marks. It should not 
be used for objects that are part of the page content of the end product.

K Turn 4 x 100 % CMYK into Spot Color "All"

Check this option if you wish to convert colors with a definition of 100 % each for C, M, Y 
and K into spot color "All".

k The color definition of 100 % each for C, M, Y and K remains unchanged.

K Remove Spot Color 'All'

All the marks with this color, e.g. trim and register marks, will be removed.

k "All" does not change.

K Turn Spot Color 'All' into K

Check this option if you wish to convert "All" to K. 

k "All" does not change.

�

� Note: These options affect solely text and graphic objects.

Graphic & Text

This option lets you set color values in text and graphic objects to zero if they are below the percent-
age entered in this box.
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Compression

Compress Processed Images

You can choose between "Automatic (JPEG, ZIP)", "JPEG (lossy)" or "ZIP (lossless)" and "JPEG2000" 
for this function. With "Automatic", compression depends on the original image compression. "ZIP" 
compression is noticeably lower than "JPEG" compression, but it is lossless. JPEG compression can 
lead to a loss of quality. Compression is also lossless if you select "JPEG2000" and "100%" for "Qual-
ity".

For All Tabs

Save As...

This button lets you save conversion parameters you have modified as a new set or you can change 
an existing set.

Save & Close

With this function, you can save the selected set using the same name and quit "Settings" at the same 
time. 

Click "Save & Close".

Cancel

You can close the selected set without saving it when you click this button. 

If you changed a parameter, the following alert message appears "Do you want to save your 
changes?" You can still save the parameter set if you confirm this message with "Yes".
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8 Color Editor Spot Colors
Working with Spot Colors

This professional tool makes it possible for you to edit spot colors in PDF documents. You can create, 
modify and discard spot colors. You can replace them by others or give them different color recipes. 
In addition to using any integrated PANTONE®, PANTONE® Hexachrome and HKS® color tables, users 
can create their own tables with custom color recipes.

Colors in a document can be defined as spot colors and then handled as such. Spot colors can be 
imported from external sources and used in the PDF document. You can also export spot colors to 
your own color tables. Two spot colors with the same name but with a different extension for the 
paper type used (e.g. PANTONE 541 CV and PANTONE 541 CVU) can be merged to one separation. 
Naming conflicts are solved automatically in this way.

This lets you take spot colors and colors from the color tables to create your own sets that you can 
then apply to different PDF files.

If spreading is then needed, users can assign attributes to spot colors to produce the desired overlap 
effects in trapping using other colors.

Overview of the functions of the spot color tool:

• Renaming and deletion of spot colors 

• Creation of spot colors

• Merging of several spot colors to one spot color or one CMYK value 

• Conversion of spot colors to process colors with the help of color tables

• Includes PANTONE®, PANTONE®hexachrome and HKS® color tables

• Color table editor for creating custom color tables

• Import/export of colors from/to color tables

• Creation and deletion of new colors

• Individual sets for general spot color settings

Open a spot color:

with a click on the icon opposite in the Acrobat toolbar 
or 
with "Plug-Ins > Prinect 2015 > PDF Toolbox > Color Editor Spot Colors...".
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"Spot Colors" Tab

Selection table

All the process and spot colors in the open PDF file display in a table in the top part of the dialog. In 
addition, all the spot colors saved in the set are displayed.

Name

The color names are used as follows:

+ (plus) The color is used in the set page range of the document.

- (minus) The color is not used in the set page range of the document.

Green After you click the "Apply" button, the color is in the page range. In other words, it can be 
output as a separate plate.

Blue A color is no longer in the page range after you click the "Apply" button. The color was con-
verted to "Process", set to "Ignore" or replaced by another color.

Black The color is created in the PDF file but not in the current page range.
112 Version 2015



Color Editor Spot Colors
Select a spot color in the list. The settings in the "Recipe" group are enabled.

The values of a color are shown when you select a color in the list.

Color space icon

This column shows the color space in which the alternate color of the spot color is created. The alter-
nate color is required to display the color in Acrobat and is also needed for printing if the alternate 
color is used to print the color (e.g. in a proof).

Panel for Color Details

Name

Select the spot color that you want to edit. You can only change the name of the spot color if the 
name is not in the document and also not used otherwise.

When you double-click the selected spot color, you have the option of editing the default name of 
"NewColor" (you can now edit the box).

Target

Click a box in the "Target" column. You can change how the color will be output in the list box that 
appears.

The output behavior of the selected color is defined. All colors that are in the PDF or in the set are 
listed in addition to "Output", "Process" and "Ignore" (see below). In this way you can assign the 
selected color to any other color (alias).

�

� Note: You can also create an alias for the process colors!

• Output
The spot colors are retained and printed as additional colors. When printing a spot color, the 
color data do not influence the printed result, they are only used for simulation on the monitor 
and proofing.

Red User-defined color from the current set that is not in the PDF file and also not used other-
wise (e.g. as an alias of another color).
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• Process

• The spot colors are converted to the alternate color space based on the process values (mainly 
CMYK).

• Ignore

• The spot colors are removed from the PDF file.

Source

This is where you set where the color properties come from, for example, the alternate color. 

• PDF

The color properties come from the color definition in the PDF document. You can only change 
the source to "PDF" if the color is also defined in the open document.

• Job

The color properties were defined by the user and are filed in the set. If you switch to the source 
to "Job", the color definition is copied to the set, even colors from the currently open PDF doc-
ument. These colors are then available in the set for other PDF documents.

• Table

The color properties come from one of the global color tables. You can only change the source 
to "Table" if the color is also defined in one of the active color tables.

• Alias

The selected color is described by another color and uses its properties. You cannot switch the 
"Defined" column to "Alias". "Alias" is applied automatically to all colors that are output by 
another color in the "Target" column.

Type

This setting forms the basis for further processing with Prinect Trap Editor. 
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Each spot color has different overprint properties:

• Normal

This property is assigned to spot colors that, similar to process colors, are translucent in prin-
ting.

• Transparent

This property is assigned to a spot color with a transparent varnish. Transparent colors do not 
have traps.

�

� Note: The objects lying below transparent elements are trapped.

• Opaque

This property is assigned to very opaque, contour-defining spot colors. They are treated as black 
and in the trap always pull the adjacent colors below it.

• Opaque & Ignore

This property is assigned to spot colors that are opaque but are not to be trapped (for example, 
for gold, silver or spot colors where undesirable combinations can occur in the trap).

• DieLine

This property is assigned to spot colors for packaging printing (hull).

If you wish to create a hull when in a PDF, set all the colors in the PDF to "Ignore". Only a "Die-
Line" color is left, and all frames with 0% fill are deleted automatically. Only the DieLine" color 
type and the register marks are left.
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Overprint

Shows the overprint status (default: as defined in the PDF file). 

• Overprint

The selected spot color is set to "Overprint".

• Knockout

The selected spot color is set to "Knockout".

• Unchanged

The selected spot color keeps its defined status.

Rendering Intent

Does not display by default. When you right-click the row with "Name, Target, Source,...", a context-
sensitive menu displays where you can select "Rendering Intent".

You can find a description of the parameters in "Rendering Intent", page 97.

Recipe

This is where you can select the color recipe of the alternate color with which the color will be cre-
ated or modified. The values of a color are shown when you select a color in the list.

�

� Note: You can select "Multicolor-6" or "Multicolor-7" only if they are set as a process in 
"Default > Process Colors".
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Create From

When you select this option, a graphic or text object that has the same color as set here is replaced 
by the selected spot color. The last color measured or RGB green (if nothing was measured so far) dis-
plays when you check this option.

Example: 

You have different graphic or text objects on the page that have RGB red (R=100%, G=0%, B=0%) 
as their color. You want to replace this color by a "dark red" spot color.

1. Click "New".

2. Type the color name and the recipe for "dark red".

3. Now click one of the red RGB elements on the page (the recipe displays below in the messages 
window).

4. Now check the "Create From" option. All red RGB graphics or texts are replaced by the "dark 
red" spot color when you click "Apply".

�

� Note: You can also set the output directly to "Process" for the color you created in order to 
convert directly from one color value to another.

As an option you can choose to map the exact color only, for example to leave smooth shadings 
unchanged.

You can specify the percentage (%) the spot color is to be created.
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Backing

CMYK can also be placed behind a selected spot color. This makes the colors appear more intense, 
for example. The function is enabled if the spot color is to be output (Target: "Output").

The values in the option let you set whether backing with CMYK will apply only to 100% of the spot 
color or also to smaller percentages of it.

Create New Colors

New

You can create a new spot color with the "New Color" function.

1. Click "New". A color named "NewColor" is created in the list box.

2. Change the name to the name you want.

3. Now select the color recipe in which the color will be created and enter the colors in the relevant 
boxes.

�

� Note: You can also use the values of a color that is shown when you select a color in the 
list.

Remove

All the selected colors are removed from the set. You can only delete unused colors that are selected 
and set to "Job" in the "Defined" column.

Import

The imported color is added to the set and can be seen in the list of spot colors.

1. Click "Import...". The "Color Table" dialog displays.

2. Select the color table you want in "Table Name" at the top left of the dialog.

3. Select a color.

4. Click "Copy".

5. Click "Close".

6. You can now see the imported color in the list of the set.

Export

This function allows you to export colors from the current list to your own color tables. You may not 
change the PANTONE®, PANTONE®hexachrome and HKS® color tables.

1. Select a color in the list.

2. Click "Export...". The "Color Table" dialog displays.

3. Select the color table you want in "Table Name" at the top left of the dialog.

4. Click "Copy". You can now see the exported color in the list.
118 Version 2015



Color Editor Spot Colors
5. Click "Save" or "Close". If you click "Close", you will be asked whether or not you want to save 
your changes.

Reset

The list of colors is reset to the current document properties.

Settings

Choose between "Default", "Document", "Customer" and "CMYK".

Delete

The selected settings are deleted from the list.

Save 

The current color settings are saved as a new setting.

Page range

This is where you define which pages in the current file will be edited, i.e. the parameters you set will 
be applied to these pages.

Apply (Object)

You can apply changes made to images or gradients separately in the "Spot Color" window now.

Apply

All changes you made in the spot colors dialog are in the set but were not yet applied to the PDF doc-
ument. This is now done when you click "Apply".

Status panel

Information about the spot colors is shown in the status panel.
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"Multicolor" Tab

Prerequisite: The "Multicolor" license option must be licensed.

The new tab lets you evaluate quality when converting spot colors with a Lab recipe to any CMYK or 
NChannel process color space. 

When you open a PDF with spot colors, the spot colors in it display as values to be converted and as 
a color box. The screenshot below shows that the conversion of red ("Rot") with the selected profile 
was not satisfactory.

The "Multicolor" tab shows you prior to printing the quality of a spot color mapped to process colors 
or to a 6- or 7-color space. 
The quality is expressed in Delta E2000 deviations. 

The deviations are shown in color as optimal (green), warning (yellow) and error (red). This depends 
on custom presettings. In the "Preferences", you define the threshold for a color deviation to be opti-
mal (green), warning (yellow) and error (red). This gives you an overview of the quality of spot color 
mapping at a single glance. 

Mapping depends on the selected press profile that describes the print process, the Rendering Intent 
and the target color space (CMYK, Multicolor-6 or Multicolor-7) that is used to convert the spot color 
to process colors. A color box shows you Before (left) and After (right) conversion.
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"Default" Tab

Folder for Color Tables

You can browse to the color tables in the Prinect system. 

Color tables are located in one central place and several Prinect PDF Toolboxes can access them and, 
consequently, work with the same tables.

Use Color Tables

PANTONE®, PANTONE®hexachrome and HKS® color tables are included in the shipment of Prinect 
PDF Toolbox. 

If "Use Color Tables" is enabled, Prinect PDF Toolbox polls the PDF file for matching definitions 
between these tables and the spot colors in the PDF file. 

If a match is found, Prinect PDF Toolbox takes the recipe from the table to always use current color 
data.

Autoresolve Naming Conflicts

Prinect PDF Toolbox checks the names of all the spot colors if the "Autoresolve Naming Conflicts" 
function is enabled (e.g. 'CYAN' to 'Cyan').

Old PANTONE extensions (CV, CVC, CVU,...) are automatically changed to the new ones (C, U). 

HKS and PANTONE colors whose names only differ in their extensions automatically use one name 
e.g. as with PANTONE CV or C.
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Upper and lower case are ignored during the check. 

Target

Default output behavior of spot colors that are not saved in the set.

• Output

The spot colors are retained and printed as additional colors. When printing a spot color, the 
color data do not influence the printed result, they are only used for simulation on the monitor 
and proofing.

• Process

The spot colors are converted to the alternate color space based on the process values (mainly 
CMYK) and then to the target color space, if necessary, with Heidelberg CMM.

• Ignore

The spot colors are removed from the PDF file.

• Cyan, Magenta, Yellow, Black

The selected color can be output as cyan, magenta, yellow or black.

Process Colors

Select the output profile you want (press profile) and the target color space for conversion. 

• CMYK

The spot color is converted with CMYK.

• Multicolor-6

The spot color is converted with CMYK + orange + green.

• Multicolor-7

The spot color is converted with CMYK + orange + green + blue.

Color Name Correction

Color names can be corrected automatically using the four options.
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Multicolor Analysis

If color distance greater than:

This is where you can enter the values for Delta-E deviations that are within your tolerance. 
Default: > 3.0 (warning, values are yellow), > 6.0 (error, values are red).

Set color values to:

This is where you can set low or high values as a percentage related to 0% and 100%. 
Default: 1% and 99%

Color Distance

DeltaE 2000

DeltaE 1976

Round color values to whole percents

Default: Not enabled

Special Handling for Contone Colors

Spot colors with an area coverage below 100% are converted to the target color space.
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"Color Tables" Tab

The "Color Space" column has been added. 

PANTONE®, PANTONE®hexachrome and HKS® color tables are included in the shipment of Prinect 
PDF Toolbox.

�

� Note: The preferences and the global color tables are generally included if "Spot Colors > 
Default" tab > "Use Color Tables" is enabled.

You can sort existing color tables (define their order) or decide not to use them.
In addition, in "Color Space", you can set "Process" and "Output" to "CMYK" or "CIE L*a*b" transfor-
mation recipes.

�

� Note: Color tables that generally have "process" in their name contain the "CMYK" and "CIE 
L*a*b" transformation recipes. This allows you to set "CIE L*a*b" in the "Output" box for 
spot colors that you wish to output to a proofer, for example, in order to reproduce a larger 
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color space. These settings depend naturally on the output.
The use of Lab recipes gives you much better true-color simulation of the printing process 
in your proof because with PANTONE® the CMYK recipe refers to its own colors and to a cer-
tain type of paper.

Search order

Click a color table and move it to the position you want, holding down the mouse button.

Color Space

Displays the color spaces of a table.

Entries

Shows the number of colors in the color table.

Used yes/no

Click a color table and set it as required. The color tables that have "yes" are used in "Default > Use 
Color Tables".

Process

Select the transformation recipe you want in "Process" and "Output".
"Process" for spot colors that are not printed separately but are converted to process colors.
"Output" for spot colors that are printed separately in their original color. In this case, the equivalent 
display colors are only for simulation in Acrobat or for proofing.

The color spaces set in this group are used in the list when "Output" or "Process" is set in the "Target" 
column. The same applies for "Target" in the "Default" group.

New

You can create new color tables with your own colors with this function.

1. Click "New". The "Color Table" dialog displays.

2. Enter a name in "Table Name" at the top left of the dialog.

3. Click "New" as well in this dialog. 

4. A color named "NewColor..." is created in the list box.

5. Change the name to the name you want.

Now select the color recipe in which the color will be created and enter the colors values in the rele-
vant boxes.

6. Click "Save" or "Close". If you click "Close", you will be asked whether or not you want to save 
your changes.

Delete

You can only delete color tables that you created.
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Modify

You can only edit color tables that you created. Click "Edit". The "Color Table" dialog displays. Make 
your changes. The PANTONE®, PANTONE®hexachrome and HKS® color tables included in the ship-
ment are read-only.
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9 Coating Editor
Coating Editor

Varnish layers are created with this editor. Varnish layers are used for finishing printed products, 
especially in the packaging industry.
Another area of application is the creation of a base coat, e.g. for printing on glass or the like. 

The created varnish objects lie on top of all other objects of a page. However, this isn't important for 
the order in which the data are printed. This means that, even if a white base layer lies on top in the 
PDF, it can of course be printed first.

�

� Note: Mostly only the varnish color is shown in the preview if the "Advanced > Overprint 
Preview" function is not enabled in Adobe® Acrobat®.

To open the Coating Editor option:

• click the icon in the PDF Toolbox 

or 

• select "Plug-Ins > Prinect 2015 > PDF Toolbox > Coating Editor...".

The following window displays:
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Varnish Color

You define the varnish color in the "Varnish Color" group. You can select defined varnish colors (that 
you may have created with "New") from the list box.

Color value

You can enter a color density between 0% and 100% for the color that you will use for varnishing.

New

1. Click "New..." to define a new varnish color.

2. Give the varnish color a name.

3. Select a color space from the list box to define the new varnish. 
The text boxes that appear for the definition of the varnish depend on the color space you 
selected.

4. Enter your color data and then click "OK". The new color appears in the list box.

Modify

Click "Modify..." to edit a varnish color. See "New..." for how to proceed further.

Delete

You can delete a varnish color definition form the list of varnish colors.

Margins

This is where you set whether choking or spreading will be used for the varnish.
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Exact/Spread/Choke

This is where you enable spreading or choking. Enter the width you want and select the unit of mea-
sure. You must enter a minus sign in front of the value for choking. If you choose "Exact", you cannot 
set any value.

You can choose between:

 round

 miter

Objects

In the "Objects" group, you can define which objects will be given varnish. The following options are 
possible:

Full Page

You can select varnish for the whole page with this option. All other options are disabled.

Region

The area to be varnished is confined to the box you selected.

Text, Graphic, Bitmap, Image, Shading, Background

This is where you set which objects will be varnished.

Color selection

You can restrict automatic varnishing with the options provided in Separations/Area. This will let you, 
for example, generate varnish (or a second black) for 100% Black only or varnish CMYK objects only 
without applying varnish to other spot colors.

This applies to text, bitmap and graphics only.
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Page Range - From...To...

This is where you define which pages in the current file will be edited, i.e. varnish will be applied to 
these pages. This allows you to varnish just a single page as well, for example, the title page.

Template / Load

You can save a varnish layer as a template (separate PDF). You can then apply this template to other 
documents as often as you like and save it as a new PDF document.

Invert

You can invert an existing varnish separation (single separation). In "Color selection", select the var-
nish separation that you wish to invert. Create a new varnish color and then click "Invert". This cre-
ates an inverse varnish separation of the color you selected in "Color selection".

�

� Note: You can apply varnish to several PDF pages. Click "Apply", holding down the Shift 
key. A windows displays where you can select various PDF pages for this process.

Remove

Clicking this button will remove the entire varnish layer of the set varnish color, including those you 
placed with the mouse and the keyboard.

Apply

The varnish layer is applied to the selected objects.

Status Panel

The status panel shows information about the varnished objects. (e.g. text, graphic, image). 
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Varnishing Objects Directly with the Cursor/Keyboard

You can use the mouse for simple and fast varnishing if you don't wish to varnish all the objects of a 
certain kind or if you wish to edit the varnish of certain objects. The settings from "Color" and 
"Spread" are applied. The settings in "Objects" and "Page Range" have no effect. The "Prinect PDF 
Toolbox" window must be open for this.

• The object concerned is varnished immediately when you click the page. All objects fully within 
the bounding box you draw are varnished immediately.

• If you press the "Alt" key while clicking the page or drawing the bounding box, the varnished area 
concerned or all the varnished areas fully within the box are removed.

• You can varnish exactly the area you draw if you press "Alt" and "Shift" while drawing the bound-
ing box. In this case, it doesn't matter which page objects are set.

Hint: To exclude a certain rectangular area on the page from varnish, e.g. an address field, you can 
do this simply by first varnishing the whole page, then setting the color value to 0% and then drawing 
the bounding box you want with "Alt" and "Shift". 
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10 Trap Editor
What is Trapping?

Trapping is a term that for some time has been widely used in the graphic arts industry. This term 
refers to the spreading and choking performed between two abutting colors.

Why Trap Colors?

Despite taking great care when printing multiple colors, register differences may still occur. Slight 
shifts (flashes, fringes) can occur at the contours of two adjacent colors.

Minimum overlaps (traps) between objects and colors are generated in the individual color separa-
tions to avoid this undesired effect.

For example, flashes occur because of inaccuracies because the printing units are not adjusted accu-
rately. Flashes are also likely to occur if the paper used is affected by the machine or by temperature, 
air humidity and the moisture content of inks. If the adjacent colors are relatively dark, even a very 
narrow flash is noticeable and cannot be overlooked.

Flashes No flashes

How Are Flashes Avoided?

The simplest way of avoiding flashes is by spreading the lighter color into the darker color. During an 
overprint, the colors will overlap slightly and no flashes will occur even if there are slight shifts in 
color.

In the example given below, the graphics on the left are not trapped while those on the right are (by 
spreading the color).
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A

B

Example: Spread

Example: A
In this case, the color of the square is "lighter". By spreading the color, the corresponding separation 
on the right side is larger when exposed. The colors overlap in the overprint.

Example: B
In this case, the color of the base is lighter. By spreading the color, the knockout size of the letter "H" 
becomes slightly smaller in that separation. The colors overlap in the overprint.

An example of white framing

Fig. 1 - Not only flashes caused by gaps between colored objects, but also overlaps themselves (in 
particular in spot colors) may be noticeable and can disturb the printed image.

In this example, both the yellow triangle and the blue circle are to be printed in their own spot color 
(Fig. 1). 

Fig. 2 - The most common method of trapping by deliberately causing an overlap fails in this case. An 
overlap of these colors, whether caused by a registration error or made intentionally, results in a very 
noticeable green line along the border between the colors. (refer to Fig. 2). 
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Fig. 3 - If at least one of the abutting colors is quite light, then a very good alternative method to avoid 
risking an overlap might be leaving a white gap between the colored areas. In Fig. 3 a white gap has 
been left between the two objects. Offsetting the color separations against each other would also pre-
vent overlapping. Next to yellow, the white frame is less noticeable than the green overlapping zone 
in Fig. 2.

This method of deliberately leaving a gap is known as white framing.

Technical Trapping Terms

Common density

This is the degree to which a color is found in common in each separation of two adjacent colors:

Common
Density

Color 2Color 1

C M Y K C M Y K C M Y K

Neutral density

Each process color (CMYK) has a different ink strength. Neutral density was defined to determine the 
strength of an ink on paper, with paper white having a neutral density of 0.
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Example of neutral density for process colors:

C M Y K

100% Cyan  0.61

100% Magenta 0.76

100 % Yellow 0.16

100% Black 1.70

The following formula can be used to calculate the "neutral density" in values less than 100%:

ND = -1.7 * log (1 - color * (1 - 10 (-0.6 * D) ))

D= Neutral density value for 100% of this separation
color = Actual color value

The neutral density of all separations is calculated from the sum of the neutral densities of the indi-
vidual separations.

Opacity

When trapping, you must take the relationship of the colors to each other into account. 

Overprint properties

The following ink properties exist:

• Normal (translucent)

• Transparent

• Opaque

• Opaque & Ignore
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Functions in the "Trap Editor"
• Automatic color matching

• Convert spot colors to process colors

• Rename spot colors

• Change existing traps

· Change the trap width

· Change the trap color

· Change the trap direction

· Change the trap path

• Add traps

• Trap a page

• Trap all pages

• Trap part of a page
(trapping of selected objects)

• Check trapping parameters

• Re-trap a page with different parameters

• Delete existing traps

• Delete all traps on the current page.

• Delete all traps on all pages

• Create trap settings

• Change trap settings
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Operation of the Trap Editor
Select "Plug-Ins > Prinect 2015 > PDF Toolbox > Trap Editor...".

"Automatic" Tab

Colors in Document

This lists the process colors used with their various parameters. 

Default Ink Set

The predefined neutral densities for CMYK are chosen from ink sets EURO, SWOP or TOYO.

Colors Save

Click this button to save changes you made to the color settings as part of the current settings.

Settings

You can select an existing trap set here. The following sets are available by default:

• defaultSet
Default trap set
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• inkReduSet
Example of a trap set with trap color reduction.

• from PDF File (special case)
The page (PDF file) is already trapped. The trapping parameters taken from the PDF file are 
shown as a default setting in the Trap Settings window.

Delete...

You can delete settings after confirming an alert message.

Modify...

The following window appears when you click "Modify":

You can find a description of this on "Geometry tab", page 169.

Traps From...To 

Specify the pages that are to be trapped. You can also select "All" and "Current" (selected page) as 
page ranges.

Remove

All traps on all pages in the set page range will be removed.

You have the option of selecting other documents to remove traps there as well if you use the Shift 
key with "Remove".
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Calculate

Traps based on your settings will be calculated on all the pages in the set page range.

Existing traps will be recalculated.

You have the option of selecting other documents to calculate traps there as well if you use the Shift 
key with "Calculate".

"Modify" Tab

In this area of the window, the trap parameters and information concerning the objects involved are 
shown in the following form: 

Hide/Highlight/Selection

Hide 

K Traps

This option lets you show a page with and without traps displayed.

Hide 

K Transparent

This option enables pages to be displayed with or without objects with transparent colors. This 
enables the traps to be checked, even if the whole page is covered with a transparent varnish.
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Hiding and Showing Objects

Hide all objects which are above the selected object.

�

� Note: All further actions can now be carried out more simply on the remaining visible part 
of the page.

Show the hidden objects.

Highlight

It is not always easy to detect all the traps on a page. With the next two functions you can highlight 
single and/or all the traps in one of three predefined flashy colors.

All Traps

Highlights all the traps on the page.

Selected

Highlights all the selected traps.

�

� Note: All traps are highlighted if both options are selected. The selected traps are then high-
lighted in the appropriate complementary color.

Overprint

All overprinted objects are highlighted, i.e. at least one separation is set to overprint ("-" sign).

�

� Note: In some situations Prinect PDF Toolbox creates overprint objects instead of traps. 

Double-click one of the three color patches to select the color best suited to highlight the 
traps. 
A dialog displays (Windows) where you can define a custom color.

The changed colors are automatically saved.

Selection

This button enables you to set the trap selection function depending on the situation: 

All Traps

All traps for the previously selected objects are selected.

Same Pairs

All traps from the objects with the same color pair are selected from the group of previously selected 
objects.

Single

Only one single trap is selected from the previously selected objects.
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All objects on the page are selected.

This function is helpful if you wish to check all traps on the page. Use the  (Next) or  
(Previous) buttons for navigation through the traps.

In addition, all objects are selected which have the same color and the same overprint fea-
tures as the object which is currently in focus.

Example: Selecting all red objects
A red object is selected. Clicking this button now selects all red objects which have exactly 
the same color values as the previously selected object.

In addition, all objects are selected which have the same type as the previously selected 
object.

Example 1: Select all images
One single image (image object) is selected. Clicking this button selects all images on the 
page.

Example 2: Select all colored text
One single colored text object is selected. Clicking this button selects all colored text objects 
on the page.

Edit Traps

Edit selected traps; edit the trap description

Edit trap path

Delete selected traps; changes to the overprint attributes are preserved.

Trap selected objects. All selected objects are trapped against all objects lying below them 
using the current valid trap setting. Already existing traps remain unchanged.

�

� Note: The setting for "Trap Selection" or a selected trap neighbor does not affect this func-
tion.

This partial trapping enables the use of different trap settings for different areas of the page without 
it being necessary to define trap zones.

Overprint/Knockout of selected objects
�

� Note: You can only change the overprint attribute if an object is not trapped. This should be 
done when you start your work. The changes are then retained when the page is retrapped.

Selected objects are given the attribute "Overprint".

Selected objects are given the attribute "Knockout".
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Undo

Undo last action

�

� Note: Deleting all traps or re-trapping the entire page can not be undone.

Restore the last action.

Description

If an object or a group of several object has several traps, the previous or next trap can be selected 
using these buttons.

Previous or next trap of the selected objects, above and below the selected objects.

�

� Note: You can select a trap as follows:
Click the first object. Holding down the Alt key, click the second object. The trap between 
these two objects is automatically selected.

Object, Trap, Neighbor

The color of the selected object is shown to the left and the color of the adjacent object is shown to 
the right, at the top of the field. The color of the trap is shown in the center. The relevant object num-
bers are shown in addition to the object colors.

The type of object for the selected and adjacent object is shown below this. 
The following object types are possible:
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Object types

Graphic Colored graphic

Text Colored text

Stroke Colored line

Image Image

Blend Vignette (many small levels)

Shade Soft vignette (level 3)

Bitmap PostScript linework

Copydot

Direction

Trap towards the abutting object

Centerline trap

Trap towards the selected object

Click the arrow, if necessary a few times, until you have the trap direction you want.

Neutral Density

This row shows the neutral density of the selected object, the trap and the adjacent object.

List of process colors used. Each row shows the values for the selected trap and the relevant adjacent 
object for each separation. 

Points to note:

• The "~" sign in front of a separation color value marks an average color value (e.g. for images 
and soft vignettes).

• The "-" sign means that the separation concerned is set to "Overprint".

Width/Height

Trap width in horizontal or vertical direction.
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�

� Note: If a value is entered in the field on the left, this value is automatically adopted for the 
field on the right. 
However, the trap width in vertical direction (right-hand entry field) can be set to another 
value if required.

Bevel

Click the triangle to expand the display for the geometry parameters.

The geometry setting controls how the trapper reacts with regard to line joins which are generated 
and in cases where 3 colors meet.

Quit edit mode without adopting changes

Applies the changes to the selected trap. Quit edit mode.

Clipped Chokes/Mitered Corners

See the "Geometry tab", page 169 for details on the parameters.

"Preferences" Tab

You can define some preferences for the Trap Editor.
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Protocol

In the "Protocol" group, you can define whether a log file will be written or not.

All PDF files edited on a certain day are listed in the log file. This log file records, for example, the 
time the program starts and ends, trap settings used, and the number of trapped objects.

Write PDF Log File

1. Check the "Write PDF Log File" option.

2. In the "Keep for ... days" box, type in after how many days the log file will be deleted automati-
cally.

3. In the "Folder" box, define the folder where the log file will be saved. Browse to the folder you 
want with the button with the three dots.

The log file is named automatically. The name comprises "Prinect PDF Toolbox" and the date (month, 
day and year). The log file is saved as a PDF.

4. Select a paper size for the log file in the "Paper" list box (DIN A4 or US Letter).

Use comment to insert information about applied parameters

You can also define whether a comment about the work done with the Prinect PDF Toolbox will be 
added to this PDF. Enable "Use comment to insert information about applied parameters". You can 
view these details using the added Note and by clicking the Adobe® Acrobat® "Comments" function.

Highlight

Soften Content

This increases the transparency of the page contents by reducing the area coverage to approx. 15% 
of its actual color. As a result, it is much easier for you to see where traps were created.
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Trap width

When highlighting traps, you can increase the trap width by selecting one of the percentages from the 
list box.

"Color Management" tab

Prinect PDF Toolbox can only trap objects that are created in one of the following color spaces: Devi-
ceCMYK, DeviceGray, Separation (single spot color) or DeviceN (multiple spot color). All other color 
spaces (e.g. DeviceRGB, Lab, etc.) must be converted to the press color space to DeviceCMYK with 
Color Management. The Color Editor is the ideal tool for this conversion.

If the colors were not converted to the press color space, Prinect PDF Toolbox automatically checks 
the colors of the page that will be trapped and, if necessary, runs Color Management. You can set 
some parameters that are required for this in the preferences. The Color Editor, however, has a much 
wider and more flexible range of options.

Remove embedded CMYK ICC Profiles

K All embedded ICC profiles that are part of the "DeviceCMYK" color space are removed. This 
setting prevents unwanted "CMYK" to "CMYK" conversions.

k The embedded ICC profiles are used for conversion to the target color space.
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Convert RGB and Device Independent Colors to CMYK

K Prinect PDF Toolbox checks the colors in the document and, if necessary, runs Color Man-
agement.

k The colors in the document are not checked and no Color Management is run. You should 
only select this option if you are sure that there are no RGB or device-independent colors in 
the document. Any objects with such colors in the document are excluded from trapping.

Treat ICCBased Gray and Calibrated Gray as Device Gray

K Colors from the "CalGray" color space are converted to the "DeviceGray" color space with-
out Color Management. The color is used in the K separation. This setting prevents a "chro-
matic" gray.

k Colors from the "CalGray" color space are converted to the target color space using the 
internal parameters. Remember that the color is made up of CMY.

Profile selection

RGB profile:
To convert the DeviceRGB colors (images, text) in the PDF document, select an ICC profile that is 
defined by the "DeviceRGB" color space.

Press Profile (CMYK):
This is where you select the output profile that describes the properties of the output device you 
want. It must be a DeviceCMYK profile.

Click the button with the three dots to display a list box (the appropriate profile folder opens 
automatically) where you can select the ICC profile you want.
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Color Matching with the Trap Editor
Prinect PDF Toolbox has some color-matching functions to ensure that the pages you wish to trap 
have suitable colors. In this color-matching process, all non-CMYK colors (RGB, Lab or other cali-
brated colors) are matched to the equivalent colors in the CMYK color space. Spot colors are ignored 
in this process. This ICC-based color matching is performed automatically before the page data are 
imported.

The following folders are created during the installation of the Prinect PDF Toolbox:

• for Windows XP: "C:\Documents and Settings\All Users\Application Data\Heidelberg\PDFTool-
box\ICCProfiles". To find the files on a Macintosh go to "... Users\Heidelberg".

• for Windows Vista and Windows 7: "C:\ProgramData\Heidelberg\PDFToolbox\ICCProfiles"

This directory contains an ICC profile for CMYK and an ICC profile for RGB. These ICC profiles are 
used for automatic color matching. The RGB profile is used for RGB graphics and images. The CMYK 
profile is used as the final output profile. 

�

� Note: You can replace these supplied ICC profiles with your own profiles by replacing the 
relevant files with your own versions. 

The "Prinect PDF Toolbox > Spot Colors" tool is a feature that lets you convert unwanted spot colors 
to process colors or rename them. However, this can only be done as long as the pages are not 
trapped.

�

� Note: The ideal tool for preparing colors for the Prinect PDF Toolbox is the Color Editor
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Working with the Trap Editor

Important Information

Caution: The way traps are displayed depends on the screen resolution and on the zoom 
factor currently set. To judge the traps on the screen, you must first zoom up the section of 
the page you want to view. If you do not set a high enough scale factor, it is possible that 
only some of the traps will be displayed.

Caution: Viewing the traps in Acrobat can be misleading in certain cases if the Acrobat 
Overprint Preview is not enabled. 

Caution: Make sure that the page you wish to edit has no unwanted spot colors.

The following items must always be remembered when working with Prinect PDF Toolbox:

• You can subsequently change the contents of a page that is already trapped. However, we do 
not recommend this method (exception: for minor changes). 

• While the Prinect PDF Toolbox is being used, in Acrobat you should only use functions affecting 
the view mode and no other functions.

• Only when the PDF document is saved with Acrobat are the changes made with Prinect PDF 
Toolbox permanently saved.

• Wherever possible, the overprint feature is used when traps are created.
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Selecting Objects

Trap selection is based on objects (colored surface, image, vignette, text,...). Each object can have 
any number of traps against adjacent objects. The program focuses on exactly one object pair and 
any accompanying trap. The object has focus. The relevant parameters are then shown in the 
Description section of the window. The accompanying object number is also displayed.

You may select any number of objects:

Prinect PDF Toolbox frames each selected object with a thin bounding box. 
The object pair which is in focus is marked by a slightly thicker frame. 
If all objects are selected, only one thick frame is shown around all of the selected objects.

The following information is displayed in the message box of the main window:

• Number of selected objects

• Number of traps of the selected objects 

• Number of selected traps 

Example:  12 objects  4 traps  1 selected

The Trap Selection button setting determines which traps of the selected objects will be deleted or 
changed. 

Selection per Mouse Click

1. Select the first object per mouse-click. All previously selected objects are then deselected.

�

� Note: The object data (color, type) is displayed in the "Description" field. If available, the 
trap closest to the click-point is also selected and the relevant trap parameter as well as the 
color and type of the adjacent object is displayed.

Multiple selection

2. Add further objects to the selection by pressing the shift key at the same time as the mouse-
click. The object selected last is in focus.
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Selecting covered objects

(3). Deselect mistakenly selected objects by clicking with the mouse and holding down the Shift key 
at the same time.

If necessary, reselect objects per mouse-click and press the following key combination at the same 
time: 

• Alt and Shift key (Windows)

•  and Shift key (Macintosh)

The object selected last is in focus.

Selection with the Rubberband (Lasso)

1. Rubberband a box around all the objects you want to select. The lowest object in the object 
stack is in focus. 

Multiple selection

2. Further objects can be enclosed and therefore added to the selection by pressing the Shift key 
while clicking and dragging. Objects which have already been selected are not deselected! 
Focus does not change

(3). Deselect mistakenly selected objects by clicking with the mouse and holding down the Shift key 
at the same time.

Selection with Menu Functions or the Tool Bar

• "Select > All"

All objects on the page are selected.

This function is helpful if you wish to check all traps on the page. Use the  Next or  
Previous buttons for navigation through the traps.

• "Select > by Color"

In addition, all objects are selected which have the same color and the same overprint fea-
tures as the object which is currently in focus.

Example: Selecting all red objects
A red object is selected. Clicking this button now selects all red objects which have exactly 
the same color values as the previously selected object.
152 Version 2015



Trap Editor
Additional function:
Clicking this icon with the Shift key held down restricts the selection to all objects that have the same 
color and overprint properties. Used in conjunction with "Select > by Type", this function is useful if 
you wish to select all objects of the same type and same color (for example, all black, knockout texts).

• "Select > by Type"

In addition, all objects are selected which have the same type as the previously selected 
object.

Example 1: Select all images
One single image (image object) is selected. Clicking this icon selects all images on the page.

Example 2: Select all colored text
One single colored text object is selected. Clicking this icon selects all colored text objects on the 
page.

Additional function:
Clicking this icon with the Shift key held down restricts the selection to all objects of the same type. 
Used in conjunction with "Select > by Color", this function is useful if you wish to select all objects of 
the same type and same color (for example, all black, knockout texts).

• "Select > Invert Selection" (see context-sensitive menu)

The current selection is inverted, i.e. 

· selected objects are deselected

· deselected objects are selected

The next object up in the stack is selected.

The next object down in the stack is selected.
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Select Traps

Single trap selection

Click on the object whose trap is to be selected. The adjacent trap is automatically selected. 

If the object has several traps, use the  (Next) or  (Previous) buttons to select the desired trap.

�

� Note: You can select a single trap as follows:
Click the first object. Holding down the Alt key, click the second object. The trap between 
these two objects is automatically selected.

�

� Note: The selected traps are highlighted if the K "Selected" option is enabled in "High-
light". 

Several traps selection

If you wish to select several traps, you must first select the relevant objects.

The Trap Selection setting determines which traps are selected.

O All Traps

All the traps of the selected objects are selected (for example, to jointly change their trap width). Trap 
color and trap direction cannot be changed in this mode.

O Same Pairs

All traps of objects with the same color pairing as the objects in "Focus" are selected from the group 
of selected objects (for example, for a joint reduction of the trap color).

O Single

Only one single trap is selected from the selected objects.
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Changing Existing Traps

Prerequisite: You can only edit existing traps in the Prinect PDF Toolbox if you have a valid 
license for it.

(1). If necessary, select the "Selected" option in "Highlight". This makes your work much easier.

2. Select the traps which are to be changed.

(3). If necessary, select a suitable color for highlighting the selected trap.

The current trapping parameters are shown in the "Description" section.

4. Click . 

5. Change the parameters (color, direction, width, ...) of the selected traps.

6. Press the "OK" button.

�

� Note: Only when the PDF document is saved are the changes made permanently saved. 

Add traps 

To create an additional trap, you must first click the two adjacent objects along whose border a trap 
will be created:

�

� Note: You can also use this function for spreading or choking complex bitmaps.

1. Click the first object.

(2). Click on the adjacent object whilst holding the Alt key.

Exception: If an adjacent object is not selected, Prinect PDF Toolbox creates a frame based on the 
color data set without any restrictions caused by background objects (see below for an example).

3. Click . 

4. Define the parameters (color, direction, width, ...) of the trap.

5. Press the OK button.

A choked trap (frame) where all the color values are set to "overprint" (-) reduces the object by the 
set trap width.

A spread trap (frame) where all the color values are identical to those of the object enlarges the object 
by the set trap width.

Trapping Part of a Page (Trapping of Selected Objects)

1. First select the object that is to be trapped with a different "trap setting".

2. Select the desired "trap setting".
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3. Trap object -> click . 
All selected objects are trapped against all objects lying below them using the current "trap set".

�

� Note: The setting for "Trap Selection" or a selected trap neighbor does not affect this func-
tion.

(4). If necessary, use steps 1 thru 3 several times.

5. Select all objects.

6. Select the other "trap setting".

7. Trap object -> click . 
Existing traps remain unchanged. Only previously untrapped objects are now trapped using the 
currently set "trap setting".

�

� Note: You can cancel the function with the Esc key.

Color Reduction

The trap color is made up of certain amounts of the adjacent object colors. The darker trap color that 
results consists of the separations with the higher screen percent density of the two object colors.

Example: 

Color A consists of 100% cyan and 80% yellow, color B consists of 100% magenta and 50% black. 

Based on the rule above, the trap color would be made up of 100% cyan, 100% magenta, 80% yel-
low and 50% black.

A trap color formed in this way is often too dark and, as a result, too noticeable. For that reason, the 
percentages of the separations used to create the trap color can be reduced. The color reduction only 
affects those parts of the trap color that originate from the lighter of the adjacent colors.

Change the trap width

1. Select the traps which are to be changed.

2. Click . 

(3). If necessary, first select the unit of measurement you want for entering and showing the trap 
width.

4. Then type the trap width desired in the "Width/Height" field. You can now enter the value for the 
trap width in vertical direction in the right input field.

5. Click on "OK" to apply the desired changes.
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Change the trap direction

1. Select the traps which are to be changed.

2. Click . 

3. Click the button with the arrow symbol  several times to change the direction of the 
selected trap.

4. Click on "OK" to apply the desired changes.

Change the trap color

1. Select the traps which are to be changed.

2. Click . 

(3). First select the color separation whose value you wish to change. 

�

� Note: The "~" sign in front of a separation color value marks an average color value (e.g. for 
images and soft vignettes).

4. Change the value for this separation in the input field. The sign “-” sets the separation con-
cerned to "Overprint".

(5). If necessary, repeat the last two steps to change the other separation values.

6. Click "OK" to apply the desired changes.
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Change the trap path

Prerequisite: The "Trap Selection" radio button is set to "Single".

1. Select the traps which are to be changed.

2. Click . The selected trap is outlined in the color selected under "Highlight".

The contour can now be changed at any point with the help of the square drag point.

3. First click on the drag point to be changed. The point is then highlighted with a thin line. 

4. Make the changes you want. 

1 2 3
Image 1 Image 2 Image 3

5. Click "OK" to save your changes. "Cancel" discards any changes you made. The trap path editor 
mode is exited.

Ways to Select Points on the Path

Mouse click on a point Deselects all other points on the trap path and 
selects the one you clicked.

SHIFT + mouse click on a 
point

Toggles the selection status (on/off) of a point.

Mouse click on a trap path Deselects all other trap path points and selects 
all the points of the path you clicked.

SHIFT + mouse click on a 
trap path

Adds all the points of the trap path you clicked 
to the selection.

Rubberband (lasso) Selects all the trap path points within the rub-
berbanded box.

SHIFT + rubberband (lasso) Adds all the trap path points within the rubber-
banded box to the selection.

Selection per Mouse Click

1. Select the first point per mouse click. All previously selected points are then deselected.
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Multiple selection

2. Add further points to the selection by pressing the Shift key at the same time as the mouse-click. 
Deselect any points you selected by mistake by clicking with the mouse and holding down the 
Shift key at the same time.

Selection with the Rubberband (Lasso)

1. Rubberband a box (lasso) around all points you want to select. 

Multiple selection

2. You can add further points to the selection by holding down the Shift key during rubberbanding. 
This action does not deselect points that are already selected! 

3. Deselect any points you selected by mistake by clicking with the mouse and holding down the 
Shift key at the same time.

How to Make Changes

Moving a trap path point

Move the point with the mouse or using the arrow keys.

Adding another point to the trap path

Add another point by clicking with the mouse on the trap path while holding down the Alt key (Win-
dows) or the  key (Macintosh).

Adding a (Bezier) curve

Click with the mouse on the trap path while holding down the Alt key (Windows) or the  key (Mac-
intosh) and the Shift key at the same time.

Convert corner point to curved point

Hold down the Alt key (Windows) or the  key (Macintosh) and the Shift key at the same time and 
click the trap path point.

Shift + Alt key ( 
key)

---> Curve point

Alt key ( key) ---> Corner point

Convert curved point to corner point

Hold down the Alt key (Windows) or the  key (Macintosh) and click the trap path point.

Deleting a trap path point

Click the trap path point.
Hit the Del key (or select "Delete" in the context-sensitive menu).
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Move a trap path

Click the trap path and move it with the mouse or using the arrow keys. For each click on the arrow 
key the path moves one pixel. Therefore the distance depends on the current zoom: 

Zoom = 100% 1pt = 0.3528mm

Zoom = 1600% 1/16 pt = 0,022mm

Zoom = 8 x 1600% 1/128 pt = 0.0028mm

Deleting a trap path

Click the trap path to select it.
Hit the Del key (or select "Delete" in the context-sensitive menu).

Trapping at a Glance

What is trapped?

Only composite elements are trapped.

Any linework data and mask images contained there are also trapped. 
Exception: 
Only manual spreading or choking is possible on complex bitmaps (pixeled elements full of details).

Default trap direction: The lighter color moves under the darker color.

Fonts

The following embedded fonts are trapped: 

• Type 1

• Type 3

• TrueType

• Kanji-Fonts

The following fonts are not trapped:

• Multiple Masterfonts

What is neutral density?

"Neutral density" simply means: how light / dark the impression is which a color leaves on the paper.
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Display

Only the measured color values of the traps are shown accurately by Prinect PDF Toolbox. The visual 
display is not true-color as Acrobat cannot depict the overprint of the separation colors. 

Manual traps

The trapper recognizes the separations of frames (manual traps) in PostScript and that they do not 
need any traps.

Trap Width Scaling

Default: 0.1 mm

Function

Sets the width of the traps.

�

� Note: 
The user interface accepts trap widths from 
0.05 pt  to 15 pt or 
0.0176 mm to 5.29 mm.

Width/Height

• Trap width along vertical contour

• Trap width along horizontal contour

�

� Note: Refers to the page as seen on the monitor.

Step Limit (%)

Default:
25% (relative difference between colors in percent)

Function

Trap decision
As of what difference between abutting colors will a trap be created.

A trap is created in those separations where the difference between adjacent colors is greater than 
the input value.

How this works

• Low value: Traps are created even when there are slight differences.
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• High value: Traps are created only if differences are great.

• Max. value 100: Trapping is very seldom.

�

� Note: There is no trapping if the difference between abutting colors is less than 5 %.

Example / Background Info

Colors C60M10% and C50M70% are adjacent. 

An input value of 25% means: 25% of the density of the lighter of the separations is added to it:

C50% + 25% = C62.5%
M10% + 25% = M12.5%

If the darker color is still darker afterwards, trapping is performed.

C60% is not darker than C62,5%. This separation is not trapped.

M70% is still darker than M12.5%. This separation is trapped.

Common Density Limit

Default: 0.5 (neutral density)

Function

Prevents traps between richer colors.

In misregisters, flashes cannot be seen between richer colors.

There is no trapping if the common neutral density (ND) of adjacent colors is greater than the input 
value.

How this works

Min. value 0: No trapping.

Low value: No trapping between lighter colors.

High value: Trapping is still performed between richer colors.

Max. value 10: The "Common Density Limit" parameter would have no effect.

Example / Background Info

Colors C60M20% and C40M70% are adjacent. These colors have 40% in common in cyan and 
20% in magenta. The neutral density value (ND) of cyan is 0.61, that of magenta 0.76. 

Formula for calculating neutral density (ND):

ND = -1.7 * log (1 - color * (1 - 10 (-0.6 * D) ))

D= Neutral density value for 100% of this separation
color = Actual color value

Result: ND= 0.294 common neutral density

With an input value of 0.5, trapping is still performed between these colors. 
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Centerline Trap Limit (%)

Default: 100% (percent)

Function

Trap direction
Is a "centerline" trap to be created?

The default trap direction (lighter color moves under darker color) is not obligatory between colors 
with a similar neutral density (ND).

How this works

Max. value 100%: None of the created traps are "centerline".

Rare exception: Centerline traps will be created if the neutral density of the objects is identical.

High value: A few of the created traps are "centerline".

Low value: Many of the created traps are "centerline".

Min. value 0%: Almost all of the created traps are "centerline".

(Exceptions: "Black" and "Opaque".)

Example / Background Info

A color with a neutral density of 0.9 and a color with a neutral density of 1.0 are adjacent. Input value 
= 80%.

If 80% neutral density of the darker color is lighter than the neutral density of the lighter color, then 
the created trap is "centerline".

Trap Color Scaling

Default: 100% (percent)

Function

Reduction of the trap color

The color of the traps can be reduced (scaled) so that the trap outline does not look like a “frame”.

Generally, in a trap, the separations of the lighter color move under the darker color. Only the sepa-
rations of this lighter color are reduced.

How this works

100% Trap color remains unchanged

High value: A large amount of the trap color is retained. (Small reduction)

Low value: A small amount of the trap color is retained. (Large reduction).

0% The trap would be reduced so much as if there were no trap.

Example / Background Info

Colors "C60M100Y10%" and "Y100%" are adjacent. Input value = 30%.
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In the trap, Y10% of the darker color "C60M100Y10" is replaced by the Y100% of the lighter color 
"Y100". 

The trap would result in a black “frame” with the color C60M100Y100%.

The difference amounts to Y90 (calculated: Y100 – Y10 = Y90). 30% of this is Y27%.

This Y27% is added to the smaller separation values. (Y10 + Y27 = Y37%).

The trap then is composed of the color C60M100Y37%.

Black

Width Scaling

Default: 100% (scaling factor)

Function:

Black can be assigned a wider trap width.

The trap for black is to be wider than the set trap width.

How this works:

Less than 100%: The black trap has a narrower trap width.

100% The black trap is assigned the set trap width. 

150% The black trap is 0.15 mm if a trap width of 0.1 mm is set.

Color Limit

Default: 95% (screen percent)

Function:

Defines black based on the screen percent in the K separation.

A color is treated as black if the K separation has the same value as the input value. It is always a 
contour-defining color and in the trap pulls the adjacent colors below it, for example, white below 
rich black.

How this works:

100% Only colors with K100% are treated as black.

95% A color is treated as black if the K percentage is 95% and higher.

1% All colors are treated as black.

Tip: Reasonable values start with approx- 80% because sometimes it can be difficult to display the 
different density levels in black upwards of this percent.
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Density Limit

Default: 1.6 (neutral density)

Function:

Defines black based on the neutral density of the color.

A spot color is treated as black if it has the same value as the input value.

It is a contour-defining color and in the trap always pulls the adjacent colors below it.

How this works

Min. value 0: All spot colors would be trapped as black.

Low value: Even lighter spot colors are trapped as black.

High value: Only very dark spot colors are trapped as black.

If the neutral density of a spot color is not entered in the color editor, the trapper determines the neu-
tral density from the CMYK substitute color.

If a spot color is not entered in the color editor, the CMYK substitute color is taken from the PDF file.

Prinect PDF Toolbox shows the neutral densities that were determined in the PDF Report in "Color 
Settings" in the "Navigator" tab.

Overprint Text (pt)

Default: 12 (point)

Function

Small black text is not to be trapped but to be set to overprint.

How this works

Min. value 0: No black text is set to overprint instead of trapping.

Max. value 999: Black text up to 999 point would be set to overprint instead of trapping.

Small Text

Size Limit (pt)

Default: 6 (point)

Function:

Determines small-sized colored texts that will have narrower traps than entered in the trap width.

How this works

Min. value 0: No small-sized text would have a narrower trap width.

Max. value 100: Text up to 100 point would be given a narrower trap width.
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Width Scaling (%)

Default: 75 (scaling factor)

Function

The trap width of small-sized colored texts is to be scaled down.

How this works

Value above 100: Small-sized colored texts are given a wider trap.

Value = 100: Small-sized colored texts are given the set trap width.

Value less than 100: Small-sized colored texts are given a narrower trap.

Example: (input value = 75%)
Trap width 0.1 mm, small-sized colored text then has a trap width of 0.075 mm (75% of 0.1 mm).

Special case:
An input of 0% means that no traps will be created for small-sized texts.

Images

Default: Active

Function

Graphic and text create traps to images.

Trapping is to images and vignettes comprising CMYK, gray and spot colors.

There is also image-to-image trapping.

How this works

Automatic (default): The trap direction is determined automatically.

Middle: Centerline traps between image and graphic/text.

To Image: Traps graphic/text towards the image.

To Object: Traps image towards graphic/text.

Background Info

Wherever image and graphic/text overlap, the trapper evaluates the image data for light, middle and 
dark areas. Based on this, the decision whether to trap or not is made and the trap direction deter-
mined.

Color settings

Step Limit

Default: not set

(Prinect PDF Toolbox: SL, default: 25)
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An individual limit can be entered here for every process color separation. These settings override the 
Step Limit setting in Trap.

The "Step Limit" setting in "Trap" treats all process color separations the same.

Trap Color Scaling

Default: not set

(Prinect PDF Toolbox: TCS, default: 100)

An individual color reduction can be set here for every process color separation. These settings over-
ride the Trap Color Scaling setting in Trap.

The Trap Color Scaling setting in Trap treats all process color separations the same

Type

• Normal 
This property is assigned to spot colors that, similar to process colors, are translucent in prin-
ting.

• Transparent
This property is assigned to a spot color with a transparent varnish. Transparent colors do not 
have traps.

�

� Note: The objects lying below transparent elements are trapped.

• Opaque
This property is assigned to very opaque, contour-defining spot colors. They are treated as black 
and in the trap always pull the adjacent colors below it.

• Opaque & Ignore
This property is assigned to spot colors that are opaque but are not to be trapped (for example, 
for gold, silver or spot colors where undesirable combinations can occur in the trap).
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Trap Settings

Automatic Tab > Colors in Document

Color Settings

List of the inks used in the order they will be printed. Each row shows the following parameters:

Type

Type of color as set in the overprint properties 

ND

Neutral Density (ND)

SL

Step Limit (SL)

TCS

Trap Color Scaling (TCS)

TWS

Trap Width Scaling (TWS) - see page 169

The boxes below the list repeat the parameters of the selected line and let you change the parameters 
that are shown.

Print order: Click the relevant process color (inverted bar). Then click the arrow keys until it 
is in the position you want.

Default Ink Set

The predefined neutral densities for CMYK are chosen from ink sets EURO, SWOP or TOYO.
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Trap Width Scaling (TWS)

Trap width scaling depends on the trap color. This function lets you change the trap width separately, 
not only for black but for any colors such as CMYK and spot colors. The trap width depends on the 
dominant separation in the trap. 
Example: If a trap has CMYK values of C 20%, M 30%, Y 50% and K 10%, then yellow is the sepa-
ration with the highest value and the standard trap width is multiplied with the "TWS" factor for yel-
low.

"Modify..." Button in the Trap Editor

Geometry tab

Size (Trap Width)

The trap width can be specified both in horizontal and vertical direction so that it is easier for you to 
customize your work to the different printing conditions. The user interface accepts trap widths from 
0.05 point to 15 point or  0.0176 mm to 5.29 mm.

�

� Note: The trap width required is based on the largest possible register error that can occur 
during the entire processing route right up to the printed result. The size of the horizontal 
register fault can differ from the vertical one depending on the error source.

�

� Note: The orientation of the page on the signature (vertical/horizontal) must be known for 
this.

Width

Trap width on vertical contour (refers to the page, as viewed on the monitor).
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Width = horizontal trap width

ö

Height

Trap width along horizontal contour.

Height = vertical 
trap width

The trap width on the horizontal contour ("Height") is automatically set to the same value when an 
entry is made in the "Width" box. However, the value for "Height" can then be changed inde-
pendently.

Line Split (%)

This parameter is only significant when trapping lines (only choked traps). The object type is "Stroke".

The function helps to prevent a third color, differing from the two trap colors, remaining visible in the 
center of the line.

"Trap Width" is 
multiplied by the 
"Line Split (%)" 

value.

Result larger than 
the line width? Yes

No

The "Trap Width" is 
set to half of the line 

width.

The "Trap Width" 
remains unchanged.

Example:

Line width Trap Width Line Split Resulting Trap Width

1 pt 0.25 pt 200% 0.25*2.00=0.5 < 1   ------>  0.25
pt

1 pt 0.25 pt 500% 0.25*5.00=1.25 > 1  ------> 
0.50 pt

Geometry

The Geometry settings control how the trapper reacts with regard to line joins which are generated 
and in cases where 3 colors meet.
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O Bevel
Line Join:

O Round

O Miter

  Limit (%)

The "Limit" determines when traps on mitered corners are beveled:

100 200 60000
The length is smaller than 5 
i.e. the corner remains miter

b

Limit = 500% (default)

100 200 600300

b

The length is greater than 5 * b 
i.e. the corner is beveled

Limit = 500% (default)

Examples: Limit 100, 200, 300 and 600%
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100 200 600300

3 Color Joins

The "3 Color Join" parameters are used to determine the contour of the trap in those places where 
at least three colors meet.

Mitered Corners

k Mitered Corners K Mitered Corners
disabled enabled

TrapTrap

Clipped Chokes

k Clipped Chokes K Clipped Chokes
disabled enabled

TrapTrap
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Rules tab

Trap

The parameters relating to "Trap" allow a general control of the trapping conditions. The following 
three conditions must be met in order to create a trap:

Absolute difference between separations

The difference in dot percentage between two colors must be greater than 5% in at least two sepa-
rations.

Relative difference between separations

The difference between two separations relative to the lighter of the two must be greater than the step 
limit entered by the user.

Overall common density

The sum of the neutral density of all separations must be less than the common density limit.

Step Limit (%) 

This parameter indicates the degree to which the separations of adjacent colors must vary before a 
trap is created.

A trap is created in those separations where the difference between adjacent colors is greater than 
the input value.

How this works:

• Lower values cause traps to be created even with slight differences in color. Accordingly, there 
are a greater number of traps.

• Higher values mean that traps are created only if the differences in color are greater. Accord-
ingly, there are not as many traps.

�

� Note: There is no trapping if the difference between abutting colors is less than 5 %.
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The step limit ranges from 1% to 100%. The default value is 25%. 

Common Density Limit 

This "Common Density Limit" is used to prevent traps being created in places where flashes are not 
visible due to the ink recipe. Any spot colors will also be taken into account.

How this works: 

• Lower values mean that traps are not created if there are only slight differences in color. Accord-
ingly, there are not as many traps.

• Higher values mean that traps are created only if there are greater differences in color. Accord-
ingly, there are a greater number of traps.

The values for the "Common Density Limit" range from 0 to 10. The default value is 0.5.

Example: "Common Density Limit" = 0.5, this means a trap is not to be created if the common neutral 
density is greater than 0.5.
Color 1 -> 60% cyan and 20% magenta
Color 2 -> 40% cyan and 70% magenta

The neutral density value (ND) of cyan is 0.61, that of magenta 0.76. 

Formula for calculating neutral density (ND):

ND = -1.7 * log (1 - color * (1 - 10 (-0.6 * D) ))

D= Neutral density value for 100% of this separation 

color = Actual color value

Result: ND= 0.294 common neutral density

The common neutral density of both colors is less than the specified "Common Density Limit". In this 
case, a trap is created.

Centerline Trap Limit (%)

The "Centerline Trap Limit" specifies under what conditions a centerline trap will be created.

The default trap direction (lighter color moves under darker color) is not obligatory between colors 
with a similar neutral density (ND).

The default value is 100% and means that no centerline trap will be created.

Rare exception: Centerline traps will be created if the neutral density of the objects is identical.

How this works: 
The lower the "Centerline Trap Limit" entered, the more centerline traps will be created.

Theory:
A centerline trap is created if the neutral density of the lighter color is greater than the neutral density 
of the darker color multiplied by the "Centerline Trap Limit".

The values for "Centerline Trap Limit" range between 0% and 100%.

Trap Color Scaling (%)

"Trap Color Scaling" helps to make traps less noticeable (for example, in pastels).
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The default value is 100% and means that there is no trap color scaling.

How this works: 
The lower the "Trap Color Scaling" entered, the lighter the trap colors and consequently the less vis-
ible the traps.

Theory:
"Trap Color Scaling" makes traps less visible by reducing the various separation colors according to 
their trap color percentage. Trap Color Scaling only affects those parts of the trap color that originate 
from the lighter of the adjacent colors.

The values for Trap Color Scaling range between 0% and 100%.

Example of a Color Reduction

Trap Color Scaling = 75%

The yellow separation in the darker color is 60%.
The yellow separation in the lighter color is 88%.

Without a color reduction, the trap in the yellow separation would be 88%. With Trap Color Scaling, 
the difference (88 - 60 = 28) is now reduced by 75% (0.75 * 28 = 21) and this 21% is added to the 
separation with the lesser value (60 + 21=81).

Result:
By means of a 75% Trap Color Scaling, the trap color in the yellow separation was reduced from 88% 
to 81%.

Keepaway Mode

This is a trapping function that is required especially in some packaging jobs.

With this function enabled, the brighter separations are pulled into the brighter object instead of the 
darker separations being pulled into the darker object during trap generation. This usually creates a 
white frame around every object.

This "White Framing" is useful if you want to keep inks away from each other, 
for example, when printing on metallic surfaces. See page 134 for details.

�

� Note: You could also call this function "inverted" trapping. 

Images

Trap To: K Objects

If checked, images are trapped to other objects. The image pixels are not replicated, instead the traps 
are created by "overprinting" single color separations.

Default: function checked.

Trap To: K Images

If selected, images are trapped to other images. Trapping within images is not supported.

Default: function not checked.

Direction

This parameter controls how traps are placed when images are trapped.
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The following settings are available:

• "Into Image"
Traps are placed in the image.

• "Center"
Traps are centered along the edge between the image and the adjacent object.

• "Into Object"
Traps are placed in the adjacent object.

• "Automatic"
The trap direction is determined automatically on the basis of the color of the adjacent object 
and of the average color of that image area.

Default: "Automatic"

 K Trap complex Bitmaps if possible

Sometimes trapping for complex bitmaps (many small elements) may not be what you want. It can 
be disabled here.

 K Convert Bitmaps to Graphics, if possible

To date, bitmaps were always converted to graphics, where possible. You can disable the function for 
trapping.

Creation

K "Postscript Level 2 if possible" (checked)

The traps are created without using the DeviceN color space. DeviceN color spaces are not repro-
duced correctly on PostScript Level 2 RIPs.

"Postscript Level 2 if possible" (unchecked)

The DeviceN color space is used when required during trapping.
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Black/Text tab

Black

The parameters relating to "Black" are used for the special way black colors are handled.

Width Scaling (%)

"Trap Width Scaling (%)" allows you set a different trap width for black. This ensures that in the case 
of a rich or fat black the colors lying below are not visible as margins on the pages.

How this works: 

• Lower values -> narrower traps

• Higher values -> wider traps

The default value is 100%.
This value means that the normal trap width is used for black.

The values range between 0% and 10000%.

Example:
To obtain 1.5 times the trap width for black, a value of 150% must be set.

Color Limit (%)

"Color Limit (%)" defines the threshold above which the trapper treats a dark color as solid black and 
thus applies the special rules for black.

How this works: 
The smaller the value, the more likely a dark color will be treated as black.

The default value is 95%. 
The values range between 1% and 100%.
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1%  all colors with at least 1% black are treated as black

100% only 100% black is treated as black

Hint: Reasonable values start with approx- 80% because sometimes it can be difficult to display the 
different density levels in black upwards of this percent.

Density Limit

"Density Limit" defines a threshold for neutral density above which the trapper considers a spot color 
to be as dark as black.

�

� Note: The special rules for black are applied to a dark spot color only if the value set for 
"Color Limit" is reached.

The user can specify that a dark spot color should be treated as black by setting the Black Density 
Limit less than or equal to the neutral density of the spot color.

How this works: 
The smaller the value, the more likely a dark color will be treated as black.

The default value is 1.6. 
(The neutral density of SWOP black is 1.7.)
The values range between 0 and 10.0.

Black Overprint

K ) Text up to (pt) 

All black texts that are smaller than or the same as the font size specified here are set to "Overprint". 

The default value is 12 point. 
The values range between 0 and 999 point.

Setting the size of the body text is advisable so that this is converted to "Overprint" while headings 
and headlines are trapped normally.

K ) Lines up to Width (mm)

All black line objects (type = Stroke) are set to "Overprint" if they do not reach the limit width.

K ) Graphics

All black graphic objects (type = Graphic) are set to "Overprint".

�

� Note: Black objects are not set to "Overprint" if they lie above other opaque or black objects 
and whose color comes after black in the order of printing. If this were not the case, the 
black object would be completely covered in the print.

Opaque

This property is assigned to very opaque, contour-defining spot colors. They are treated as black and 
in the trap always pull the adjacent colors below it.
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Opaque & Ignore: This property is assigned to spot colors that are opaque but are not to be trapped 
(for example, for gold, silver or spot colors where undesirable combinations can occur in the trap).

Opaque Color Limit (%) 

If a color is defined as "Opaque" or "Opaque & Ignore", the color separation must have at least the 
value set in this box so that the special opaque handling can be applied to the object during trapping. 

In other words, you can define as of which limit a color will be treated as opaque. Its trapping is dif-
ferent as a result. This requires that the color is set to "Opaque".

(Small) Text

Under this name, parameters are integrated which control the specific behavior of the Trapper with 
regard to smaller fonts. This should help to reduce possible problems with the legibility of smaller 
fonts which can be caused by trapping.

Size Limit (pt)

Colored fonts below or equal to the size specified here are given special treatment. The trap width 
(defined by the "Width Scaling" parameter) may be reduced in such cases.

"Overprint" cannot be used here as this would change the color of the text.

The default value is 6 point. 

Width Scaling (%)

If the font size of a colored text is smaller than specified in "Size Limit (pt)", the trap width for this 
text is scaled down as set here. 

The default value is 75% and means that the trap width for small fonts is scaled down to 75% of the 
original trap width.

Special case:
An input of 0% means that no traps will be created for small-sized texts.

Thin Lines

In "Lines", parameters are integrated which control the specific behavior of the Trapper with regard 
to existing lines. This should help to reduce possible problems in detecting thin lines which can be 
caused by trapping.

Size Limit (mm)

Colored lines less than or equal to the width specified here are given special treatment. The trap 
width (defined by the "Width Scaling" parameter) may be reduced in such cases.

"Overprint" cannot be used here as this would change the color of the lines.

The default value is 0.0 mm. In other words, each line width is taken into account.

Width Scaling (%)

If the width of a thin line is smaller than specified in "Size Limit (mm)", the trap width for this line is 
scaled down by the percentage set in this box. 

The default value is 100%. In other words, there is no change. For example, with 75%, the trap width 
for thin lines is scaled down to 75% of the original trap width.
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Special case:
An input of 0% means that no traps will be created for thin lines smaller than the size entered in 
"Size Limit (mm)". 

Document tab

This is where you can specify limits regarding the complexity of page contents or runtime. In a large-
scale automated mode, this prevents a long-running action from blocking everything.

You can select the following restrictions:

• Maximum size of page content (MBytes)

Warning: All pages will be trapped except for those pages whose page content is too large.
Error: The trap is aborted for the whole document.

• Maximum number of objects in page content

Warning: All pages will be trapped except for those pages that have too many graphics, images 
or texts.
Error: The trap is aborted for the whole document.

• Maximum trap time (minutes)
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Warning: All pages will be trapped except for those pages whose trap time is exceeded.
Error: The trap is aborted for the whole document.

General Trapping Rules

Trapping changes your page to cover up any errors that may occur during print. In other words, errors 
are deliberately built in to hide other errors (a case of choosing the lesser of two evils). 

The way to generate a trap is marked by a number of steps which must be carried out for each tran-
sition between different object colors:

• Decide whether to trap or not.
Must a trap be generated at a color transition?

• Define the trapping direction.
If a trap must be generated , in which direction must it be set?

• Define the trapping color.
When the trapping direction has been set, the correct color for the trap must be determined.

• Generate the trap.
Finally, the trap must be generated using the determined parameters.

Trapping Rules

Trapping changes your page to cover up any errors that may occur during print. In other words, errors 
are deliberately built in to hide other errors (a case of choosing the lesser of two evils). 

The way to generate a trap is marked by a number of steps which must be carried out for each tran-
sition between different object colors:

• Decide whether to trap or not.
Must a trap be generated at a color transition?

• Define the trapping direction.
If a trap must be generated , in which direction must it be set?

• Define the trapping color.
When the trapping direction has been set, the correct color for the trap must be determined.

• Generate the trap.
Finally, the trap must be generated using the determined parameters.
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To Trap or Not to Trap

Trap algorithm

For every pair of adjacent colors (that are visible) on a page, the trapper (trap algorithm) checks 
whether a trap is necessary or not. This decision is based on the properties of the inks used in the 
adjacent objects.

In principle, the following rules can always be presumed:

• If one of the neighboring colors is very light, trapping is not required.

• If the neighboring colors do not contain common separations, or if the "common" color resulting 
from the separations present in both object colors is very light, trapping is required.

Trap Direction

The trap color is normally darker than that of the adjacent colors. To ensure that the trap is as invis-
ible as possible, it must be generated in the darker of the two neighboring colors. 

Which of the two colors is the darker one can be judged on the basis of their neutral densities.

If the abutting colors have a similar lightness, it is difficult to decide which trap direction is the "cor-
rect" one. This means that the neutral density of the colors is similar. In this case, it can be a better 
idea to insert a trap in both colors; such a symmetric (centered) trap changes the contours of neigh-
boring colors of similar brightness in a less noticeable way than a one-sided trap.

Trapping Rules for Black

Black suppresses all other colors because it has such a high density that other colors become prac-
tically invisible in composite printing. Therefore, special rules are applicable for black to achieve opti-
mum results.

Colors containing a large amount of black are called solid black and are given special treatment in 
trapping. In such a case, the non-black separations are spread under black. This exception ensures 
that only the black separation determines the visible edge of a color transition.

Fat black

Rich or fat black refers to a color that consists of a large amount of black plus other amounts of at 
least one other separation. These additional color components that are used to obtain a darker 
(hence “fatter") black can lead to misregisters at the edges of the color.

The special treatment of fat black where the other separations are choked back under black helps to 
avoid such a problem.
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Trap Color

Generally, the trap color is a mixture of the two adjacent colors. For each separation in the two colors, 
you usually take the darker of the two and generate a new color, the trap color, from these separa-
tions. 

Trap Color Scaling

Trap colors formed in this way are often too dark and, as a result, too noticeable. Trap color scaling 
can be used to create lighter colors.

The Principle of Trapping 

Trapping is based on vector data. With this type of trapping, you can trap against other vector data 
and images. Trapping within images is not supported. 

The trapper creates traps based on its internal rules and on the settings defined by the user. It eval-
uates the adjacent colors and decides whether to trap or not, and, if so, the direction and color of the 
trap. 

The quality of scanned images generally suffers from pixel-to-pixel trapping.

Trapping of Spot Colors

Spot colors are fully supported. The following properties in spot colors must be taken into account 
when trapping them:

• Each spot color has a certain neutral density.

• Each spot color has different overprint properties:

· Normal

This property is assigned to spot colors that, similar to process colors, are translucent in 
printing.

· Transparent

This property is assigned to a spot color with a transparent varnish. Transparent colors 
do not have traps.

�

� Note: The objects lying below transparent elements are trapped.

· Opaque

This property is assigned to very opaque, contour-defining spot colors. They are treated 
as black and in the trap always pull the adjacent colors below it.
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· Opaque & Ignore

This property is assigned to spot colors that are opaque but are not to be trapped (for example, for 
gold, silver or spot colors where undesirable combinations can occur in the trap).

Trap Editor Viewer

If the Trap Editor does not have a valid license key, it runs as the Trap Editor Viewer with a restricted 
functional range.

Basically, the Trap Editor Viewer has the following functions:

• It edits and saves parameter sets

• It highlights all the traps on a page.

• It highlights individual traps by clicking an object on the page.

• It shows the color of a selected object, the trap and the adjacent object.

• It checks the trapping parameters the file was trapped with.

• It deletes all the traps on a page or in a document.

�

� Note: You cannot make any changes to traps with the Trap Editor Viewer, you can only view 
them!

�

� Note: The way traps are displayed depends on the screen resolution and on the zoom factor 
currently set. To judge the trap width on the screen, you must first zoom up the section of 
the page you want to view.

Trap Editor Demo Mode
�

� Note: You can also use the demo mode of the Trap Editor to test its full function range. You 
can find details about this in Demo Mode.
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11 Screening Selector
Screening Selector

This professional tool makes it possible for you to create various objects in PDF documents such as 
graphics or images with different screens for output. 

You can save custom "Settings" for use. These settings can consist of the screen system, dot shape, 
screen frequency and dot size. Simple operation makes sure that "Settings" are assigned to a selec-
tion of similar objects. The assigned "Settings" are added to the objects in the PDF file and, as a 
result, go on to the RIP as well.

�

� Note: Prinect PDF Toolbox works together with Prinect MetaDimension as of version 6.0 if 
you enable the MetaDimension Object Screening option there after purchasing it.

�

� Note: Prinect PDF Toolbox does not work on preseparated PDF files. The pages must be 
filed as a composite PDF. If necessary, use Prinect PDF Assistant's separation tool to convert 
preseparated pages to composite.

Use Prinect MetaDimension Screen Systems Only

If you wish to work only with screen systems that are released for your Prinect MetaDimension, you 
must copy the "ScreenList.xml" file from Prinect MetaDimension to the config folder of the PDF Tool-
box. 

You will find the file for Prinect with the Renderer in: \servername\PTConfig\SysCon-
fig\Nodes\servername\Tools\Renderer\version\Highres\UserData\ScreenList.xml

and for Prinect with Prinect MetaDimension in the share\\MetaHost\OutputPlans.

You can also browse to this file. See page 188

Launch from the Prinect PDF Toolbox

1. Open Prinect PDF Toolbox:

by clicking the icon shown opposite 

or 

with "Plug-Ins > Prinect 2015 > PDF Toolbox > Screening Selector".
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The following window displays:

Edit

Object Types

This is where you assign your "Settings" to the objects in the PDF document.

The following options are possible:

Default

The setting selected in this box applies to all objects in the PDF document. You can define a screen 
system in the "Settings" tab.

Text, Graphic, Image, Bitmap, Shading

The object types that you enable (have tick) are excluded from the setting shown in "Default". For that 
reason, the relevant setting shown in "Default" is dimmed. You can assign objects a different setting 
in this group.

From ... To 

This is where you define which pages in the current file will be edited, i.e. the parameters you set will 
be applied to these pages.
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Remove

All screening data in the PDF document is removed. This does not affect the way objects are dis-
played on the screen.

Apply

All settings made in "Object Types" are applied to the PDF document. This does not affect the way 
objects are displayed on the screen.

�

� Note: A batch mode is also possible if you click "Apply" and hold down the Shift key at the 
same time. This means that the settings are applied to any number of files in a folder.

Selection

"Selection" refers only to the page currently displayed and not to other pages in the PDF document.

�

� Note: Your selection in this group does not affect what you selected in "Object Types" and 
in turn "Apply".

You can select objects in the PDF document in four different ways. For example, you can select all 
the objects on the page together to give them a new screen, then deselect one object and assign it a 
different screen, or you can view all objects with the same screen, etc.

Click this button to select all the objects.

Click this button to invert your selection.

In this case, you must have selected an object first. Then all objects of the same type are 
shown when you click this button.

Screening data about objects must be available in this case, either already in the PDF doc-
ument or screenings you assigned yourself. Click an object. Then all objects with the same 
screen are shown when you click this button.

The setting used for the selected objects is shown in the list box to the right. You can select another 
setting at any time in this box. This new setting is applied immediately to the selected objects. 
Screening data assigned to the object is removed if you switch to "No Screen System" in the list box.

Details...

Click "Details" to open the "Settings" dialog. You can view details about the selected setting in this 
dialog. You cannot make any changes here.

Select objects with the mouse/keyboard

As an alternative to selecting objects and ranges in the window, you can also select them using the 
mouse and keyboard. See Selection of items in Object-Editor / Screening Selector for a description. 
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Status panel

For example, this shows screen settings for selected objects in the PDF document.

Settings

MetaDimension/Renderer screen system information

This is where you can browse to the screen list.
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New

2. Click "New...". You must first select an existing setting if you wish to use it as a preference. The 
"Settings" dialog displays:

This is where you can select the parameters that you need for screening.

3. Start by giving your "Setting" a suitable name in the top box.

Filter

4. If you want, you can now select the recorder and perhaps its resolution. This confines the selec-
tion of screen systems, frequencies and dot sizes to those available for the recorder you 
selected. Other options are filtered out.

If you set a certain resolution in "Resolution", only the frequencies for this resolution will be available 
for the recorder you selected. All the screen frequencies for the recorder are shown if you set "All".

5. Then select the screen system and the dot shape. Whether or not you can select just the screen 
frequency, dot shape or both depends on the screen system you selected.
AM screen (amplitude modified) = only frequency
FM screen (frequency modulated) = only dot size
Hybrid screening = frequency and dot size
IS Classic = frequency + dot size (Prinect MetaDimension as of version 7.0)

You can choose between "lpi" and "lpcm" for the frequency.

�

� Note: Heidelberg screen settings (i.e. those created at a different workstation with Prinect 
PDF Toolbox) are automatically created if these settings come with the PDF document and 
they are not on the current workstation in the Prinect PDF Toolbox. These settings are read-
only. You cannot change or delete them.
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Non-Heidelberg screen settings are automatically removed when the Prinect PDF Toolbox starts. This 
is indicated in the status panel.

You can find more details about screening:

• on the Prinect MetaDimension DVD > Work with MetaDimension > Prinect MetaDimension 
Screen Frequencies

• if Prinect MetaDimension is installed, in > Heidelberg Prinect MetaDimension > Books Online > 
Prinect MetaDimension Screen Frequencies

Angles

6. This shows the screen angles for each separation color. You can edit these angles if needed.

The CMYK colors and "Default" are always listed. Spot colors in the PDF document are also listed. 
They always have the angle as shown for "Default", e.g. Magenta (45.0°).

You can change the angles in two ways:

1. Select a color in the list box and then a new angle. For spot colors, you cannot select the color 
that is set above in "Default", in this case, for example, Magenta (45.0°). You must select a new 
angle for "Default" if you wish to change all the colors with a "Default" angle.

2. With the "Automatic" button. For spot colors, the angles are assigned based on a certain order.

�

� Note: You cannot change angles in FM (frequency modulated) screening.

You can reset any changes you made with "Reset".

3. Close the dialog with "OK". The settings are now saved.
190 Version 2015



Screening Selector
The list in "Settings" then shows the name and the parameters you set. You can view the screen fre-
quency in "lpi" or "lpcm". Explanation of the symbols:


Turquoise dot: No angle changed
Symbol with arrow: Angle changed
Gray dot: No angle change possible

Modify...

Select the setting you want and click "Modify...". The "Settings" dialog displays. You cannot change 
settings that are used in the PDF document.

Delete

Select the setting you want and click "Delete". The setting is deleted without any alert message. You 
cannot delete settings that are used in the PDF document.
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12 Object Editor
Object Editor - General Information

The "Object Editor" shows you the various properties of placed elements and you can modify them 
accordingly. You need a separate license. 

A new component in the "Object Editor is the "Wireframe View On/Off" quick tool that reproduces the 
outlines of the various elements on the page. The tool has no other functionality. Its purpose is to help 
you detect elements and their structure on a page more easily.

The "Object Editor" now has three tabs for easy operation. A button bar was also implemented along 
the bottom of all the tabs to provide direct operation. These buttons reflect for the most part the func-
tions in the context-sensitive menu.

The edit options open to you vary depending on the object selected (graphic, image, text). These edit 
options are also found in the context-sensitive menu (select the object and right-click).

"Color/Overprint" tab

Special features in the tab

You can view and edit the following properties:

• Color, Overprint, Transparency, Color Mixture

In addition:

• You can modify color profiles for graphics and text using the list box.
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• You can modify color profiles for images using the "Modify" button. 
Furthermore, you can map images and smooth shadings of a device-independent color space to 
a device-dependent color space by "deleting" the assigned ICC profile.

• Import of color tables.

"Geometry" tab

Special features in the tab

• Move, rotate, scale objects, define fill rules and modify margins.

• Matrix operation for page and object reference points.
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"Text" tab

In the new tab, you can now view fonts explicitly and edit them. 

Special features in the tab

• Modify font type, font size, character spacing and word spacing of selected text.

• Convert text to paths (with the "Graphic" button).

• Embed a font into the document.
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Working with the context-sensitive menu / lower part of the 
window

The "Object Editor" also has a context-sensitive menu, one with a selected graphic object (left col-
umn) and one without a selected object (right column) with the following functions: 

Brief Overview of the Overall Functionality

• The following properties can be displayed or run as functions:

Color, Overprint, Transparency, Color Mixture

Geometry (line weights, line pattern, line shapes, fill rules)

Fill / Box on/off

Position, Size, Rotate

· Image and smooth shading properties can not be edited!

Selection of objects ("All", "Nothing", "Invert", "By Color", "By Type", "By Color and Type")

Delete, duplicate objects, put objects to front or back

Create new spot color using the list box and "New…"

Convert indexed images to normal images.

Color picker supports measuring in images and shades
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The color picker remains active if you keep the  "SHIFT" key pressed during measuring (for 
repeated measuring). 

The values are displayed in the message pane during measuring with the color picker (color 
space and color values)

Editing of axial and radial smooth shades

Undo/Redo (selection of objects is maintained)

Ungroup text into words or characters

Create new graphic objects using the context-sensitive menu and using buttons

Rectangle/Square (with "Shift" key)

Ellipse / Circle (with "Shift" key)

Freehand polygons / Bézier curves with the Path Editor

Edit individual outline points with the Path Editor

Positioning of objects also possible with arrow keys / Shift + Tab + arrow key = bigger displace-
ment steps

Rotating of an object by specifying the rotation angle

Points to note about operation

• When several objects are selected, there are restrictions regarding possible changes.

• Positioning, size changes, scaling, rotating and mirroring are possible also on several selected 
objects.

• You can execute the following functions only if the selected objects are of the "Text" and/or "Gra-
phic" type and all have identical properties: 

· Changing the fill or box color

· Changing overprint or transparency properties

· Changing the box properties

· Enabling / disabling fills or boxes 

• Tip: If you wish to change the fill color of several graphics in the same way, you can first deselect 
the fill and afterwards select it again. The same also applies to the border color and border prop-
erties.
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Editing the path

More details can be found in "Mouse and Keyboard Shortcuts", page 39 in the "Editing the path with 
the Path Editor", page 40 section.
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13 Assemble Pages
Working with Assemble Pages

Assemble Pages lets you assemble two or more PDF pages to one page This can be useful, for 
example, if you wish to add missing elements such as marks or text, place elements on free spaces 
like newspaper ads, for example, or create different language versions.

This section first describes all possible settings of the plug-in. Some practical examples are given 
after this section.

You must have at least two pages open at the same time to be able to work with Assemble Pages.

Mounting procedure

Launch Assemble Pages by clicking the icon shown to the left in the menu bar or selecting 
"Plug-Ins > Prinect 2015 > Assemble Pages". 

The following window displays:
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Favorites

This is where you will find pages that are constantly used, e.g. a custom logo.

To add documents...

These let you add documents as your favorites, just add documents or delete selected documents.

Position Check...

With this function, you can select positioned pages (elements) in a document one after the other; the 
respective pages (elements) are identified with frames. This lets you easily check each of the posi-
tions (without having to click in the document). 

Position

Specify the way the added page will be positioned in the "Position" group. You can define the vertical 
as well as the horizontal position.

Scaling

This is where you enter the scaling factor of each selected object in horizontal and vertical direction.

You must disable "Proportional Scaling" if you want the horizontal and vertical directions to have dif-
ferent scales.

Size

This is where you check or edit the size of a single selected object. 

Procedure

First, you must open the target file.

If you wish to position your object (with drag-and-drop) either from the "Favorites", "Opened Files" 
or root folder, the target object will have "plus signs" (hotspots) for positioning. 
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Another dialog displays when you let go of the left mouse button on a "plus sign" (hotspot): This is 
where you select the range of pages in you will place your object.

• Page Range From - To

· All

· Current

· Even

· Odd

• Transparency

Using the transparency slider, you can check the differences between PDFs (e.g. original and 
correction copy). To do so, place both pages on top of each other with "Drag and Drop" and drag 
the new page onto the center "plus sign" (hotspot). You can match the "transparency" using the 
slider.
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• Reference Value 

The pages are assembled based on reference boxes. When you select a box, one of the things 
you can decide is whether you want trim between the pages.

Click "OK".

�

� Note: You can also place everything (all the pages) of a source object in a target object.

To do this, click the name of the document on the left side and drag-and-drop it onto a hotspot in the 
target document.

Snap lines

When you drag a page onto the middle hotspot and then move it by drag-and-drop, "snap lines" (lines 
running through the vertical and horizontal center of the pages of other objects) appear automatically 
for exact positioning.

You can also scale up or down the assembled object and rotate it using the rotation tool.
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Context-sensitive menu

You can scale the pages up and down also using the tools in the menu bar or with "Zoom In" / "Zoom 
Out" in the context-sensitive menu as well as select "Previous View". You can also select the functions 
listed above in the context-sensitive menu.

Mask Box

Use this tool to insert a frame that will cover certain unwanted contents.

On the left, you can edit the values of the mask box by typing in different values.
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Examples of Assemble Pages

You can also use the page mount to add missing elements to a PDF.

Adding Missing Marks

This way you can, for example, merge sheets that only have the required register marks with docu-
ments lacking such marks.

For this purpose, you must open the otherwise "empty" file in the background.

Then set the transparency for both documents to 100%.

If necessary, align the pages to each other by selecting the file with the marks as the "source" and 
the page to be mounted on all pages of the current document.

Tip: You can create a margin for the marks missing in the PDF to be printed with Geometry Control 
beforehand.

Language Versioning

You can also create different language versions. For this purpose you need one language-independent 
PDF and one PDF per language with the relevant texts.

The benefit of such a versioning approach is that you don’t have to create a complete PDF for each 
language variant.

Both PDF documents, the basic document and the language version, must be open.

Set the transparency for both documents to 100% as before and align the pages to each other.

Select the PDF document that will be added to the current document as the "Source".

Save the completed language version under a new name to preserve the original file for future ver-
sions.

Inserting Elements (e.g. ads)

You can also add individual "elements", i.e. objects smaller than the completed file, to an existing 
PDF file and accurately position them. For example, this could be an ad where current data to be 
inserted on particular pages or an individual address on a flyer used for several branches.
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14 Barcode Editor
Barcode Editor

You can use the Barcode Editor to create new barcodes and replace or correct inadequate or faulty 
ones.

Launch of the Barcode Editor

You will find the icon for the Barcode Editor in the Prinect toolbar. You can start the Barcode 
Editor on a PDF page with "Plug-Ins > Prinect 2015 > Barcode Editor" or by clicking the icon 
in the Prinect toolbar. A dialog displays.

General

In the "Text" tab, you can define custom text marks and position them with the "Plus" button. In the 
"Barcode" tab, you can generate a barcode.
You set up the barcode at the top right, and a preview of the currently set barcode is shown at the 
bottom right. There is a panel for messages, properties or comments on the barcode below this pre-
view.

Barcode Selection

You select your barcodes from a list of available codes.

You can make a preliminary selection of the barcodes to be shown in the list using the "Barcodes", 
"2D barcodes" and "Binary codes" buttons. 

You can selected the following barcodes at present:
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Barcodes 2D barcodes Binary codes

Barcode Properties

You set up each barcode in the parts of the dialog that are specific for this barcode as the different 
barcodes also need different parameters.

Example: EAN-13 not only needs "Content" but also "Addon" and "Distance" for its setup.
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Geometry

The narrowest element in a barcode is known as a module. 
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"Module width", "Module height": You can enter a module width in these boxes or modify the set one. 
You can define the module height yourself or use the one suggested. You can set "Module Width" and 
"Module Height" in points or millimeters. 

"Optimized for...": Optimizes the module with regard to the target resolution.

"Bar Width Adjustment": You can set bar width adjustment in points or millimeters.

You can offset the dot gain resulting, for example, from the absorbency of the paper used with bar 
width adjustment. Dot gain would make the bars wider than intended, a fact which would noticeably 
restrict the read capability of the barcode.

Barcodes are specified in 10 sizes (SC0 thru SC9). The SC sizes determine the module width, in other 
words, the width of the narrowest bar.

The following table shows you the dimensions for EAN-13:

Size/module width (mm) Module width 
(%)

SC0 / 0.27 28

SC1 / 0.297 90

SC2 / 0.33 100

SC3 / 0.363 110

SC4 / 0.396 120

SC5 / 0.445 135

SC6 / 0.495 150

SC7 / 0.544 165

SC8 / 0.610 185

SC9 / 0.66 200

"Position X/Y": This shows you the position of the barcode on the PDF page after you applied the bar-
code.
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Color

You can set or select the color of the barcode itself and the background. 

"Barcode Color": The colors suggested in the list box depend on the document. All the colors in the 
document are presented. 

"Text color": The colors suggested in the list box depend on the document. All the colors in the doc-
ument are presented.

"Background Color": You can set the background color to "Transparent", "Knockout" (no color) or cre-
ate your own color ("Custom"). 

You can pick a color from the current document with the pipette icon and use it as the background 
color. You can also click the three dots. In the dialog that appears you can use the sliders to create 
the background color you want.
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Text

In the Text group, you define which font you will use for text in the barcode and whether this text will 
be shown.

• Select the font you want.

"+": This lets you select the font you want from a list box of installed fonts.

"-": This lets you remove a font from the list box. 

Disable "Show Text" if you just want bars in the barcode, i.e. no text.

"Font Size": Enter the font size you want.

Enter the space between the lines and text in "Distance".

The list box following "Content Position" defines the start position of the content.
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Margins

You set the barcode borders in this group.

• Tick bottom left: The barcode is given a border. 

• Tick in middle box: The border marks of the barcode are shown.

• Tick bottom right: The end of the barcode is indicated by border mark ">" or "<", at the bottom 
left and right respectively. The area up to the border marks must remain blank. There is no bor-
der mark if there is a digit on an outer side of the barcode. These border marks are type-depen-
dent and not allowed in all barcodes.

Example:

EAN-13 has border mark ">" only on the right if "Text" is enabled because there is no space for one 
of the left.

The value in "Width of Border Marks" defines the width of the border or the border marks. 
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Position

A separate tab now shows the position values of the placed barcode. 

Additional displays and functions:

• Alignment Vertical/Horizontal

Applying the Barcode

You will see a preview of the currently set barcode in the lower part of the Barcode Editor dialog.

Barcode Preview

In the preview, the number above the barcode indicates the number of selected barcodes. This is a 
reminder so that you do not apply planned changes to all the barcodes.

Add/Edit/Delete Barcode

When all barcode parameters are set, you can apply it to the selected PDF page.

Click the "Add" icon.

The barcode is centered on the PDF page. You can also apply the barcode using the context-sensitive 
menu item "Add". In this case, the barcode is positioned at the mouse pointer position. 
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You can use the icons along the top margin to modify the barcode. The context-sensitive menu as well 
provides you with various ways of editing the barcode.

You can

• Scale up/scale down

• Select the "Previous View"

• Fit the width

• Fit the height

Delete; you will also find the "Delete" function in the context-sensitive menu. You can also 
delete with the "Del" key.

"Rotate" lets you rotate the barcode. You will also find the function in the context-sensitive 
menu.

You can select and rotate several barcodes at the same time.

The angle displays while you rotate in steps of 5° with the Shift key.

• Determine dimensions.

With the tape measure (ruler) you can quickly determine the dimensions of objects. You can choose 
the following units: mm, points, inch, cm 

The changes are applied to the PDF page with "Close". 

You can modify the barcodes again or delete them after they are read in again.

Example of a barcode in the packaging industry:
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Load Templates

Click the icon in the top icon bar.

This lets you load and use data that already have barcodes.
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15 Imposition Editor
Imposition Editor



The Imposition Editor is implemented as an Acrobat plug-in. The "Imposition Editor" folder has some 
examples that you can use as templates when using the tool the first time. In addition, the folder also 
contains tutorials.

The Imposition Editor is designed for you to set up an imposition scheme for a PDF file and to show 
a preview of the press sheets that is as accurate as possible. The Imposition Editor lets you impose 
PDF files with visual control.

Overview of the main functions: 

• You can generate a great number of schemes or edit defined schemes. 

• You can use master pages to set up the pages of your schemes (size, orientation, back margins, 
etc.). 

• Selection of binding methods

• Marks setup

• Sheet setup (printing material, imaging window, etc.) 

• Setup of how the sheet will be utilized (layout of several folding sheets on one press sheet) 

You can save all your settings as a job ("*.jdf" file). In this way, you can work on your job at any time, 
such as printing it again or using it as a template for other jobs.

�

�
�

� Note: Changes that are made in the PDF file using other PDF Toolbox tools are immediately 
visible in the (started) Imposition Editor and are incorporated here. 

Launch of the Imposition Editor 

You launch the Imposition Editor from Acrobat. 

Proceed as follows to launch the Imposition Editor the first time: 

1. Start Acrobat. 

2. Open your PDF file. 

3. To launch the Imposition Editor, click this icon if it is in the toolbar or select "Plug-Ins > Prinect 
2015 > Imposition Editor  ...". 

4. If you start the Imposition Editor by clicking the icon, the "Select a Job" dialog opens. 
Click "Cancel" and select "Use Default Layout". The open PDF converts automatically to a 
default template (Flyer layout) and displays the layout in the Imposition Editor.

Proceed as follows if you wish to use an existing layout:

1. Start Acrobat.
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2. Open your PDF file.

3. Click "Plug-Ins > Prinect 2015 > Imposition Editor > Open Layout...".

4. The "Select a Job" dialog is displayed.

5. Select the job (*.jdf) whose settings you wish to use for the PDF file.

6. Click "Open".

7. The Imposition Editor opens your PDF with the selected job settings.

8. You can use all Tools of the Imposition Editor / Context-Sensitive Menu on it. 

Explanation of the Graphic Elements 

When you open a job, you first see the page contents. You can hide the PDF page contents for a sim-
plified, schematic view. 

The graphic below shows you a view where the page contents are hidden so that the various graphic 
elements can be seen clearly.
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• White area: The white area represents the printing material. 

• Light gray area: (should be the same size as or bigger than the printing material) This is the 
imaging window. It contains all the imaged objects. 

• Dark gray areas: Dark gray areas the size of the page portray hidden page contents. 

• Purple circle with white "F" on the page: Marks a page orientation. 

You will see the "F" if the page contents are hidden and shown as gray areas. This allows you to 
still recognize the orientation of a page.

• Blue dashed box (around a page): Trim box.

A bleed was defined for this display. You see the bleed as a border that goes beyond the trim box 
(see also Bleed). 

The pages were centered in the trim box (see also "Page Policies", page 227).

• Green dashed box: Folding sheet

The trim allowance was calculated automatically for this display. Otherwise the green box would 
encompass the trim boxes.

• White numbers on the page: Numbers for the page placeholders in the layout
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Tools of the Imposition Editor / Context-Sensitive Menu

You can apply the following functions using the toolbar (from left to right):

• "Save job" - "Save" / "Save as"

• "Output Job"

• Scale up the view or scale down with Ctrl key

• Return to the previous view

• Fit width and height: The current view is fit automatically so that you can see all image elements 
in horizontal direction. 

Make sure that your window is active.

• Use the Tape measure to measure lengths

• "Show/close document view" - show or hide the PDF with pages.

• Show/hide imposition settings

• Select the unit of measure: mm, inch, points

• Context-sensitive menu - Display the context-sensitive menu in the Layout view

"Save job" - "Save" / "Save as"

You can save the jobs that you edited with the Imposition Editor as a "*.jdf" file. 

You can open a saved job at any time to edit it (open it from Acrobat with "Plug-Ins > Prinect 2015 > 
Imposition Editor > Open Layout..."). The "Prinect PDF Toolbox Editor - Select a Job" dialog displays.

Your job is saved under its present name with "Save". You can give your job a new name when you 
save it with "Save As".

�

� Note: Your "*.jdf" file has references to the PDF file. If the paths to the content files change 
(because you moved the file), it is possible that content files or marks are no longer found 
when you open a job. 

In such a case, the "Missing File" dialog displays, giving you the following options: 

• You can set a new path to the content file in a browser dialog. Click "Retry" when the path is set 
correctly. 
218 Version 2015



Imposition Editor
• "Cancel": The job displays without content pages if you click "Cancel". Instead, the same num-
ber of page placeholders as required by the job scheme is generated.

"Output Job"

Click the icon shown opposite. The "Output Job" dialog opens.

This dialog lets you output the job as an imposed PDF file:

• "Output in Acrobat":

This lets you output directly in Acrobat and then to a proofer, for example.

• "Choose a Hotfolder": 

You can select the hot folder (target folder) manually or using the browser dialog. 

• "Output of": 

This is where you set whether you wish to output only the front, only the back or front and back. 

• "Mode"

This is where you can select whether folding sheets, sheets or the plate size will be output.

· "Plate Size": You output the whole imaging window in your final output. This is always 
set by default.

• "Print Range": This is where you set which parts of the job will be output. 

· "All": The entire job is output. 

· "Pages": You can define the pages that will be output in the box beside it. All the pages 
are output if you do not define any pages. 

All sheets that have defined pages are output. 

· "Sheets": You can define the sheets that will be output in the box beside it. All the sheets 
are output if you do not define any sheets. 

The file names are numbered consecutively if you output sheetwise. 

• "Keep as one file": The job is output as a PDF file if this option is set. 

The job is output sheetwise if this option is not set. In other words, a PDF file is generated for 
each sheet. The file names are numbered consecutively if you output sheetwise. 

Tape measure 

The tape measure makes it simple for you to measure distances. You set the unit of measure 
in the Acrobat menu "Edit > Preferences > Units and Guides". 

You can use the tape measure as follows: 
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1. Click "Tape Measure" (or press the "m" key). The cursor changes to a crosshair. 

2. Click the view with the left mouse button and draw the tape measure holding down the mouse 
button. The distance you are measuring shows while you are holding down the mouse button.

The tape measure also lets you measure at 90° angles. To do this, hold down the Shift key at the 
same time when you are measuring.

"Show/close document view" 

A column that can have the following items opens/closes on the left when you click "Show/
close document view": 

• "Content" (working without layers): All the PDF content files are listed below this item. The page 
list can be shown for every PDF file. The pages in the page list are numbered consecutively. 
These numbers are found below each page. If a page was assigned to the layout, the page place-
holder number from the layout appears on the corresponding page in the page list. A double 
click on the page opens the page in Acrobat.

• "Content" (working with layers): The layer names are shown below "Content" when you work 
with layers. The PDF files shared by all languages are generally shown below the first layer. The 
language-specific PDF files are generally shown below the second layer. 

• Page selection: This is where you select the range of pages that you will use. Do not enter any-
thing if you wish to use all the pages.

Enter the page numbers or page ranges separated by commas (e.g. 1, 2, 4-9). Then click "Apply".

• Context-sensitive menu of a page: You can open a context-sensitive menu for each page in the 
page list. 

· "Open in Acrobat": The selected page displays in Acrobat.

· "Properties...": See Terms Used in the Imposition Editor. 

Show/hide imposition settings

Click the icon shown opposite. This lets you hide and show the column with the tabs for the 
imposition settings. As a result, the layout view can be scaled up.

Context-sensitive menu

Right-click in the layout view of the open PDF file or job. 

The following functionalities are possible:

Zoom

• "Zoom In": Click "Zoom In" (or press the "z" key). The cursor changes to a magnifying glass with 
a + sign. 
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· Click the view with the left mouse button to scale it up.

· You can also scale up a certain section of the view. Click with the left mouse button, then 
holding it down, create a box over the section you want. When you release the mouse 
button, you will see a scale-up of the section you marked. 

• "Zoom Out" (or press the "Ctrl" key): Click "Zoom Out" to scale down your view.

• "Last View" (or press the "l" key): The view of the last scale up/down displays. 

Add PDF Mark...

Normally, this function is used for plate control strips and Dipco marks. You can select the angle, out-
put and positions on front and/or back in a properties dialog. Use the context-sensitive menu to go 
to the properties dialog. Select the mark and right-click.

You can reload a PDF mark to the layout by clicking the icon with the three dots.

The "Select a PDF Mark" window opens. You can now immediately load a new mark. The "PDF Mark 
Properties" window opens when you close the window or load a mark:

• "Front/Back": This lets you decide on which press sheet the mark will be positioned, e.g. a color 
control bar only on color separations.

• "X Position" / "Y Position": This function lets you set the position of the PDF mark manually. The 
bottom left corner of the printing material is the reference point.

• "Confine to Subject Width/Height": You can define whether or not the mark can be seen only in 
the subject area.

• "Angle": Selection of the angle for rotating the PDF mark.

• "File Name": Name of the mark. Click the icon beside it and browse to the mark that you want 
to add.

"Select a PDF Mark" list box: You can insert PDF marks directly with this function. A file selection 
dialog first opens where you can select the PDF mark you want. The mark is then inserted with 
its bottom left corner at the position of the mouse pointer.

"Remove": Right-click the PDF mark and select "Remove" in the context-sensitive menu.

• "Preview": Shows actions done in the dialog immediately.

�

� Note: It's worthwhile disabling the preview if you have jobs with a great number of pages.

"Info Text"

Text marks are shown when this function is enabled. When you enable one of these marks in the lay-
out view, you can set the following options through "Properties" in the context-sensitive menu:

• "X Position" / "Y Position": This function lets you set the position of the text mark manually. The 
bottom left corner of the printing material is the reference point. 

• "Right arrow": Applies the position of the front mark also to the back.
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• "Color Names next to one Another": When this option is enabled, the separation color names are 
arranged next to one another and not on top of one another.

• "Angle": Selection of the angle for rotating the text mark.

• "Comment": This is where you can enter text that can be added to the text mark and also printed 
with it. 

• "Preview": Shows actions done in the dialog immediately.

"Show"

The settings below are applicable only to the screen display and do not affect your print later on. 

• "Frames": You can show or hide frames with this function. The blue guides surround the 
trimmed size. The green guides surround the folding sheets.

• "Marks": This is where you set whether marks will be shown or hidden for a more simple view. 

• "Content": This is where you can set whether or not the page contents will be shown. Gray areas 
display if page contents are not shown. You can see a purple circle with a white "F" on each 
page. This tells you how the page is oriented.

• "Page Numbers": This is where you can set whether or not page placeholder numbers of the lay-
out will be shown. 

• "Clip Pages": You can use this function to set whether or not contents excluded from imaging or 
printing will be shown.

This function is applied in the following situations: 

· A page content is larger than the trimmed size plus bleed. 

Everything that juts beyond the bleed is not shown if the "Clip Pages" function is 
enabled. 

· There is artwork that is not positioned in the imaging window. 

These objects are not shown if the "Clip Pages" function is enabled. 

If the function is disabled, you can view all the objects and check whether or not you 
really want to image them.

"Properties...(page)"

If a page is active in the layout view, "Properties" displays for selection in the context-sensitive menu. 
You can use it to view specific page details for every page. 

1. To do this, right-click a page.

2. Select "Properties..." from the context-sensitive menu. 

The "Page Properties" dialog displays: 

• "Document": Document name with path 
222 Version 2015



Imposition Editor
• "Page": Position of the page in the page list

• "Ordinal": 

See "Ordinal". 

• "Rotation": Page orientation in the PDF file 

• "Scale": Scaling of the page 

"Boxes" group 

This shows you the boxes listed below with size and X/Y position (X/Y = page origin at bottom left). 
There will be no information about a box if it is not defined for a PDF page. 

• "Media Box": The media box comprises all objects of a page, including text and images that 
appear on the page or extend beyond the page.

From a technical point of view, the media box defines the limits of the physical medium on which 
the page is to be printed. Apart from the complete page, it can comprise space for trim marks, 
color control bars and other elements. 

Contents outside the media box can be deleted without changing the essential PDF file contents 
because Adobe® Acrobat® ignores objects outside the media box when creating PDF files.

• "Crop Box": The crop box defines the area the page content is cropped to for display or output. 
In contrast to the other box types, this box does not tell you anything about the physical page 
geometry or intended use. It merely defines how the page contents are cropped. The crop box 
defines the way the page contents are positioned on the output medium if no other information 
is available (e.g. imposition instructions defined in a JDF or PJTF job). 

• "Trim Box": The trim box shows the final document size after printing and cutting. The trim box 
must be smaller than the bleed box or media box. 

• "Bleed Box": The bleed box represents an extended area around the trim box causing the entire 
page contents to be trimmed when a bleed area is defined. A document requiring a bleed also 
requires a bleed box. The bleed box is always larger than the trim box and smaller than the 
media box. The bleed area of a printed page can have marks, slug lines, etc.

• "Art Box": The art box represents a page area (e.g. a graphic file) that will be positioned when 
the PDF content is to be placed in an application such as a DTP program. The art box must be 
smaller than the bleed box.

Imposition Settings

The functions shown in the lower part of the dialog are valid for all the tabs:

• "Auto Apply": All the imposition settings are shown immediately in the graphic if this option is 
set. 

• "Apply": You can apply your settings with "Apply" (i.e. view them) if "Auto Apply" is not set. 
Prinect PDF Toolbox  –  User’s Guide / Online 223



Imposition Editor
• Show

"Front": Only the front is displayed.

"Back": Only the back is displayed.

"Front/Back": Front and back are displayed.

"Transparency": The transparency setting is best either with just the "Front" or "Back" view. You 
can use the slider to simulate on the screen how the other surface shines through. If "Front" is 
set, you will then see a simulation of the back shining through. If "Back" is set, you will then see 
a simulation of the front shining through.

"Sheet" tab

Plate Size 

The imaging window includes everything that will be imaged, i.e. subject with bleed and marks. 

• You can select: Custom, Fit, QM 46; SM 52; SM 74; SM 102.

• Custom: You can define the size of the imaging window through "Width" and "Height". 

• Fit: The size of the imaging window is fit to the size of the printing material. 

· An offset that was defined for the printing material compared to the imaging window 
(see X/Y position) is taken into account in "Fit". In other words, the imaging window is 
then the same size as the printing material plus the material offset.

Printing Material

• You can select a predefined printing material size from the list box. 

• "Width" / "Height": You can type in values for the printing material size in these boxes. "Custom" 
then displays in the "Format" list box.

• "Orientation": Orientation refers to the imaging window. 

• "X / Y Position": Offset of the printing material in positive X or Y direction in relation to the imag-
ing window. The imaging window automatically becomes bigger if an offset causes the printing 
material to jut beyond it. 

• You can use "Horizontal center" to position the printing material on the imaging window so that 
it is centered in the X position.

Folding Sheet Position 

This is where you position the bottom left corner of the subject in relation to the bottom left corner 
of the printing material. 

• "Mode > Center": The subject is centered on the printing material.
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• "Mode > Custom": The subject is positioned manually. 

• "X Position": Subject offset in X direction.

• "Y Position": Subject offset in Y direction.

Placement Rule 

• "Perfector" work style: Two plates are created for printing, one for the front and one for the back. 
The stack is turned from front to back after printing the front. A perfector in the press very often 
does this.

• "Sheetwise" work style: Two plates are created for printing, one for the front and one for the 
back. The stack is turned from right to left after printing the front. 

• "Work-and-turn" work style: The front and back are located on one plate. (As a result, you do not 
need a plate for the back.) The stack of paper is turned after printing (from right to left) and prin-
ting is now on the reverse side. 

• "Work-and-tumble" work style: The front and back are located on one plate. (As a result, you do 
not need a plate for the back.) The stack of paper is tumbled after printing (from front to back) 
and printing is now on the reverse side. 

"Marks" tab

This tab allows you to set and modify marks that refer to the layout or folding sheet. 

Folding Sheet Cuts, Cut Marks, Folding Marks, Fold Lay Marks

• "Offset": The mark is moved outwards by this value. 

• "Length" / "Width": Length and width of the mark 

Ink Pickup Bar

As many as three ink pickup bars are possible, namely C, M, Y, K, X, Z, U, V, S1, S2 or S3 and - (no 
ink pickup bar).

Color Bar

The top left corner of the subject is the reference point (zero point) for the color control bar. 

By default, the color control bar is always placed at the top left above the subject. 

• Use "Offset" to set the vertical position of the color control bar. 

Each ink zone is calculated to have 5.5 patches. The following functions run automatically in the 
background when you display a color control bar: 

• One patch per ink zone is always inserted for every process color. The dot percentage is 100%.

• Spot colors are calculated to have 1.5 patches if you have four process colors. The spot color 
patches are distributed as evenly as possible across the color control bar if you have more than 
one spot color.
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• Empty patches are inserted for process colors that are not used. If the remaining patches should 
not be needed for spot colors, they are then used to display the used colors with a dot percent-
age of 70%. 

• A special color control bar with a grayscale displays for pure black-and-white outputs. 

• A separate color control bar is generated in each case for front and back if you use the "Work-
and-turn" or "Work-and-tumble" work style (see "Front / Back"). 

Register marks

This is where you select the position of the register marks, whether they will be "Floating", "On side" 
or "Top/Bottom". 

You can also select the width (line width) and offset in X and Y direction.

Collating mark

• "Automatic" list box: The length of the collating mark is defined automatically. You can type in 
the width.

• "Custom" list box: You enter the length and width of the collating mark manually.

• "Length" / "Width": Length and width of the collating mark

"Master Pages" tab 

A master page is a parameter set for a page placeholder in a scheme. A master page 
defines, for example, the size of the page placeholder in the scheme (trimmed size), the 
Bleed and the Trim. 

Default

Lists the master pages found in the PDF. A master page is always assigned to each page placeholder. 
The "Default" master page is assigned by default to each page placeholder.

"+": You can create a new master page with this button. Type a name for the new master 
page in the dialog.

"-": This function lets you remove the master page you selected in the list box. You can only 
remove a master page if a page placeholder is not assigned to it. 

The parameters of the master pages include:

Page Size 

• You can select predefined sizes for the trimmed size (or page placeholder) in this list box. 

The size of the master page is equivalent to the size of the trimmed size on the press sheet.

"From PDF" is the predominant size of all the trim boxes of the PDF document (see also the 
"Boxes" group). 
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• "Width" / "Height": You can type in values for the trimmed size in these boxes. "Custom" then 
displays in the "Standard Sizes" list box. 

Orientation

• This is where you define whether the master page is portrait or landscape.

Page Policies

• Placement rule for the assigned pages. This is where you define how an assigned page will be 
placed in the page placeholder (e.g. "Center"). 

· "Center": The assigned page is centered on the trimmed size. Page content that juts over 
the trimmed size or bleed is cut off.

· "Lower Left": The bottom left corner of the assigned page is placed on the bottom left 
corner of the trimmed size. Page that juts over the trimmed size or bleed is cut off.

· "Scale to Fit": The assigned page is scaled proportionally to fit exactly into the trimmed 
size. 

· "Unconditional": The bottom left corner of the assigned page is placed with no con-
straints on the bottom left corner of the trimmed size. For example, a page that is too big 
is not scaled and the page content juts over the trimmed size. The projecting part is not 
cut off.

"Trim Allowance for Pages" Group 

• "Automatic calculation of Trim Allowance": When you set this option, the Trim is calculated so 
that the folding sheet and printing material are the same size. This saves you cutting along the 
outer edge. 

• The folding sheet bounding box is the same size as the printing material if there are several fold-
ing sheets on the printing material. 

• "Left", "Right", "Top", "Bottom": These are the page margins for which you can define a trim. 

The trim is assigned to the page content. This means that "Top" is always the trim at the head 
of the page, no matter what orientation the page has. 

• "On even Pages" "Swap Left/Right": This function makes it easy for you to define a back margin. 
The values for the right and left margin are swapped when this option is set. 

• "On even Pages" "Swap Top/Bottom": This function makes it easy for you to define a back mar-
gin for calendars. The values for the top and bottom margin are swapped when this option is set. 

The procedure is the same as for "On even Pages" "Swap Left/Right".

• "Bleed": This is where you define the Bleed. 

Bleed is used to specify the maximum amount of page content outside of the Trim Box that is to 
be printed. If bleed is defined for a PDF page (via PDF Bleed Box), but the bleed is smaller than 
the master page bleed, the printout is limited to the size of the Bleed Box. 
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Tips:

If a bleed unexpectedly does not appear, the following can be the cause:

• No Trim Box is defined for the PDF page, or the Bleed Box is smaller than or the same size as 
the Trim Box.

Remedies: Correct the bleed box / trim box or set the correct height and width for your own trim 
size; in addition, set the page policies to "Centered".

• No trim allowances for the pages are defined in the master page.

Remedy: Define sufficient trim allowance for the pages.

• The limit value for the bleed in the master page is "0".

Remedy: Correct the limit value for the bleed.

Example of How to Define a Back Margin

The following example will be used to illustrate the function: 

• Binding is to be on the left side on pages with odd numbers. 

• Binding is to be on the right side on pages with even numbers. 

Proceed as follows if you wish to set a trim only on the binding edges: 

1. Type in the trim you want for your binding edge in "Left". 

The trim is shown as a hatched area in the graphics below: 

Even Page Odd Page

2. Set the "Swap Left/Right" option. 
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As a result, the values in "Left" and "Right" are swapped for the even pages. In this way, you set the 
trim only on the binding edges as you wanted.

Even Page Odd Page

Trim left/right are swapped!

"Scheme" tab 

You can use a predefined scheme in "Scheme". All the other functions are for defining a new 
scheme.

In other words, you can create a new scheme or load a predefined one. 

"Scheme" group 

You can select a predefined scheme in this group. 

You cannot overwrite predefined schemes. 

"+": This lets you create a new scheme. You can change a predefined scheme, for example, 
by adding columns. The "+" sign  is active and you can click it and enter a name for a new 
scheme in the dialog that displays. 

"-": This lets you remove custom schemes that are selected in the list box. 

Explanation of the Name Used for a Scheme

The elements of scheme "F6-2 3x1P" are taken as an example to explain the naming in standard 
schemes:

F6-2 3x1 P 

(1) (2) (3)

• (1): Name of the scheme as listed in Heidelberg's fold type catalog

· First digit: Number of pages per folding sheet 

· Second digit after the hyphen: Consecutive number

• (2): "Number of columns" x "Number of rows"
Prinect PDF Toolbox  –  User’s Guide / Online 229



Imposition Editor
• (3): Numbering is for a brochure if a "P" is added to the scheme name. This is a scheme for the 
"Accordion Fold" pagination mode.

This type of pagination only affects single-lined schemes. Viewed from page 1, page numbering 
is to the right and circular (including the back) and in ascending order. All the pages have the 
same orientation. 

Numbering is for a calendar if a "C" is added to the scheme name. 

"Columns" and "Rows"

• "Columns": Number of columns in the scheme.

• "Rows": Number of rows in the scheme.

"Master Pages" 

This is where you can assign a master page to the selected page placeholder.

"Ordinal" 

This is where you can change the ordinal for the selected page placeholder. 

To create a blank page, enter "0" as the ordinal. In this case, no page is assigned to this page place-
holder. 

"Orientation" 

• "0°": Orientation of the pages selected in the lower graphic is normal. The arrow in the page 
placeholder points up. 

• "180°": Orientation of the pages selected in the lower graphic is head-to-foot. The arrow in the 
page placeholder points down. 

"Front / Back" 

• No tick in "Back": A scheme is edited only for the front.

• Tick in "Back": A scheme is edited for front and back. 

Graphic View

You can view the graphic of the front and back for the scheme in this panel.

The arrows in the page placeholders show the orientation of the pages. The numbers are the page 
placeholder numbers for the pages. 

Layout tab 

"Binding Methods"

• "Saddlestitch"
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In saddlestitching, the folded press sheets are nested. As a result, the position of a document 
page on a folding sheet not only depends on the scheme selected, but also on the size of the 
publication. For this type of binding, the program automatically combines the highest and lowest 
page to a pair and then calculates the position of each individual page. The scheme is repeated 
until all the document pages are assigned to a folding sheet. If necessary, blank pages are added 
to the first folding sheet.
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• "Perfect Binding"

In perfect binding, the folded press sheets are placed on top of each other, milled off at the back 
and glued. The scheme is repeated until all the document pages are assigned to a folding sheet.

"Creeping Value"

You use the creeping value to offset unwanted creeping.

The creeping value that you can define in this box defines creeping between two successive two-page 
spreads. 

A positive value shifts the inner pages inwards (towards the spine). A negative value shifts the inner 
pages outwards. 

The value determines the offset per fold layer.

The page spacing changes if you enter a value for creeping.

Click the icon shown opposite. Fixed marks are enabled or disabled.

The page cut marks stay in the same position even if you entered a creeping value.

Fixed Marks: If your document has more pages than defined in the scheme, you can use this option 
to specify whether the folding sheets will be nested (saddlestitch) or stacked one on top of the other 
(perfect binding), which can lead to different pagination of the folding sheets. Creeping compensates 
the shift of the inner pages outwards. The setting is taken into account in all cases except when the 
scheme only has one page. The cut marks are not shifted inwards if "Fixed Marks" is set.

In "Saddlestitch" creeping is calculated for all the pages of the job, even if there are several folding 
sheets. 

In "Perfect Binding", creeping is calculated only for the pages of a single folding sheet, regardless of 
how many pages the job has as a whole.
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"Gripper Collator"

Normally, a strip of paper/material is used to pull the folding sheets on to the saddle if a sad-
dlestitcher is used to collate the sheets. The position of the gripper margin on the sheet depends on 
the folding sheet scheme. The folding sheet becomes bigger because of the gripper margin. As a 
result, all the pages are shifted.

Choose between a front fold and rear fold if you need a gripper margin:

• None

• Fold Rear

• Fold Front

"Margin"

Enter the width of the gripper margin of a folding sheet.

Press Sheet Layout

This is where you define how the folding sheets are arranged on the press sheet. 

You always start off with one folding sheet per press sheet. In other words, folding sheet 1 is placed 
on press sheet 1, folding sheet 2 on press sheet 2, etc.

"AutoArrange Folding Sheets"

The folding sheets are arranged automatically so that the printing material is utilized to its maximum. 
This means that the maximum values for "Columns" and "Rows" are set automatically. 

The folding sheets are duplicated to fill the sheet if "Repeat" is set. If it is not, the folding sheets are 
not duplicated but arranged consecutively.

"Collate, Cut and Stack"

You can use "Collate, Cut and Stack" if you placed a number of different folding sheets on a press 
sheet. The function can be used with perfect binding as well as saddlestitching.

• Function disabled: 

Each press sheet is cut separately. The cuts sort out the folding sheets. 

• Function enabled: 

All the press sheets of a printing unit are first stacked. The number of stacks you will have as a 
result corresponds to your press run, i.e. one stack of press sheets per printing unit. Then each 
stack is cut so that you have your folding sheets. As a result, you will have a number of folding 
sheet stacks that are then stacked or collated in the correct order. 

Collating the press sheets and/or folding sheets can be automated depending on the capability 
of the finishing route. 

In contrast to the disabled function, the order/layout of the folding sheets on the press sheets 
changes. 
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"Rotate Folding Sheets": 

This is where you select whether you would like to rotate your folding sheets by 0°, 90° or 180°.

If you have several folding sheets and you rotate them by 90°, the folding sheets are always arranged 
head to head in pairs.

"Columns" / "Rows"

This is where you define how the folding sheets are arranged on the press sheet. 

You always start off with one folding sheet per press sheet. In other words, folding sheet 1 is placed 
on press sheet 1, folding sheet 2 on press sheet 2, etc. 

You can only set the "Repeat" option if a number greater or equal "2" is entered in "Columns" or 
"Rows".

"Columns" with "Repeat"

The number in "Columns" is greater or equal "2" and "Repeat" is set. In this case, the number in "Col-
umns" indicates how often the folding sheets of a press sheet will be duplicated on this press sheet 
in horizontal direction.

Example: You have folding sheet 1 (pages 1-4) on press sheet 1 and folding sheet 2 (pages 5-8) on 
press sheet 2 (see graphic below): 

Enter a "2" in "Columns".

Then the front of folding sheet 1 will be placed twice side by side on the front of press sheet 1. Mat-
ching this, the back of folding sheet 1 will be placed twice side by side on the back of press sheet 1.
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Do the same with folding sheet 2, see graphic below: 

As a result, you can have several press sheets.

"Columns" without "Repeat" 

"Columns" displays a number and "Repeat" is not set.

In this case, the number in "Horizontal" indicates how many folding sheets will be placed on a press 
sheet in horizontal direction. No folding sheet is duplicated. The folding sheets are simply placed side 
by side.

Example: You have folding sheet 1 (pages 1-4) on press sheet 1 and folding sheet 2 (pages 5-8) on 
press sheet 2 (see graphic below): 

Enter a "2" in "Columns".
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Then the fronts of folding sheet 1 and 2 (pages 1, 4, 5, 8) will be placed on the front of press sheet 1. 
Matching this, the backs of folding sheet 1 and 2 (pages 2, 3, 6, 7) will be placed on the back of press 
sheet 1. You save one press sheet. See the graphic below: 

"Rows" with/without "Repeat"

Like "Columns" with/without "Repeat", only in vertical direction.

Spacing of Folding Sheets 

Prerequisite: You have more than one folding sheet in vertical or horizontal direction on a press sheet. 

You can then set the vertical or horizontal gaps between the folding sheets. 

Vertical gap between folding sheets 

Horizontal gap between folding sheets 

Terms Used in the Imposition Editor

Bleed

The bleed defines a margin around the page placeholder. Page content may still be printed in this 
margin. This avoids white flashes. Bleed is generally 3 mm per side margin. 

Trim 

The trim defines a margin around the page placeholder. This margin defines the gaps between the 
page placeholders. The size needed for the output material may change because of the trim defined. 

Trimmed size

The trimmed size is the size of the cut page after printing. The trimmed size is equivalent to a trim 
box defined in Acrobat. 

The size of the trimmed size is defined on the basis of the master page. The page placeholders in the 
scheme are the size of the trimmed size. 
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Gripper for Saddlestitcher (Collator) 

Normally, a strip of paper/material is used to pull the folding sheets on to the saddle if a sad-
dlestitcher is used to collate the sheets. The position of the gripper margin on the sheet depends on 
the folding sheet scheme. The folding sheet becomes bigger because of the gripper margin. As a 
result, all the pages are shifted. 

Scheme / Heidelberg Fold Type Catalog

The parameters of the scheme include: 

• Number and arrangement of the page placeholders on the press sheet. 

• Ordinals for the page placeholders of the scheme. 

• Orientation of the pages 

• Folding Rule: Each scheme has a folding rule. This is a precise instruction on how the folding 
sheet must be folded. 
The names of the predefined schemes are the same as those in the Heidelberg fold type catalog. 
You can find the various folding rules in the fold type catalog. For custom schemes, you must 
create your own folding rule. 
A scheme doesn't have any dimensional data. Only when you assign master pages to the page 
placeholders does the sheet have dimensional data. 

Heidelberg Fold Type Catalog

Green: Open sheet length 

Red: Open sheet width 

Fold lay mark 

Buckle plate on top 

Buckle plate on bottom 

Finished folding sheet 

1, 2, 3 Folds in numeric order, open sheet length

1, 2, 3 Folds in numeric order, open sheet width 

+ 90° rotation of fold 
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1/2

Example: Example: Fold to top with 1/2 open sheet width 

1/4

Example: Example: Fold to bottom with 1/4 open sheet length 
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Subject

Subject is the term for the bounding box around the printed area of the content data on a press sheet. 
(This does not include marks.)
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Creeping

For saddlestitch-bound publications (see Scheme / Heidelberg Fold Type Catalog), the paper thick-
ness makes the inner pages shift outward (i.e., away from the spine). If the publication is trimmed 
after binding, the inside pages will have narrower outer margins than the outside pages. (The same 
is true for perfect binding when large press sheets must be folded often.) 

The creeping value that you can define in this box defines creeping between two successive two-page 
spreads. 

A positive value shifts the inner pages inwards (towards the spine). A negative value shifts the inner 
pages outwards.

The creeping value depends on various material properties such as thickness, flexibility, pressure 
sensitivity, grain direction and tear resistance. 

The page spacing changes when you define a value for creeping. 
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16 Register Control
General Information about Register Control

Register Control is a tool that lets you verify positions on press sheets and on single PDF pages. You 
can, for example, place front and back sheets or pages on top of each other to verify register accu-
racy. Basically, you simulate a double-sided sheet, e.g. two A4 pages one on top of the other.

You can save the result of the superimposed pages of the various files. This lets you, for example, add 
trim marks or mount different language versions on one basic layer.

Working with Register Control

Launch Register Control by clicking the icon shown to the left or selecting "Plug-Ins > Pri-
nect 2015 > Register Control".

A window opens, displaying the first page (front) of the document:

3. Select "Back".
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4. Enable the "Tumble" option to add the page on the current page mirrored on the x-axis.

5. Enable "Turn" to mirror on the y-axis.

6. You can use the slider to check whether the pages are placed one on top of the other like in the 
trim box.

You can scale the pages up and down also using the tools in the menu bar or with "Zoom In" / "Zoom 
Out" in the context-sensitive menu as well as select "Previous View".
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Example of Use of Register Control

Verify the position of trim marks

Move the slider exactly to the middle to verify the register accuracy of trim marks on imposed sheets. 
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17 Fast View - Alternate Images
Alternate Image - Fast View On/Off

The “Fast View” function lets you view high-res images in the PDF file at a low resolution (provided 
the PDF already contains low-res images) or generate and embed such alternate low-res images.

With low-res images, the speed with which PDF files display on the screen can be quickened signifi-
cantly.

You can enable/disable the display of low-res images by clicking the icon shown to the left 
or selecting "Plug-Ins > Prinect 2015 > Alternate Images...".

Prerequisite: Low-res alternate images must already have been calculated for this func-
tion. This may have been done in applications such as Prinect Integration Manager, PitStop, 
or Prinergy. 

�

� Note: "Alternate Images" does not work if the PitStop fast view is enabled.

You can also use "Calculate" below “Alternate Images” to generate low-res images if these are not yet 
available.

Calculation of Low-res Images
�

� Note: Alternate images created with "Fast View" are written to a Heidelberg-specific area of 
the PDF file and thus are technically compatible with PDF/X-1a.

1. Select “Plug-Ins >Prinect 2015 > Fast View...” if you wish to calculate low-res images for a PDF 
document.

The "Fast View" window displays: 

It provides information on the number of images in the document and the number of available 
alternate images.
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2. Already existing alternate images can be removed prior to a recalculation. In this case, check the 
"Remove" option.

�

� Note: Alternate images created by PitStop will also be removed.
Alternate images will be only created for those images without a corresponding alternate 
image if you do not enable the “Remove” option.

3. Enable the “Calculate” option.

4. Type a value (in dpi or lcm) for the alternate image resolution in the “Subsample to” box. Use 
the list box to choose between two units.

5. Type a value (in dpi or lcm) in the “... if Above” box starting from which an alternate image is to 
be created from a high-res image. 

No alternate image will be created for those images that already feature a resolution below this 
value.

6. Click "OK". 

The alternate images are calculated and can now be viewed using the “Fast View” icon.

�

� Note: The images are calculated without opening the dialog if you press Ctrl+Shift 
(Apple+Shift on a Macintosh) or Alt+Shift and click the icon.

Remove All Alternate Images

1. Select "Plug-Ins > Prinect 2015 > Fast View..." to remove all low-res alternate images in a PDF 
document (e.g. to comply with the PDF/X-1 standard).

The "Fast View" window displays: 

2. Verify whether alternate images are present.

3. Enable the “Remove” option and disable the “Calculate” option.

�

�
�

� Note: Alternate images created by PitStop will also be removed.

4. Click "OK". 
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18 Show Layout Pages
Splitting Press Sheets into Single Pages

This tool lets you edit press sheets at a later stage. You can view the separate pages. Programs such 
as PitStop or Prinect Trap Editor can edit individual pages, but not imposed sheets.

This lets you, for example,

· perform trapping

· check head-to-foot pages beforehand

· edit text

· swap pages

· exchange pages

Prerequisite: Only press sheets created with Prinect Integration Manager or Prinect Signa 
Station are recognized as press sheets. The “Show Layout Pages” function is disabled if a 
PDF document is not detected as a press sheet.
This function also lets you separate pages again that were superimposed with Register Con-
trol.

1. Select "Plug-Ins > Prinect 2015 > Show Layout Pages".

�

� Note: Pages of another PDF you use to replace pages of the current PDF with must feature 
the same geometry.

2. Make your changes and then choose “Save” or “Save As...” in the “File” menu. 
The press sheet is shown with the changes you made.
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19 Versioning Assistant
What is Versioning?

Versioning means that you create several versions of one print product. More precisely, you have a 
large part with similar components and smaller parts with differing components.

Files can be broken down into a base and version (e.g. language), checked or cleaned up. The bases 
of various files can be checked for differences. Differences in the bases can be highlighted visually. 
This lets you judge whether the versions match the base. You can view different version files on top 
of a selected base file with a preview function. These functions are available also for the case that the 
files are supplied already split into base and versions.

Examples:

• A brochure will be printed in a number of languages. The images are the same in all the lan-
guages, but the text is different for each language.

• Customer information will be produced for different customers. The content is identical but dif-
ferent addresses must be printed. 

Procedure

1. Select Files

Open the Prinect PDF Toolbox:

with a click on the icon opposite in the Acrobat toolbar

or 

• with "Plug-Ins > Prinect 2015 > PDF Toolbox > Versioning Assistant...".

If no PDF document is open:

The Prinect PDF Toolbox first demands that you look for and select a folder in which the PDF files to 
be checked are located. This means that all the files you will compare with each other must be in the 
same folder.

If a PDF document is open:

If the Assistant launches on an open PDF, the folder containing this file is presented. You must then 
select the PDF files that you will check together from the list.

The following requirements must be met:

• All the files have the same number of pages.

• All the files have the same size.

• All the files have the same colors and/or the same number of separations.
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You can view the number of pages, page size and used colors for each file if you click "Details".

The "Continue" button is enabled when more than one file is selected.

�

� Note: When launched on an open file, the Versioning Assistant tries to present a suitable 
initial selection of files based on the extension.

Folder

Click the button with the three dots, then choose the folder containing the files you want to version.

File name

The names of the open PDF files are listed below "File name".

Pages/Colors/Format

No items display below these parameters when you launch the Versioning Assistant. 

Click "Details".

This shows you details about the page total, colors and sizes of the open PDF files:
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cm, pt, inch, mm

Select the unit of measure for the size indicated.

Base and version are together or separate...

Caution: Make sure that you choose the correct option whether the base and version of the 
PDF files will be together or separated. Different functions are available depending on the 
way the files are supplied. To make good use of the functions offered, in the case of sepa-
rated data you must select just one base file and any number of version files.

together

Base and version are located together in one file.

separate

Base and version are located in separate files.
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2. Create and Check Versions

The window below displays when you click "Continue".

Files Supplied Together

Functions that you can select when the files are supplied together.

You must first select the master version from the list of selected files. The master version is the file 
from which the plates for the joint primaries (e.g. CMY) will be taken during production. When you 
select a different master version, the file of this version also displays.

From the list of colors, you can now set which separations will contain the versions. "Black" is set by 
default. But you can also select all other process and spot colors as versions.
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Settings

Part of Version Layer

• Only Text

• No Images

• All Elements

These are the possible types of object in a PDF page description (Text, Graphic, Image, Bitmap, Sha-
ding). 

This is where you now select the object type which contains the varying (version-specific) part.

You should select "Only Text" if version-specific information is found only in text elements. This option 
normally makes the other functions much faster because, for example, no images have to be sepa-
rated. You must select "All Elements" if the images or graphics have version-specific parts. The graph-
ics and images from the base with the text of each version are imaged on one plate if you select "Only 
Text".

�

� Note: You should select "All Elements" only if images or graphics in the versions are posi-
tioned on exactly the same position.

Set elements to overprint if area coverage is at least (%)

You can set version-specific text or graphic elements with a minimum area coverage to overprint so 
that there is no unwanted knockout on the separated base file. The area coverage applies to the color 
that was selected as the version, e.g. black for the text. If saturation of this color is above or equal to 
the set value, the color is overprinted. It stays as knockout if it lies below the value. This function does 
not affect images or blends.

Compare within   at

The set box and the resolution define the accuracy and speed with which the comparison is made. A 
resolution of 72 dpi is normally entirely sufficient to determine the differences.

Split

File Name for Base / File Extension for Version

The data are needed for the new PDF files that are produced with "Split". You must specify the file 
name for the base (e.g. CMY) of the master version. An extension is needed for each new version file 
(e.g. K separations for English and Spanish).

File to Subfolder

A subfolder is created in the folder for the PDF files that will be processed when this option is 
checked. You must enter a name! This is where the base file and the version files will be located.
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Functions

Back

You can change the files selected for comparison. You go back to the "Select Files" step.

Compare

The bases of all the files are compared. In this process, temporary PDF files without any version-spe-
cific details are created of all the files to be compared. These are then rendered in the set resolution 
and compared. This process can take some time, depending on the complexity of the files and 
selected settings. 

Any differences that are found are displayed in the "Result of Comparison of Base Elements" window. 
Only a brief message is issued if there are no differences.

Combine

The versions are combined with the base and saved. A PDF with the version name is generated auto-
matically for each combination. 

Split

Base of the master version and version elements of all versions are saved separately. A base file and 
a version file are created for the master version. Only version PDFs are created for all other files.

Preview

This function lets you view the versions of a file on top of the base of the master version. For example, 
you can view the English version on top of the German base.

�

� Note: Use Acrobat's output preview as well to check, for example, that versions are cor-
rectly overprinted.

Make sure that the overprint preview in Acrobat's preferences is enabled ("Page Display") 

Files Supplied Separately

Functions that you can select when the files are supplied separately.
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You must select the base file and a master version from the list of selected files. You can compare 
other versions with the master version. When you select a different master version, the file of this ver-
sion also displays.

From the list of colors, you can now set which separations will contain the versions. "Black" is set by 
default. But you can also select all other process and spot colors as versions. In our example, spot 
color "Tekst" is version-specific.

Settings

Compare within

You can specify that the comparison will apply to one of the boxes in the PDF files.
This option avoids error messages because of the different color control marks, for example. 

at (resolution) 

The set resolution defines the accuracy and speed with which the comparison is made. A resolution 
of 72 dpi is normally entirely sufficient to determine the differences.
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Clean up

Remove white graphics

On the version layer (text), knockout text graphics when placed one on top of the other can knockout 
the base layer. To prevent this from happening, the graphics are deleted automatically if this option 
is enabled.

File Extension for Version

This detail is needed for the new PDF files that are produced with "Clean up". An extension is needed 
for each new version file (e.g. K separations for English and Spanish).

File to Subfolder

A subfolder is created in the folder for the PDF files that will be processed when this option is 
checked. You must enter a name! This is where the base file and the version files will be located.

�

� Note: Remember that image boxes with a filling of 0% CMYK can apply overprinting white 
to elements from the base and, in this way, can make them invisible.

Functions

Back

You can change the files selected for comparison. You go back to the "Select Files" step.

Compare

All files are compared with the master version. In this process, temporary PDF files without any ver-
sion-specific details are created of all the files to be compared. Any unwanted versions that may be 
present affect the base file, for example, knockout or non-version colors. The temporary files are ren-
dered in the set resolution, compared and then the color deviations are displayed. This process can 
take some time, depending on the complexity of the files and selected settings. Any differences that 
are found are displayed in the "Result of Comparison of Base Elements" window. Only a brief mes-
sage is issued if there are no differences.

Clean up

All non-version parts are removed from the version files. For example, these can be unwanted ver-
sions that affect the base file, for example, knockout or non-version colors. The result in each case is 
created as a new PDF file.

�

� Note: Remember that image boxes with a filling of 0% CMYK can apply overprinting white 
to elements from the base and, in this way, can make them invisible.

Combine

You can combine files that are separate when supplied to versioned PDF files. A PDF file is generated 
automatically for each combination made up of a base and version and saved to the set subfolder. 
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Preview

This function lets you view the versions of a file on top of the base of the master version. For example, 
you can view the English version on top of the German base. 

�

� Note: Use Acrobat's output preview as well to check, for example, that versions are cor-
rectly overprinted.

Make sure that the overprint preview in Acrobat's preferences is enabled ("Page Display")

Example for a "preview":
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3. Result of Comparison of Base Elements

In the base file of the master version, differences to the bases of the other files are shown. When you 
select a file, the differences are highlighted on the master version in the color you set in "Color for 
Visualization", for example, differences in the English file compared to the German master version.

Click "Open" to open the selected file in Acrobat beside the highlighted master version for a visual 
comparison. The non-highlighted master version opens on the right. All three open windows react the 
same when you scroll or change the page display in the middle window.

Selection of a comparison file automatically changes to a file you loaded before with "Open".

"Back" closes the file you loaded with "Open".

Two differences to the English base file are seen in the German base file.

One difference to the Spanish base file is seen in the German base file.
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20 VDP Editor
VDP Editor

With this tool, you can create dynamic marks of the "VDP Barcodes" and "VDP Texts" types for digital 
printing. You can add identifiers to them and edit or delete such identifiers.

The marks are named "Prinect VDP Marks" and stored in layers of the same name. They are visible 
in the "Layers" view of Acrobat. Acrobat shows the new layer only after the document has been saved 
and reopened.

Prerequisite: An existing "VDP Editor" license option. 

Invoking the Option

You will find the respective icon for the option in the Prinect toolbar. You can start the option 
in the menu with "Plug-Ins > Prinect 2015 > VDP Editor..." or by clicking the icon in the Pri-
nect toolbar. The following dialog displays:
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Working with the VDP Editor

Operation of the VDP Editor is basically the same as that of the Barcode Editor. See the Barcode Edi-
tor to learn how this function works.

The "What's new?" document on the installation medium offers additional brief operating instruc-
tions.
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21 PDF/VT Control
Creating PDF/VT Files

With this tool, you navigate through PDFs with variable data records or even go directly to a certain 
page in a data record. PDF/VT Control indicates for the current page in the PDF, which page in which 
data record belongs to the respective page. 

PDF/VT meta data can also be created and/or edited. 

Prerequisite: An existing license for the "PDF Assistant PDF/VT Control" option. 

Invoking the Option

You will find the respective icon for the option in the Prinect toolbar. You can start the option 
in the menu with "Plug-Ins > Prinect 2015 > PDF/VT Control..." or by clicking the icon in the 
Prinect toolbar. The following dialog displays:

The currently selected page is page 17 of a total of 19 pages in the first data record! 

Using PDF/VT Control

The "What's new?" document on the installation medium offers additional brief operating instruc-
tions.
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22 Import / Export...
Parameter Sets/Folders

The following window displays when you select the "Import/Export" function. You can select or dese-
lect parameter sets for import or export in this window. 

You can save all the PDF Toolbox settings (PDF Report, Geometry Control, Trap Editor...) in a central 
location or copy them back from there with the relevant menu item in "Plug-Ins > Prinect 2015 > 
Import/Export...". In this way, parameters can be exchanged between different workstations. This 
function is also suited for a backup of parameter sets. 

• When you use the Export function, in "Backup" set the folder into which the parameter sets will 
be copied. The source folder automatically recognizes PDF Toolbox.

• When you use the Import function, in "Backup" set the folder from which the parameter sets will 
be copied. The target folder automatically recognizes PDF Toolbox.

�

� Note: After you click the "OK" button, PDF Toolbox immediately starts copying.

�

� Note: When parameter sets are copied several times, folder names that were already cre-
ated are not overwritten; instead, _1, _2 etc. are appended to these folder names.
Prinect PDF Toolbox  –  User’s Guide / Online  263





CFF2 Presettings

23 CFF2 Presettings
Settings

The following dialog appears when you choose "CFF2 Settings..." in the menu: 

You can change the line width when importing CFF2 cutting die outlines. 

When you import CFF2 cutting die outlines, the preset line width can be too thick, making it difficult 
to distinguish between contents and cutting die outline. In this case, you can reduce the line with 
accordingly.

You can invoke the dialog with "Plug-Ins > Prinect 2015 > CFF2 Settings ..." in the menu.

• Choose the "Fixed" option and specify the desired value (units: mm, cm, pt, inch).

• Confirm your settings by clicking "OK".

• To position the CFF2 file with changed line width, use the "Assemble Pages" tool.
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